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Schools in the US spend more than Rs 25,000 crore annually on technol -
ogy. Now consider this: Most government schools in India don’t even have a
clear-cut computer education programme. The obvious question that then
comes to mind is: How do we overcome this digital divide?

Global tech giants are spending crores of rupees to educate teachers on tech-
nology and provide computer equipment in schools. In fact, the US Department
of Education has gone so far as to commission a Rs 50 crore study to research
the impact of technology in education. This is possible because schools in the
West have all the pieces of infrastructure in place: they have the computers, the
connectivity, trained staff and the content.

But the situation is quite different in India. Most schools don’t even have
basic computing infrastructure to impart computer literacy, let alone use 
technology as a tool to aid education. Couple this with the fact that not every-
one can afford to pay thousands of rupees to a computer training institute 
and only a small fraction of us actually have access to a PC, and we’ve got a 
serious problem.

With computer literacy being a pre-requisite in today’s age, it’s obvious that
we need some sweeping changes to ensure that this digital divide doesn’t make
our children start life with a disadvantage.

Companies like Intel are making attempts to bridge this gap with their 
Rs 500 crore ‘Teach to the Future’ programme, which aims at imparting tech-
nology education to 5,00,000 teachers globally. Even though there’s a humani-
tarian angle to all these programmes, these tech companies realise that they
need to do this in order to seed their own future. 

We too can play an important part in bridging this gap.
Every year we junk thousands of PCs without realising that there might be

an educational institution in our neighbourhood that might have tremendous
use for our discarded technology. After all, one person’s obsolete technology
might be another’s future meal ticket. 

Companies can get in touch with schools and donate their old PCs to help
underprivileged children in coming to grips with computers. We can organise
charity drives to ensure that every school in our locality has access to comput-
ers. The government can offer tax rebates to urge larger companies into donat-
ing old PCs. Not-for-profit organisations can be set up to manage collection,
refurbishment and grants of donated PCs.

So what if we can’t provide the latest and the greatest technology to our
schoolchildren? We can at least ensure that they’re literate enough to compete
in the same race as the rest of the world. 

vinit_aggarwal@jasubhai.com

“With computer
literacy being a pre-
requisite in today’s

age, it’s obvious that
we need some

sweeping changes to
ensure that this digital

divide doesn’t make
our children start life

with a disadvantage”

Vinit Aggarwal
Assistant Editor

Helping Hands

Note: We at Digit are committed to help bridge this digital divide. Schools and edu-
cational institutions that wish to recieve technology donations, as well as companies
willing to donate their old PCs can write to us and we’ll do our best in getting them
in touch with each other.
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■ Creative DAP-CD0001
■ Creative PA-20
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■ Microsoft Project

Professional 2002
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■ Sun StarOffice 6.0
Flash MX . . . . . . . . . 80
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MUSICMATCH Jukebox 7.2
Size: 8.9 MB, Type: Trial
Mindware\Software\Multimedia

Assimilation
Size: 7 MB, Type: Demo
Playware\FunZone

Babylon-Pro 3.2.46
Size: 6.9 MB, Type: Shareware
Mindware\Software\Home

Download Accelerator Plus 5.3
Size: 1.67 MB, Type: Freeware
Mindware\Software\Internet

Auryn Quest
Size: 99.1 MB, Type: Demo
Playware\Arena\Games

PowerZip 6.01
Size: 1.65 MB, Type: Trial
Mindware\Software\System

Flashdown 1.2
Size: 682 KB, Type: Shareware
Mindware\Software\Internet

IrfanView 3.75
Size: 812 KB, Type: Freeware
Mindware\Software\Multimedia

AudioCatalyst 2.1
Size: 2.8 MB, Type: Shareware
Mindware\Software\Multimedia

NetCaptor 7.0.1
Size: 836 KB, Type: Trial
Mindware\Software\Internet

CloneCD 4.0
Size: 2.13 MB, Type: Shareware
Mindware\Software\System

HIGHLIGHTS

Macromedia Flash MX
Flash is a software that needs no intro-
duction. It has for long been a favourite

among developers and designers alike
when it comes to developing dynamic
multimedia content for Web sites, online
advertising and more. Flash MX now
includes video support for MPEG, Digital
Video, MOV, and AVI formats. You can
edit, manipulate and animate video
objects or use scripting to make your
videos interactive. You’ll also find new

graphic design capabilities such as Bezier
curves, transformation tools and pixel-
level snap control. In addition, Flash’s
ActionScript environment has under -
gone significant improvement. For a full
review, see page 80. 
Size: 46 MB, Type: Shareware
Mindware\Software\Multimedia

Windows Commander 5.0
Windows Commander is a replacement
for File Manager and Explorer in
Windows. The program handles archives
and lets you easily copy files to and from
them. It also features renaming and delet-
ing of entire trees, drag-and-drop sup-
port, a launch utility that lets you place
frequently used programs into a drop
down menu, etc. This new version has
support for Windows XP themes, back-
ground download manager, and more.
Size: 1.29 MB MB, Type: Shareware
Mindware\Software\System

Duke Nukem: Manhattan Project
Duke Nukem is raising hell again—this time in New
York City! Help the Duke battle his way across tow-
ering skyscraper rooftops and through subway sta-
tions as he hunts down Mech Morphix. You’ll have
to take on mutants of every kind as you fight your
way through eight huge environments.
Size: 50.3 MB, Type: Demo
Playware\Arena\Games

ON THE CD

8

MINDWARE\CONNECT
The Connect sec-
tion on your Digit
CD brings you
some fun reading
with Bookmarks
and Newsletters.
Bookmarks con-
tains a list of sites
on a particular
subject along with
a detailed description of the sites.
You can browse each site by simply
clicking the Web site link. This
month we bring you some cool sites on

Indian and International cinema. The
Newsletterssection, of course, brings
you a collection of newsletters on
different topics every month. This
month we have some of the coolest

comic strips deliv-
ered straight to
your inbox.  

So if it’s some
light reading that
you’re looking
for, then this 
is one section 
that you would

definitely want to browse.

KNOW YOUR CD

MUST-TRY SOFTWARE

Free PC to
Phone Dialer

SEPTEMBER 2002

Droolmaal Sponsored by:

D r o o l  o f  t h e  m o n t h
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Have an opinion? Want to share some
thoughts with us? Got an idea to make
your magazine better? Just fill in your
name, e-mail address and thoughts and
we’ll surely read it.

Icons for a
Generation
From chubby Pac-Man
to lissome Lara Croft,
characters in computer
games have, over the
years, evolved into icons
transcending the game
screen...

WEB SPECIAL FEEDBACK

WEB SPECIAL

taste technology at http://www.thinkdigit.com

BY DEMAND
You get to choose what goes on
Digit Interactive. This month, you
have chosen:
America’s Army Operations
(218 MB) for Playware 
Sun ONE Studio 4, Community
Edition with J2SE 1.4
(84 MB) for Mindware
Expect these on the October
2002 CDs.

Moore’s Last Sigh
Moore’s Law, which states that
the number of transistors on a
chip doubles every 18 months,
held true for 35 years. However,
the latest trends indicate that
the ‘law’ is ready to be broken.

SEPTEMBER 2002

Results 
of our first By
Demand poll!
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Palladium
■ What is it?
Microsoft’s ambitious plan to
change the architecture of
PCs in order to address con-
cerns relating to security, pri-
vacy and intellectual property. 

■ How does it work?
Microsoft is hoping to add
these features to future ver-
sions of the PC with a combi-
nation of hardware and soft-
ware. Basically, Palladium is
about deciding what’s trust-
worthy. It not only lets your
computer know that you’re
you, but can also limit what
runs on your computer. The
system uses high-level
encryption to lock data and
can also protect the integrity
of documents so that they
can’t be altered without your
knowledge. Even the link
between the keyboard and
computer can be encrypted!

■ What does it mean 
to me?
Palladium is touted as the
complete security and priva-
cy solution. It tells you who
you’re interfacing with or
who's using your PC and
what they’re doing, protects
information from unautho-
rised access and modifica-
tion, stops viruses and pre-
vents spam. Your information
can be transferred to other
systems (say, a bank) by an
'agent'—even the agent can't
read the information, it only
carries it. It’s currently being
offered to record studios to
control media piracy.

hypethesis

■ Honda cars to include IBM’s voice recognition technology ■ Royalty fees shut down over 200 Internet radio stations ■ Apple, Sun to make StarOffice for OS X

ACalifornia-based technol-
ogy company, SkyTower,

is planning to launch crewless
solar-powered airplanes that
will provide entire cities with
broadband Internet access
and 3G mobile services from
70,000 feet above the ground.
SkyTower is working with
NASA and the Japanese Min-
istry of Telecommunications
on this project.

Tests show that SkyTower’s
planes, called Pathfinder-Plus,
could complement and, in
some cases, supersede satel-
lite and terrestrial telecom-
munications systems. Because
the signal is being transmitted
from directly or almost direct-
ly above, the SkyTower sys-

tem will cover areas that can-
not receive satellite or terrestri-
al signals due to obstructions
such as large buildings. 

The upper wing of the
Pathfinder-Plus plane is made
of solar panels, which gener-
ate the energy for the aircraft
to remain
in flight

throughout the day. The
plane must land at night, but
SkyTower is trying to create
fuel cells that would store
enough energy to allow the
plane to stay circling a city
overnight. Such fuel cells
could enable an airplane to
stay in the air for up to six

months at a time. The
extremely tight turning
circle of the Pathfinder-

Plus means that the plane
stays within a small area
throughout its flight, so

people on the ground will
not have to keep moving
their receivers to track it. 

SkyTower is confident of a
commercial launch of the air-
borne services in 2005.

The upcoming version of
Windows XP, named Win-
dows XP Media
Center Edition,
aims to make
the PC a per-
manent part of
home entertain-
ment. It will enable users to
use a TV remote control to
catalogue songs, videos and
pictures, as well as check TV
listings. However, users will
need a new system to run it
on. Hewlett-Packard and
Samsung are among the
computer manufacturers
developing Windows Media
Center PCs and prices are
estimated between $1,000
and $2,000.

➜

Solar plane for 3G

The ISO standards body
will take the unprecedent-

ed step of withdrawing the
JPEG image format as a formal
standard if Forgent Networks,
a small Texan company, con-
tinues to demand royalties on
a very old patent. According
to Richard Clark, JPEG com-
mittee member, under the 
ISO terms, only a standard
that can be implemented for

free or on Reasonable and
non-discriminatory (RAND)
terms can be allowed. It is
clear that Forgent’s claims are
not RAND compliant. “How-
ever, ISO itself cannot formal-
ly take a stance on the
patent,” Clark added. Unlike
MPEG, there is no licensing
structure for JPEG.

The current assumption is
that the patent is not valid.
Since the patent becomes
invalid in 2004 (under the
old rules, 17 years after filing
the patent) there is little
incentive for manufacturers
to bow to the terms, though
Forgent declined to rule out
litigation against those who
decline to pay them royalties
on the claim.

Have JPEG, will pay A new XP

ILLUSTRATIONS : Mahesh Benkar
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Trojan in encryp-
tion program
A Trojan horse turned
OpenSSH, the de facto stan-
dard for network security,
into a convenient back door.
OpenSSH encrypts the link
between two computers to
prevent eavesdroppers from
capturing messages as they
are sent across the network.
In the infected release, the
Trojan attempts to communi-
cate with other computers on
the Internet and awaits fur-
ther commands, giving com-
plete control to potential
hackers. How the Trojan was
sneaked in as part of the
update is unknown. The fake
release has been replaced
with one without the Trojan.

PHP vulnerable
The PHP form-data post han-
dler is susceptible to a mali-
cious post request that can
trigger an error condition
which, depending on the
hardware, can crash the
machine or provide access for
remote exploitation. On an
Intel x86 machine an attacker
has no control over memory
allocation and can only cause
a Denial of Service (DoS), but
on a Solaris machine, a hack-
er would be able to free
chunks of memory and over-
write them arbitrarily to run
code. PHP versions 4.2.0 and
4.2.1 are vulnerable. A fixed
version as well as patches
have been released to rectify
the problem.

redalert

■ Throwaway mobiles set to debut in US stores ■ China to break foreign monopoly with own Windows OS ■ Princeton allegedly hacks Yale admissions site

➜

In one of the boldest politi-
cal efforts yet, movie stu-

dios have drawn up a bill to
disrupt peer-to-peer networks
to curb piracy. The bill per-
mits copyright holders to per-
form nearly unchecked elec-
tronic hacking if they have a
‘reasonable basis’ to sus-
pect piracy. In effect,
this would immunise
groups such as the
Motion Picture Associa-
tion of America (MPAA)
and the Recording
Industry Association of

America (RIAA) from all state
and federal laws if they dis-
able or block a peer-to-peer
network. Anyone whose com-
puter gets damaged in the
process, must receive permis-

sion from the US Attorney
General before filing a law-
suit, and the suit can be filed
only if the actual monetary
loss was more than $250. 

Concerns have been raised
over the fact that unless you
can show economic harm,
you can’t even be compensat-
ed. Even if you  want to be
compensated, you have to
jump through procedural
hoops. The MPAA however
asserts that law-abiding Inter-
net users should have no rea-
son to be concerned.

Andrew Neff, an analyst
with the US-based invest-

ment banking firm, Bear
Stearns, predicts
that Apple will
shift to Intel
chips. Apple cur-
rently uses the
PowerPC chips
from Motorola
and IBM that max
out at 1 GHz. Intel
already has chips

running at 2.5 GHz, with 3
GHz due later this year. This

move will give
Apple’s computers a
great performance
boost and in turn
gain more cus-
tomers.

When Steve
Jobs was asked if
Apple would con-
sider a move
from the Power-

PC architecture, he had
replied, “…we like to have
options.” While Wall Street
analysts have created a cot-
tage industry out of making
grandiose predictions and rec-
ommendations, Neff can
boast of a fairly strong track
record. In January 2001, he
said that HP should purchase
Compaq—months later HP
announced it was buying
Compaq.

Hollywood invading your PC?

INFOGRAPHICS : Jaya Shetty

statattack

Apple may switch to Intel

Two heads 
are better
Japanese company Scarabs

has designed a two-headed
hard drive that consists of a
read/write head and a second
read-only head to provide
higher security. The latter will
be connected to the Web serv-
er, while the former connects
to the PC used to update the
Web site. Both are completely
independent, making it
impossible for people viewing
the site to hack it. It also
means that the Web site can
be updated without inter-
rupting surfers, as changes
can be made using the
read/write head. Source: IDC

Overall IT spending

in 2002:

$981 billion

snapshot
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ATi Technologies Inc has
introduced the RADEON

9700 Visual Processing Unit
(VPU), a groundbreaking chip
that boasts of features such as
eight parallel rendering
pipelines, complete
Microsoft DirectX 9
support, AGP
8x support
and a fully
programmable
floating-point architecture.
The chip’s eight parallel ren-
dering pipelines provide the
brute force to process over 2.5
billion pixels per second. The
four parallel geometry engines
process greater than 300 mil -
lion transformed and lit poly-
gons per second. In addition,
Hyper Z III reduces overdraw
by detecting and discarding
hidden pixels and reduces
memory bandwidth con-
sumption by over 50 per cent.
It incorporates a new high-
performance 256-bit DDR
memory interface, providing
over 20 Gbps of graphics
memory bandwidth and fully
supports the AGP 8x specifi-
cation, allowing increased
volumes of texture and vertex
data to be transferred quickly.

The AGP 8x interface was
designed to double the graph-
ics processing bandwidth over
today’s AGP 4x.

The chip supports up
to 16 textures
per rendering
pass with Pixel

Shaders 2.0 and
vertex programs of

up to 1,024 instructions
with flow control. This
architecture enables
users to run complex

cinematic-quality shader pro-
grams in real time for truly
realistic effects. SmoothVision
2.0 incorporates a full-scene
anti-aliasing implementation
for unprecedented perform-
ance at even the highest qual-
ity anti-aliasing modes. Also
included is ATi’s popular
advanced anisotropic filtering
technology, supporting up to
16 bilinear or trilinear samples
per pixel in a variety of
modes. These technologies
substantially improve the
visual quality, without
degrading performance. ATi’s
retail product will ship with
128 MB DDR memory, at a
suggested retail price of $399
(approx Rs 20,000).

Graphics at the speed of light

Microsoft Corporation will
reveal hundreds of pieces of
proprietary code from its
Windows operating system to
comply with an antitrust set-
tlement it signed in Novem-
ber 2001 with the US Justice
Department. It will disclose
385 modules of internal
operating rules, previously
kept secret. The Justice
Department and 18 states
had accused Microsoft of
deliberately withholding
computer code in Windows
to hamper competitors.
Microsoft reached a settle-
ment and nine states agreed
to sign, but nine others are
still asking US District Judge
Colleen Kollar-Kotelly for
tougher restrictions.

Microsoft to reveal
Windows code

heroes
Open Source
nVidia will make its Cg devel-
opment tools for program-
ming high-level graphics
effects open-source software.
RealNetworks too plans to
publicly release the code
underlying its multimedia
player software, though 
certain details may change
before its release.

Adult entertainment
The US adult Web site indus-
try has set up a trade organi-
sation to represent it. The
Internet Freedom Association
(IFA) aims to promote the
rights of the online adult
entertainment industry, while
taking a strong stand against
child pornography.

Privacy  
Japan launched a compul-
sory government ID system
in the face of stiff protests
calling it a violation of pri-
vacy. The database stores
names, addresses, dates of
birth, gender and the new
ID numbers for each of
Japan’s 127 million citizens,
making it easier for them
to obtain documents for a
variety of public services
and benefits.

Piracy
Federal prosecutors charged
Canadian Robert Garby with
selling of illegal mod chips
and pirated console games
through his Kustum Kom-
puters business. He pleaded
guilty to six counts of crimi-
nal code violations and
copyright law infringement
and was fined $17,000 and
sentenced to a year of 
probation.

zeroes

Source: Dataquest

Dataquest predicts

1 GB memory for

entry-level PCs by

2005

snapshot

A practical application of the
Sense and Sensibility story car-
ried in the July 2002 issue is seen
in Texas where three Kroger
stores are testing biometric sys-
tems that enable shoppers to
pay with their thumbprint. Cus-
tomers register with a store by
placing their thumb on an elec-
tronic screen that records the
print. The information is
encrypted and linked to the cus-
tomer's credit card, debit card or
checking account information. A
picture ID establishes the shop-

per's identity and the whole
process takes just 20 seconds!
Though more technology-savvy
people were expected to be
most interested, everyone from
teenagers to the elderly are sign-

ing up. Grocers say that control-
ling fraud was their main goal—
credit and debit card fraud cost
grocery chains an average of
$1,96,000 each in 2000.
Though the feedback is positive,
reports show a fear of govern-
ment and law surveillance.
Kroger employees remind shop-
pers that the system is based on
the thumbprint rather than the
index finger that is standard in
law enforcement. Also, they
don’t store the entire thumb-
print, just crucial characteristics. 

Pay with your thumb!
followup

■ Intel accelerates 3 GHz P4 release to compete with AMD ■ AOL misrepresented accounts for 3 quarters ■ Apple’s Jaguar (OS X 10.2) releases ahead of schedule
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Selling for around $75
(approx Rs 3,700) with an

Ethernet port, the Sega Dream-
cast is currently the choice
game console for information
warfare as demonstrated at the
Black Hat conference in Las
Vegas held on July 31, 2002. As
one example, the console has
been converted into a bug that
can be dropped into a corpo-
rate network with little or no
detection.

Aaron Higbee of Found-
stone and Chris Davis of Red-
Siren have developed a Linux
toolkit that runs on the system,
and when hooked up to a net-
work, dials into the hacker’s
network. Known as the DC

Phone Home kit, the software
checks all available services
such as HTTP, SMTP and SSH in
a bid to make an outbound
connection. It even checks for
proxy servers hooked
up to the net-
work. Though
the kit could
be used on a
range of hard-
ware quite easi-
ly, the Dreamcast
was chosen due to its
innocuous nature.
According to a report
from SecurityFocus, dur-
ing their presentation at
Black Hat, when performing
penetration tests, they often

found themselves able to get
physical access to the target’s
facilities for a few minutes.

As a defence against such
attacks, Higbee and Davis sug-
gested allowing only network

connections from pre-
assigned MAC addresses,

along with the obvious
tightening up on physi-
cal security. Other hard-

ware that could be
used in the phone
home attack
includes software
for the Compaq
iPAQ and a

bootable x86 CD-
ROM which can perform the
attack using any available PC.

It smiles when you
approach, opens its doors

and rotates a seat towards
you. It observes you
in your house to
study your music
and TV preferences.
The Toyota p.o.d
(personalisation on
demand) uses mini-
pod, a portable terminal that

constantly observes your
lifestyle and habits, and
adjusts the driving experience

to provide greater
comfort and satis-
faction.

Introduced at
the 2002 Tokyo
Auto Show, the
p.o.d  creates a

responsive, humanised envi-

ronment that raises ergonomics
to a new level. The car observes
your behaviour and tailors the
driving experience accordingly.
More than an automobile, the
p.o.d is an intuitive driving
companion. Unfortunately,
Toyota attaches a little note that
reads, “Concept vehicle only.
Not intended for production.
Don’t you wish.”

Toyota’s driving companion

US supercomputers have
long been considered the

world’s most powerful. But
the Earth Simulator built in
Japan with an old design runs
five times faster than the pre-
vious record holder, a
machine that simulates
nuclear tests at Lawrence Liv-
ermore National Laboratory
in the US. “This machine is so
powerful that a researcher
who uses it can do in one day
what it takes a researcher in
the US to do in one month,”
said Jack Dongarra, a Univer-

sity of Tennessee professor
who tracks the world’s 500
speediest computers.

Supercomputers have thou-
sands of processors working in
tandem to analyse the most
complex issues, such as nuclear
test simulations, air-
craft designs and
drug creation.
The Earth Simu-
lator is faster
than all 15 of the
biggest super-
computers in the
US combined and

will be used in climate and
earthquake studies. It uses
5,104 processors to perform
35.9 trillion calculations a sec-
ond. IBM, which built ASCI
White, HP and other US super-
computer makers are working

on even more pow-
erful machines.
“We can do that
in a heartbeat

and with a lot less
money,” said Peter

Ungaro, vice presi-
dent of high per -
formance computing

at IBM. Earth Simulator costs
about $350 million, while ASCI
White cost $110 million.

Price isn’t the only factor.
Certain research problems
work better on one super-
computer type over the other.
Custom supercomputers, for
instance, have bigger data
pipes, which is critical in cli-
mate modelling and nuclear
research, whereas this can be
a drawback for off-the-shelf
processors, which work best
on data analysis in fields such
as genetic research.

Dreamcast, the hackers choice

■ Creative to ship thumb-sized MP3 player ■ HP stops selling imaging products to Dell ■ .Net will link to Apache ■ Xbox to hit 6 new countries this year

Def Con, an annual gathering
that holds the Alexis Park
Hotel’s all-time record for the
most alcohol consumed by
one group in a weekend, has
always intended to be a place
where the young can quietly
talk tech. But on its 10th
anniversary held from August
2 to 4, 2002, it became more
of a party, with over 6,000
paid attendees flooding the
premises—the three confer-
ence rooms used hold a com-
bined total of just 2,800 peo-
ple. San Francisco criminal
defence attorney Jennifer
Granick gave legal tips, while
the MojoNation folks (an
open source software for peer-
to-peer sharing) spoke about
their new better-than-Napster
software. Arthur Money, assis-
tant Secretary of Defense,
spoke about hacking issues.

Def Con 10

31.1 million
PCs were shipped

in the second quar-

ter of 2002

snapshot

Source: Bear Stearns 

Super duper computing
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In the past decade, televisions
have become bigger, wider,

flatter and now they're becom-
ing thinner. Advancements in
the development of next 
generation plastics that are
capable of emitting light are
coming closer to commercial
production than ever. These
screens can be rolled up when
not in use. It all began 
with the development of a 
special compound called 
p-phenylenevinylene, which is

a type of plastic that can glow
green-yellow when subjected
to an electric charge. Further
developments led to the cre-
ation of a polymer capable of
emitting red and blue light.
Laboratories like Britain’s
Cambridge Display Technolo-
gies (CDT), which is among
the forerunners in developing
this technology, say that these
flexible television screens
would be ready for commer-
cial production by 2004-05.

The primary hindrance has
been in finding a substance
thin and flexible enough to
protect the sensitive compo-
nents used in the creation of
these ‘floppy screens’ but this
is also nearing commercial via-
bility. As this technology gets
cheaper, we will see fabrica-
tions of ultra-portable floppy
screens that can be used any-
where from large screen pub-
lic billboards, to TV-watches to
even display-capable clothing!

“The more choices
you have in enter-
tainment program-
ming, the more time
consumers will
spend in front of a
guide. Any [TV] guide
company is in a cen-
tral, powerful posi-
tion. The same way
companies like
Yahoo! and AOL are
crucially important
to guide people on
the Internet”
Josh Bernoff, analyst at 
Forrester Research

“It's funky to be a
geek and MP3
allows you to be an
outlaw without
knowing anything
about technology.
With MP3 you can
become an outlaw
just by clicking on a
button”

G. Fedorovsky, British
leader has started a political
party named MP3!

■ Microsoft to enhance Active Directory in Windows .Net Server ■ John Cocke (77), inventor of RISC chips dies ■ Intel planning portable audio-video player

An addition to Microsoft’s
End User Licensing Agree-

ment reads as, “You agree that
in order to protect the integri -
ty of content and software 
protected by digital rights
management (‘Secure Con -
tent’), Microsoft may provide
security- related updates to the
OS components that will be
automatically downloaded
onto your computer. These
security-related updates may
disable your ability to copy

and/or play
Secure Con-
tent and use
other software
on your com-
puter. If we pro-
vide such a security
update, we will use reasonable
efforts to post notices on a Web
site explaining the update.”
Meaning, MS will automatical-
ly install code of its choice
without letting you examine
the download or cancel it!

Software development site
CollabNet is working with

Butterfly.net, an IBM-backed
effort to create a supercomput-
ing grid for hosting online
games. Butterfly
will also use Col-
labNet’s Source-
Cast Web applica-
tion to enable
game develop-
ment teams to
share source
code, manage
assets and
design games.
Butterfly.net is an effort to
apply grid-computing, in
which computational tasks are

spread over multiple net-
worked computers, to the
infrastructure challenges of
hosting online games. The
increasing sophistication of

online games, the most
popular of which

manage thou-
sands of simul-

taneous players,
has made infra -
structure a grow-

ing concern
among develop-
ers. Spreading
the computing

power required across several
computers may be the most
effective solution available.

Grid computing for online games

Linking people’s brains
together to form a collec -

tive intelligence. Humans liv-
ing beyond 100 years. These
can all happen with proper
investments in technology,
according to a recent report
from the US National Science
Foundation and the Depart -
ment of Commerce. The 405-
page report argues that a host

of advances can be achieved in
the next 20 years alone. 

Authorities cast doubt on
proposals such as capturing
consciousness through com-
puters or linking neurons with
nanocircuitry. Our minds may
not be able to handle the flood
of information resulting from
a brain-machine interface, sug-
gests Jeremy Rifkin, author of
books on biotechnology and
globalisation. Rifkin said soci-
ety ought to pick and choose
carefully among emerging
technologies, given potential
downsides. “Some of that
harm can be irreversible—
especially in biotechnology,”
he said.

Brainfeed

Roll up for the floppy television
tomorrow’stechnology

Bill’s in your PC

US tops Web traffic

with 42.65 per

cent, China second

with 6.63 per cent

Source: WebSideStory Inc

snapshot

quoteworthy



24

pulse ■
■ letters

Q. Which amongst these four comparison tests would you
like covered in an upcoming isssue of Digit?

Your vote counts

Look out for a DVD-ROM drive shootout in a forthcoming issue!

This month’s question:

SEPTEMBER 2002

“Which of these would you prefer covered in
greater detail?”

■ Linux ■ Gaming ■ Mobile computing

Log on towww.thinkdigit.com and vote on it

Dear Priyangshu,
India is not a potential market for console games for a number of
reasons. Console makers lose sizeable amounts of money on
every unit of hardware they sell, which is recovered via software
sales over a period of time. With piracy being a big problem in
India, console makers cannot hope to recover their money and
hence will be forced to price the hardware at a premium.
Compound this with the duties that will be levied on these gam-
ing consoles and you’ll land up with prices that will be quite out
of reach for most consumers.

Only when these console makers have recovered the R&D
costs of their hardware will they turn to less lucrative markets like
India, but that will involve a long waiting time for Indian gamers
hungry to get their hands on these new game machines.

36%
DVD-ROM drives

15%
Input devices

23% 26%
PC cabinets MFDs
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■ In the scanner comparison
test (August 2002), we’ve incor-
rectly mentioned that the HP
ScanJet 5400C, 5470C and
Microtek ScanMaker X12USL
(pg 60, features table) do not
have removable lids.
■ Several readers have com-
plained that the Java 2 Devel-
opment Kit (Mindware CD,
August 2002) was corrupted.
We’ll provide a fresh installa-
tion with the October issue.
■ In the printer comparison test
(July 2002) we’ve incorrectly
mentioned that the HP Deskjet
845C (pg 55, features table) has
a parallel port.

Notice any goof-ups? Write to
goof@jasubhai.com

Goof Ups

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Short Bytes

Rock on
Hi Vinit,
I have always skipped the
music section of Surge,
because I don’t like techno
and trance, but the Indian
rock collection on the
August 2002 Playware CD
was fantastic.
Vishal

Via e-mail

Hi Vishal,
Indian rock bands have defi-
nitely come of age. And the
most amazing thing is that
these bands created the
music on their PCs!

Dr Digit
Dear Digit,
You will be surprised to
know how popular Digit
has become in the doctors’
community, especially
amongst medical students
and new doctors like me.
There are so many of us
who wish to be current
with our knowledge of the
tech world and at the
same time want it to be
simple. Digit is truly a
technology magazine for
the common man.
Manoj Khemani
Via e-mail

SEPTEMBER 2002
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The Net today offers very vivid
content such as animation-rich
Flash Web sites, streaming
audio and video news and 

full-motion videoconferencing with
friends and family abroad. But these
services require a high-bandwidth con-
nection—something that every Net
junkie dreams of.

The Internet actually operates on
very high bandwidth pipelines, but the
problem is that most of us never ever get
to experience this speed. Take, for exam-
ple, the case of the backbones of the Inter-
net that are used to connect countries to
one another. These are based on ultra
high-speed optical connections such as
OC-12 lines, which offer a bandwidth of
622.08 million bits per second—with
such bandwidth at your disposal, you
could transfer an entire CD in 9 seconds
flat, twice as fast as the practical data
transfer rates of most hard disk drives
used in PCs! 

With all this delicious bandwidth

out there, the
question is how

to make it available
to end-users as effi-

ciently and cheaply as possible. The
popular standard of Internet access for
most surfers today is through the trusty
but archaic telephone network. Dial-up
connections provide cheap access to the
Net but prove to be a bottleneck for
bandwidth-demanding applications
such as real-time audio and video appli-
cations, as they are only capable of
delivering transfer rates at a maximum
of 6 KBps. With the proliferation of
peer-to-peer applications, millions of
files are just asking to be down-
loaded, and this last mile con-
nectivity is the only hin-
drance. Other alternatives like
DSL and cable modem are too
expensive and their availabil -
ity is limited. Additionally,
the effective bandwidth of
these supposedly ‘broadband’
services is curbed in most
cases and the end-users are
left with a rather narrow-
band experience. 

But there’s hope yet. Here’s a look at
some saviour technologies that promise
Nirvana by elevating your Internet expe-
rience to a higher plane.

Internet at the speed of light
Very few establishments, much less
homes, are located within close proximi-
ty of an Internet backbone. So far, the
only way to create a high-bandwidth link
with the Internet backbone was by setting
up optical fibre connections, but this is
not a viable option for most. One of the
most promising technologies that effec-
tively deal with this problem is Free Space

Optics (FSO). FSO uses laser beams
capable of carrying enormous

quantities of data at high
speeds. These laser devices
can be mounted on top of
buildings pointing at one
another, creating an invisible
laser mesh of optical connec-
tivity over short distances. 

The US Army has been
using this technology since
the 1980s to carry digital
information through modu-
lated laser beams. However,

Multimedia content on the
Internet is here, but the

ubiquitous dial-up throttles your
surfing speed. Will there ever be a

respite? A look at some new
technologies that promise to set you

free from ever having to look at the
downloading status bar again

Fibre optics link: up
to Rs 1 crore; four to
12 months
FSO link: about Rs
10 lakh; two to
three days 

Cost and time to
install per building

➜
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the devices have to have a clear line of
sight between the transmitting and
receiving stations in order to work. These
laser systems operate in the terahertz
(THz) frequency spectrum and usually
operate in the 194 THz or 375 THz range.
Their performance is comparable to the
best fibre optic system available, giving
speeds between 622 Mbps and 1.25 Gbps.
Research predicts that this can go as high
as 160 Gbps—faster than your hard
disk’s interface!

Another advantage of this
technology is that it’s
portable and fast to imple -
ment. Conventional high-
speed connections like T1
lines take between two to
four months to install as the
roads have to be dug up to
lay down the cables, not to
mention the bureaucratic
formalities involved. On the
other hand, FSO only
involves mounting the trans-
mitting and receiving units between
buildings. FSO devices look a lot like secu-
rity video cameras and can be mounted
on rooftops, corners of buildings or even
inside offices behind windows. Another
inherent advantage with this system is
that of security—it is exceedingly difficult
to jam or intercept an optical signal with-
out breaking it, thus alerting the user.

However, FSO does have its disad-
vantages. Interference with the line of
sight is one of the biggest drawbacks. If
the laser beam is broken by a passing bird
or heavy rain, it will affect the bandwidth
or even halt data transfer completely.
Even extreme weather conditions like fog
and mist diffuse the beam and disrupt
data transmission. In high-rise construc-
tions, the wind causes the buildings to
sway, affecting the alignment of the laser
beam if the equipment is mounted on top
of the structure. Service providers have
created multiple workarounds for these
problems that basically work at main -
taining the alignment of the transmitter
and receiver in real time. Such systems
have been used successfully in ships that
were able to maintain connectivity with
hubs located on the shore. However,
these work out to be much more expen-
sive than conventional FSO systems.

As with any other budding technol-
ogy, in order to get it out of the laborato-
ries and into the realm of mass accept -
ance, it has to establish its reliability. Most
FSO companies demonstrate a reliability

of 99.99 per cent at distances of up to 2
miles, compared to the magical 99.999
per cent expected of broadband connec-
tivity. It is this ‘five nines’ reliability that
still eludes most implementers of this
technology.

As FSO evolves, its ease of implemen-
tation and cost-friendliness breeds the pos-
sibility of connecting rural areas, where
laying fibre optic cables is economically

unadvisable. It can also be applied to
cellular phone technology, paving

the way for broadband 3G cel-
lular networks or even as a tem-
porary network for disaster
management (see box, ‘FSO to
the Rescue’).

The power within
Every few years, an innovative
use of an existing technology
bridges the gap between the
old and the new, making us

think, “Gee, why didn’t any-
one think of this before?” Power

Line Communications (PLC) is one such
technology. Using PLC, various compa-
nies have used ordinary power lines such
as those found in homes and offices to
transmit data.

Theoretically, the maximum band-
width achievable with PLC is 14 Mbps,
and the practical speeds range between 6
to 8 Mbps, making it slightly faster than
WiFi (Wireless Fidelity) networks. WiFi is
a standard for devices compliant with the
802.11b wireless standard (for more infor-
mation, see ‘Wireless Connectivity’ in Digit,
June 2002).

But once networking enters the
realm of utility power lines, it is in very
harsh territory, electrically. It will have to
address the issues of static, noise and high

voltage before it is looked upon as a viable
networking system. The evolution of
Application Specific Integrated Circuits
(ASICs) is the main driver of PLC tech-
nology. ASICs are basically small proces-
sors with powerful signal processing capa-
bilities, which filter out the noise in the
power lines. Unlike a traditional Ethernet-
based network using CAT5 cable that is
far more controlled in terms of shielding,
power, voltage levels and impedances,
utility power lines present a nightmare of
situations that need to be dealt with for
reliable data transfer.

One of the biggest hurdles in home
PLC is the varying transfer function of the
power circuitry. The transfer function is
the overall response of the power lines,
taking into account the different imped-
ances and the levels of voltage all over the
lines—the transfer function will vary if
you plug in a new appliance or switch
power supplies. To counter these situa-
tions, a technique that allows adaptive
response to variable conditions in the
power line was developed. HomePlug is
one such standard that allows home net-
working through power lines. It employs
an adaptive approach to get the highest
possible data transfer rate on the channel
by varying the bit rate of the information
in accordance with the noise levels and
the condition of the power line. 

Another concern is that of security—
since most homes in a neighbourhood are
connected through a single distribution
grid, there exists a distinct possibility of
your neighbour being able to pry into
your network. Some manufacturers have
integrated passwords into their home PC
gear to solve this problem. 

PLC removes the need for an addi -
tional network between your home and

One of the most critical implementations
of Free Space Optics (FSO) technology
was seen during the September 11
tragedy, where various FSO services pro-
vided the much-needed bandwidth to the
rescue teams. Its ease of installation made
FSO the only viable technology to respond
so quickly to the bandwidth requirements.
FSO companies such as LightPointe and
Terabeam restored gigabit connectivity
within a week to companies such as Merrill
Lynch, which was losing millions of dollars
each disconnected day and Federal 

Emergency Management Agency, which
carried out the rescue operations.

FSO to the Rescue

WTC Twin Towers

Danish truckers are
using the utility
power lines at inter-
city truck stops to
plug into their corpo-
rate network at
broadband speeds

PLC en route
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service provider, since the network is
already in place and more widespread
than ever. In developing countries, the
electric power line infrastructure is more
widespread and robust as compared to the
telephone network, making it possible to
connect even the remotest location to the
Internet.  

Thomas Edison once said, “I’ll make
electric light so cheap that only the rich
can afford candles.” PLC is all set to deliv-
er on a similar promise for Internet con-
nectivity.

The Web from outer space
Satellite communication has been here
for a while; cable television transformed
our television watching experience from
a bland three-channel serving to a splen-
did buffet of over 150 channels! These
silent machines set in the blackness of
space are now entering the realm of home
Internet access. 

Satellite Internet Access (SIA) is a
relatively high-speed service that uses
orbiting geo-synchronous satellites to
beam down information. However, this
technology works in tandem with your
existing Internet connectivity; users still
connect to their present Internet 
service provider to upload and 
transmit data.

The process is very simple—you
dial into your Internet service provider
and the requested data is sent from your
ISP to a special server from the SIA
provider called the Network Operations
Centre (NOC). This server retrieves the
requested information from the Web
server but instead of sending it back
through the ISP, it beams it up to an
orbiting satellite, which in turn trans-
mits the data to a little satellite dish out -

side the user’s location. From here, it
passes through a special modem that
decodes it and sends the information to
the user’s computer. The entire
process takes less than half
a second to complete,
which is rather long for a
single request of infor-
mation.

Due to this inherent
latency, SIA is most suited
to applications involving
sustained data transfer
(such as large file down-
loads and streaming
audio and video applica-
tions) rather than repeat-
ed access to small amounts of
data (as in Web browsing or playing
games). Another disadvantage is that it is
still expensive and relatively more diffi-
cult to install than DSL or cable. The serv-
ice promises download speeds up to 400
Kbps, while the upload speeds depend
upon the service provider. 

However, newer systems offering
download speeds up to 1.5 Mbps, with
upload speeds of 200 Kbps are in the

pipeline. Understandably, this system,
in its present state, will be more suit-

ed to applications that stress on
downloading information rather
than uploading.

What tomorrow holds
Yesterday was the era of text
Internet; today is the age of
sound and animation; tomorrow
will usher in a radical epoch of
high-quality audio and video
streaming, interactive video-con-

ferencing and megabyte down-
loads in minutes. The last mile has
always been a hurdle in the path of high-
bandwidth Internet connectivity. Once
these new technologies are economical -
ly viable, our perception of the Internet
will change forever. And the dice has
already been rolled.

MARCO D’SOUZA

Free Space optics
http://www.terabeam.com
http://www.lightpointe.com
http://www.lightpointe.com/index.cfm?fus
eaction=technology.WhitePapers
http://www.airfiber.com/tech/WP_laser_ey
e_safety.pdf
http://www.freespaceoptic.com/
Power Line Communications
http://www.homeplug.org
Satellite Internet Access
http://www.isp-
planet.com/fixed_wireless/research/satel-
lite.html

Web Resources

There’s been a quantum jump in last-mile Internet connectivity. This logarithmic graph depicts the
bandwidth of various Internet technolgies from the lowly modem to FSO.

Arthur C. Clarke, the
science-fiction novel-
ist, first postulated
the idea of using
satellites for point-to-
point radio commu-
nication back in 1947 

From Fiction to Fact

How fast is fast?
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Panasonic SV-SD80 MP3 Player 
Lilliputian with the heart of a Goliath
No bigger than a matchbox and weighing only 26 grams,
the SV-SD80 has the distinction of being the world’s
smallest digital-audio player. This player sports an
impressive battery life of 50 hours of playback time. Based
on a 64 MB SD card, it can store up to 2 hours of near-CD
quality audio. It hosts a USB interface and features a clear
display and an incandescent neck-strap—it can’t get more
feature-packed than this!
Web site: www.panasonic.com

Sony MicroVault
The united colours of storage
Sony’s MicroVault USB storage media is the perfect
medium for transporting presentations, MP3s and work
data from PC to PC and sharing them with colleagues,
clients, friends and family. It weighs 20 grams and
measures 26x13x92 mm. Its USB interface enables it to
be plugged into computers on the fly. Based on Flash
memory, this thumb-sized storage device is fashion savvy
and comes in colour coded cases that are based on the
storage capacity—so think orange for 16 MB, wear red
for 32 MB, choose blue for 64 MB, and black for 128 MB. 
Web site: www.sony.com
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Fujifilm Axia Eyeplate
Axia power! Go get it! 
This aluminium-encased camera could easily be
mistaken for a credit card! Only 6 mm thick, the
Eyeplate is astoundingly light at 35 grams. It features
8 MB of built-in Flash memory, and is capable of
storing 26 images at a resolution of 640x480 or 101
pictures at 320x240. It extends a popup lens while
taking pictures, which retracts when powered off.
You can upload pictures to your computer via the
USB cable and simultaneously charge the internal
batteries. It adopts the Autobrite technology, which
automatically adjusts the brightness of the subject
when shooting against a bright background.
Web site: www.axia.co.jp

Panasonic SV-AV10
Three for one
This dwarf-cam is loaded with serious wow factor. At a mere
1.1x1.97x3.43 inches and 100 grams, the SV-AV10 captures
low-resolution video and stills, plays digital music and records
voice memos. Its super compact design includes a flip-out LCD,
and it keeps the size down by relying on Secure Digital (SD)
removable media for storing all the digital data. 
Web site: www.panasonic.com

Sony Vaio U1
So much, so small
Sony’s Viao U1 sets a whole new ultra-small
standard for the world of notebooks—it
weighs a meagre 816 grams. The package
includes a Crusoe processor running at 
867 MHz, 384 MB RAM, a 20 GB hard disk and
a 6.4-inch TFT LCD. It runs Windows XP and
has a built-in zoom function that magnifies
the screen at the touch of a button. Its
7.3x5.5-inch frame includes two USB ports, a
PC Card, memory stick slots, an i-LINK (IEEE
1394) terminal, as well as an Ethernet port.
Now you can hold your whole office in the
palm of your hand!
Web site: www.sony.com
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Family ties
Kumar residence, Andheri 
Roop Kumar wakes up to the
sound of the alarm set on his

cell phone. It’s a custom ring tone based
on a song from his favourite movie Dil
Chahta Hai, which he downloaded two
days ago. By 7 am, the Kumar residence
is bustling with activity, with the usual
battles for the bathroom and squabbles
over breakfast. Roop decides to get some
work out of the way and retires to his
PDA where he schedules his meetings
and plans the day ahead of him. 

While Roop is the man of the house,
when it comes to the PC, it’s his 19-year-
old son Atul who gets the upper hand.
“I’m not very good with the PC, but my
son tinkers with it all the time. He was
the one who figured out how to hook the
MP3 player to the car,” says Roop, while

his son uploads a
new set of songs
into their MP3
player. He’s also
the one to hook
up his audio 

system to his PC, while his comparative-
ly underpowered computer speakers gath-
er dust on the table. 

“I usually spend late nights surfing
and downloading, even though my con-
nection lets me be online all the time,”
says Atul. His Cable Net connection gives
above average speeds late in the night, a
development that has changed his body
clock and sleeping hours. His computer’s
on all day, leeching off MP3s from P2P
applications. Three songs are being down-
loaded at speeds of less than half a kilo-
byte per second while 14 more are in
queue. “When I used a modem, I used to
hog the land-line and the phone bills
were a nightmare. Now it’s bye-bye to
dial-up connections and extravagant
phone bills! For Rs 800 a month, I’m con-
nected to the Net all the time!” says Atul
in a voice filled with glee. 

A couple of years ago, the PC was
exclusively Atul’s domain, but now the rest
of the family is just as involved. “It’s
become too easy. Supriya’s on the messen-
ger all the time with her friends. It’s one of
the reasons why I want to switch to Linux,”

he complains. “I’d like to have another PC
and network it to this one,” he adds. “There
are so many old parts lying around the
house. We have a spare monitor and a Pen-
tium 100 MHz—I could easily get another
PC up and running. I just need some extra
RAM and a new hard disk.” 

“I’ve spent over a lakh and a half on
the PC in the last year,” sighs Roop as he
peers through his bifocals at the monitor.
Right now he is mailing himself some
files, which he can later access at the
office. Simultaneously, he looks up the
headlines and checks the latest stock
quotes at the Mumbai Sensex. With
online stock trading, it’s been such a long
time since he actually needed to talk to
his share broker. “It’s my new habit. I keep
checking the stock quotes of my portfolio
whenever I get some free time. I never
close the window; I just click Refresh every
few minutes, even at work,” he says.

Office hours 
Roop Kumar’s office, Nariman
Point
While sipping on his first cup

From the minute we wake up to the time we go to sleep, technology touches 
us in many ways. A look at how technology is entrenched in our lives

➜

THE CAST
Father: Roop Kumar
Mother: Hema Kumar
Daughter: Supriya
Kumar
Son: Atul Kumar 
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of tea for the day, 
Roop juggles multiple
browser windows. 
He downloads his 
e-mail, which filter
themselves into differ-
ent folders—newslet-
ters, personal, work
and spam. He con-
nects his PDA to his
PC and gets updates
from his favourite
news channels using avantgo.com and
sends off the e-mail he typed the previ -
ous night. “The PDA is a godsend for a
person like me who’s frequently on the
move. I can keep track of all my tasks for
the day, track expenses and make a to do
list on a device that can inconspicuously
fit in my jacket pocket. All in all, I find
this to be a very useful device, especially
when I’m bored during the long com -
mute everyday—I play games on it.” 

Roop does most of his banking and
bill payment from the office itself. “Net
banking is such a lifesaver. I used to waste
a lot of time paying bills and updating my
passbook but now I can pay my bills,
check my account or cheque status, trans-
fer money or stop payment, without
moving from this chair. I don’t know how
I ever managed without it!” 

His cell phone beeps. It’s a
reminder for his meeting with
the Vice President who’s at the

head office in Delhi. Roop turns to his PC
and starts the Video Conferencing linkup.
This is the practice in his office when it

comes to meetings with people from the
head office or the regional offices. He had
suggested this as an efficient and cost-
effective method and now has some very
pleased superiors. 

He receives an SMS from his friend
Ravi: ‘lunch @ 2?’ Roop punches ‘ok’ and
sends it back immediately. 

Campus capers
Mithibai college, Juhu
Supriya is hanging out with her
classmates in the college can-

teen, when she remembers that she has a
big test coming up. Pulling out her cell -
phone she punches an SMS to her batch-
mate Karishma Shah: ‘can i borrow ur psy-
cho notes plz? thx bye’. The cellphone is a
hand-me-down from her dad when he got
himself a sleeker and smaller model. The
family stays in touch through SMS all the
time, be it a request for a special dish for
dinner, or informing of a late night out. 

Speaking of studies, “I get most of the
research for my papers off the Net and
then just photocopy them for a set of
notes to exchange with friends. This way
we all end up doing only a fraction of the
research needed,” says Supriya. Fifteen
minutes later, her friend Karishma joins
in the discussion of how technology has
changed lives, for better or for worse.
Both agree that women are more inclined
to use Internet for communication above
anything else: “The most important way
that technology has affected my life is

communication; I get
withdrawal symptoms
if I’m away from my
Net connection and
my mobile phone. I
feel cut off and lost
without it,” says Kar-
ishma. She’s not much
of a gadget freak and
doesn’t have any giz -
mos on her wish list. “I
got a CD-Writer so that
I could burn audio CDs

and free up some space from my PC. I’d
also like to buy a scanner because I have
tonnes of photographs that I’d like to
scan and upload to a photo album online,
but that’s pretty much it.” 

“I also plan to study further in the US
or Canada and I’m studying for my GRE
exams. I have joined an online training
course that covers the GRE syllabus. It’s

easier than ever to study this way and I
always get access to the latest informa-
tion,” asserts Karishma.

Home alone
Kumar Residence, Andheri
While the rest of the family is
busy with the day’s work, Atul

is playing Counter-Strike on the local area
network. He has a few friends in the neigh-
bourhood who are keen gamers and with
very low ping times between their com-
puters, the experience of overpowering

I chat with my friends
abroad, using a Web
cam. It is so easy and
saves me heaps of
time and money”

There are two things
on my wishlist: a
scanner to digitise all
my old photographs
and a speedy broad-
band connection

Karishma Shah
STUDENT

“
”

Cellphones: In the fast-paced,
urban world, cellphones are a
necessity. They are easy to carry
around and have been getting
smaller each year. Today’s cell-
phones offer advanced features such
as text messaging, GPRS, games, calen-
dar, calculator, reminder and custom 
ring tones. 

PDA: A PDA used to be like a private sec-
retary—you could schedule your
daily work, make appointments
and read text files. Today it
can be equated with a per-
sonal computer—you can
watch movies on it, play
music, surf the Internet using a fully-fea-
tured Web browser and even use it as a
handy-dandy digital camera! 

MP3 Players: Digital music is here to
stay, no matter what the RIAA thinks
about it, and an MP3 player
gives it the much-needed
portability. MP3 players are
more compact and portable
than CD players and you can
even buy one with Flash memory. Some
provide up to 6 GB of music, which trans-
lates into a lot of albums (see ‘Music
Unplugged’ on page 72). 

Game Consoles: Consoles
have always been the bigger
brother to PC gaming, with
higher market penetration
and a larger roster of games.
They are simple to use,
addictive and can be played on a televi-
sion. And there’s no issue of patches,
driver updates, or system instability. If it’s
no-frills gaming you’re after, a console is
exactly what you need.

Must-have Gadgets

“
Vikram Mody
STUDENT
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your buddies in a strategic war is an intox-
icating experience. Right now only
Vikram is online, so it’s a one on one
game. “I remember playing 3 hours of
monopoly and scrabble with my family. It
used to be quite tedious. Now with Com-
mand and Conquer and Counter-Strike ,  I
have a lot more variety in terms of new
challenges and people to play with.” 

Vikram’s ageing TNT2 graphics card
cannot handle all the requirements of the
high-end games, but he has no intention
of upgrading his graphics card yet. “Let
ATi and nVidia have a price war first with
their next generation cards! Besides, a
graphics card is low in my priority as I use
my PC more for communicating with my
friends abroad.”

Play time
Entertainment for the Kumars
Hema comes online to remind
Roop of the family dilemma that

was the cause of the squabble at break-
fast—evening entertainment. Should they
a) watch the movie running at Regal cin-
ema or b) rent a DVD and watch it over
dinner? Roop reads up a few reviews of
Minority Report online and decides to drop
it. “I still rely primarily on input from
friends and co-workers for advice on these
sort of things, but if I’m surfing and I see
a movie or a restaurant that’s received a
glowing review, my odds of checking it
out go up considerably.” He makes a call
to his neighbourhood DVD rental store for
the latest DVD and stops to pick it up on
the way home. “I like DVD movies. 
They have far superior sound and video

quality, are easier to store, and you don’t
have to rewind them!”

Back home, Hema is searching for the
recipe for Avial, a south Indian delicacy.
“I use the Net for surfing once in a while,
but usually only to send e-mail to our rel-
atives. Now that we have a Web cam, we
can have a face-to-face chat with our rel-
atives abroad—seeing them in person is
such an amazing feeling,” she gushes. The
family gathers together at 7.30 pm for an
early dinner, when Roop delivers his final
observations.

“For what it’s worth, technology has
drastically changed the way I do things.
For example, the yellow pages are sitting

in a corner of my house collecting dust,
since I use the Internet to search for
local businesses. I research products
online and use the Internet to check
whether a business carries a particular
item I want instead of calling them per-
sonally. In fact, if a company doesn’t
have at least a rudimentary Web site, the
likelihood of me patronising them drops
dramatically.”

Third wave
Most of the daily activities that the Kumar
family engaged in would have sounded
like science fiction 10 years ago. Yet mil-
lions of people are living similar lives.

The next revolution in technology,
which some are calling ‘pervasive com-
puting’, attempts to bring computing
even closer to our lives. The idea is to put
a computer into everything and then
hook it up to the Net. Pundits envision
that in the next 10 years, thinking appli-
ances, clever clothes and intelligent cars
will be commonplace. Whatever the speed
and shape of pervasive computing, the
hope is that it will keep its main promise:
integrating computers and the Internet
into devices so imperceptibly that we’ll for-
get they’re there! 

SRIRAM SHARMA

Imagine being logged onto a computer all
the time, no matter where you went, or
what you did. The computer would always
run in the background, unobtrusively and
seamlessly, forming an integral part of your
daily life, like an element as pervasive as oxy-
gen. That’s the idea behind MIT’s $40 mil-
lion Project Oxygen, which attempts to
make us all nodes on the network, reachable
any time, any place. 

The project consists of four components
that use techniques borrowed from a variety

of disciplines. The
Handy21 is an all-in-
one device that can be
a GPS module, a two-

way radio, a television, a pager, and a hand-
held computer rolled into one. The Enviro21
is a stationary unit that enables computers
to monitor our activities and body move-
ments through infrared cameras. The N21
network links you to the World Wide Web
and Natural Speech lets you communicate
directly with the devices using voice com-
mands. 

Oxygen lets the network know where
you are, and what kind of a device you are
using at any given time. Suppose you are
outside, walking the park, with a headphone
and a microphone attached, the network
innately knows the best way to reach you.
This dramatic new project will help in 
organising our complicated lifestyles, but
the revolution also raises some troubling 
privacy issues.

Project Oxygen

Jaishankar Tiwari, more popularly known as
Mucchad, is a minor celebrity in Warden
Road, Mumbai.

What makes this paanwalla a legend,
apart from his prominent moustache, is
that he has his own Web site. He has sever-
al enduring fans who swear by his Calcutta
ek sau bees and meetha paan. 

Visit www.paan.com, and you can order
paan or Mucchad special supari via 
e-mail. The site traces the history of
paan from its origins in the Mughal era
and differentiates between the varieties of
betel leaves and paans, explaining the
ingredients that go into making a paan. 

Mucchad has had people from the US
signing his guestbook and placing orders.

He’s not quite ready to export
paan to the US yet, but his site serves as

an example of how technology has been
adopted even by the layman and not just
the English educated urban populace.

Mucchad, The First Paanwalla on the Web

Technology and You
How much of a technophile are you?
What are the ways you use technology in
your daily life? Feel free to share your
experiences at readersletters@jasubhai.com.
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The Digital Media
Test & Research
Centre (DMTRC)
conducts a series

of elaborate tests to eval-
uate the merit of each
hardware and software
product. To ensure that
our readers have all the
information they need to
make an informed buy-
ing decision, engineers at
DMTRC evaluate and
review the latest hard-
ware, software and technology services in accor-
dance with the most up-to-date evaluation
processes and methodologies used around 
the world. 

Comparison Tests
We use a dual rating system, the first of which is

applied to the Comparison
Tests in which we compare
the performance of products
within a particular category.

Each product is evaluat-
ed under different parame-
ters such as performance,
value for money, features,
warranty and support, etc. 

Weightages are then
applied to the various test
parameters according to
their importance for 
that particular category of
products. 

These weightages are
then used to arrive at an
overall grade for each indi-
vidual product. An overall
grade of A+, therefore, indi-
cates that the product is
close to perfection.

The Awards
Digit awards out-
standing products
by selecting a Best
Performance and
Best Value winner in
each comparison
test. The winner of
the Best Perfor-
mance Award will be
the product that
scored the highest in
the performance seg-
ment of our tests.

This award represents the best performing prod-
uct in our tests and doesn’t factor in any other
parameter such as value for money, features, sup-
port, etc. The winner of the Best Value Award
will be the product that scores the highest in
our value for money parameter which is derived

taking into account the ratio of
a product’s performance and fea-
tures to its price. The product
winning this award offers good
performance at a great price.

In Bazaar
The second part of the rating system is used to
evaluate individual hardware and software prod-
ucts in the Bazaar section. The evaluation covers
parameters such as performance, ease of use,
value for money and the build quality/features of
the product in question and then arrives at an
overall rating. 

Here each of these parameters is given a
weightage of 25 per cent and is rated on a scale
of 5, which is represented by arrows ( ). 

The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret
assessment of a product. For example, a product
that receives an overall score of five arrows sig-
nifies an outstanding buy!

How we Test
The comparison test this
month aims to present you
with the right acoustic offer-
ing for your PC. We first
evaluated 29 speakers that
delivered everything from a
2.1-channel sound for gen-
eral home use, to a com-
plete 5.1 surround setup for
a Dolby Digital experience.
Find out which speaker sets
emerged unscathed from
our gruelling sound quality
and performance tests to
offer you the best audio
solution for your needs.

Soundcards provide the
easel on which the speakers
paint their magic. We thus
checked out six soundcards
that will convert your dull
computer into an aural beast
fit to stalk even the best Hi-fi
systems. Our bag of tricks
included performance tests
to test the mettle of every
soundcard, even as we
grilled each card on the fea-
tures that it offered. The
cards we tested are sure to
please your ears, whether
you are on a budget, or are
looking for the most profes-
sional solution.

Finally, to complete the
picture, we brought in the
MP3 players. With MP3
music blaring out of every
computer in the world, we
thought it time you carried
the music along. We thus
tested six portable MP3 play-
ers; within the array you will
find both solid state devices
and CD-based solutions.

In our Bazaar section we
bring you the first-ever test
of some of the hottest prod-
ucts and technologies in the
country. This month we put
the fastest CD-Writer to the
test—the LITEON 48x. We
also evaluate the Intel
Celeron 1.7 GHz processor.

In Test this Month
It looks good and the technology is glitzy, but does it do the job?

Excellent: a brilliant combination of price, performance and features—far 
beyond expectations
Good: a good buy, better than most products in its category
Average: reasonably competent but nothing spectacular about the product
Mediocre: does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be 
used for its target application

The 5-point Rating System used in Bazaar



46

test drive ■
■ sound solutions



No more are we satisfied with
sound systems that merely
output sound. We now expect a
full-blown surround sound
experience that lets us feel
everything from a room-shaking
grenade explosion all the way to
the gentlest gush of wind in next-
generation games and DVD
movies. 

Convergence has made it
more viable to integrate a home
entertainment system within the
computer itself, rather than go
down the conventional route of
buying separate devices for
audio and video. With falling
prices and increasing availability
of these products, we now have
a choice from amongst an array
of truly utilitarian and sometimes
downright funky devices. Today
you will find a range of
computer speakers that promise
acoustic experiences that rival
conventional hi-fi systems,
affordable MP3 players that let
you carry your music wherever
you may roam, and soundcards
that can transform your
computer into a Dolby Digital
home theatre system.

The following tests will
navigate you through this
abundance of audio options to

Speakers  . . . . . . . . . . . . .48

Soundcards  . . . . . . . . . .64

MP3 Players  . . . . . . . . . .72
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A
good  set of speakers not only sounds good,
but feels good too. There is nothing that can
stir the senses more than a delicately ren-
dered passage of Mozart or, if you are inclined
towards gaming, a gunfight where you almost
feel the recoil of the shotgun with bullets ric-

ocheting all around you!
No longer are home computers sold just as simple devices for

getting your tax work done and managing your weekly expen-
ditures—they are meant to be full-blown entertainment cen-
tres. You can use a PC as a massive repository for all your family’s
music or double it up as a home theatre system for movies on
the weekend. Today when you buy a PC, you can easily integrate
a home theatre system with it, and that too at a budget. 

In this comparison test, we have deliberately not tested any
standard stereo speakers. We have only tested speakers that
bundle a subwoofer with them. This, we feel, is a critical com-
ponent in delivering the power and the room-filling sound
that is a requisite for today’s demanding audio applications
and an immersive home theatre experience. The fact that even
the most basic 2.1 speaker systems are available for under Rs
2,000 is testament enough that the standard of the audio com-
ponent for the PC is on the rise, even at the most basic level. 

Digit Test Process
We used a Pentium 4 2.4 GHz, on an Intel D850EMV2 moth-
erboard with 256 MB of RDRAM running Windows XP Profes-
sional as the test system for evaluating the speakers. Since
sound quality depends as much on the soundcard as the out-
put speakers, we used the Sound Blaster Audigy Platinum
soundcard for all our tests as it provides a pure audio signal
with very little noise. We tested speakers across three categories:

2.1 speaker systems: These speakers feature a front left and
front right channel along with the subwoofer channel used for
low frequency sound output. At their basic level, however, they
are still stereo speakers as they have only two channels of input
(the subwoofer channel is derived from the stereo channel).

4.1 speaker systems: These speakers can output four discrete
channels of sound—the front left, front right, rear left and rear
right speakers along with the subwoofer channel used for pro-
ducing bass frequencies. These speakers have four channels of
input and the bass channel is derived from the front channels. 

5.1 speaker systems: These speakers have six discrete chan-
nels of audio—the front left, front right, centre, rear left and
rear right speakers along with a dedicated subwoofer channel
used for handling bass frequencies. They can accept six sepa-
rate analogue or a digital input channel.

To obtain the purest possible sound without any form of

enhancement, any available equalisation on the speakers was
turned off and the volume, bass and treble levels were kept at a
fixed 50 per cent throughout, except in the power-handling test,
where the volume was raised to its maximum possible setting for
evaluating the sound quality at high output levels. The test was
run in an isolated room to avoid any external audio disturbance. 

Test Methodology
We evaluated the speakers on the basis of features (20 per cent
weightage), performance (50 per cent weightage), value for
money (20 per cent weightage) and the warranty and support
offered (10 per cent weightage). 

Features: We awarded points based on the capability and the
features of the speakers. We logged technical specifications such
as the power rating, frequency response range, the number and
type of connectors provided such as S/PDIF, coaxial, optical and
any other type of analogue or digital inputs. We also checked
whether the speakers adhered to any standards such as Dolby Dig-
ital or THX and they were given extra points if they did. Addi-
tional accessories such as speaker stands, remote controllers and
even longer bundled speaker cables were awarded separate points.

Performance: This was the single most important category as
we tested the ability of speaker sets to deliver on their claimed
audio performance. Performance was evaluated on the basis of
the purity of the sound reproduced by the speakers under vari-
ous conditions using an array of tests.
a) Sound reproduction quality: We evaluated the performance of
the speakers under various applications such as gaming, music and
movie playback. The in-game audio tests checked the overall clar-
ity of the speakers while reproducing in-game music along with the
other gaming sound effects. We used the retail version of Quake III
Arenav1.30 and Serious Sam: Second Encounter for this test. We then
tested the ability of the speakers to effectively reproduce surround
sound in movie playback. For testing overall surround sound qual-
ity, we played a VOB file. This is a file that is encoded with DVD-
quality video (usually at a resolution of 720x480) with full support
for Dolby Digital audio. Next, we tested the music playback qual-
ity using two types of audio files—CD audio and MP3. We used two
tracks to evaluate this: ‘Freak on a Leash’ by Korn and the Hindi
track ‘Mitwa’ from the movie Lagaan. Finally, we used a special
test Audio CD that contained reference audio files consisting of a
cross-section of music and sound effect files. This CD was used to
ascertain the response of the speakers to different types of audio
and to transient sound effects such as gunshots and explosions.
b) Sound frequency test: This test was divided into four parts in
which we played four different test tones. Each of these files were
in frequencies ranging between a low 30 Hz to a maximum of 15
KHz. Points were given based on the speaker’s ability to accu -
rately reproduce the sound in each frequency range. 

Plain-Jane speakers can no longer match today’s demanding audio applications. You deserve better!
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c) Power handling test: This test was run to check the power of
the speakers in reproducing low and high frequencies at high vol-
umes. We played two MP3 files (one with low frequency sounds
and the other with high frequency sounds) with the speaker vol-
ume at 100 per cent. The speakers that produced less distortion
and crackling were awarded more points. 

Value for money: This is a factor of the performance and features
offered by the speakers as compared to its price. Therefore, the
greater the performance and features and the lower the price, the
higher will be the value for money rating of a speaker.

Warranty and support: Here we took into account the war-
ranty period offered by the manufacturer, the number of authorised
service centres and the number of cities in which these authorised
service centres are present. The information here is as provided by
the respective companies.

How they fared
The overall performance of the speakers was evaluated on the
basis of four parameters, namely the features, audio performance,
warranty and support and value for money. Let’s go onto these
parameters and see how each of these speaker systems fared.

Features
We evaluated the speakers for the presence of various features
such as the number and types of connectors provided on the
speaker set, the bundled accessories, thoroughness of the manu-
al and documentation, the inclusion of an amplifier or multi-
channel decoder, etc.

The largest variety of speakers is available in the 2.1 speaker cat-

1/2 page Ver. AD

At the very heart of every speaker system are
the drivers—electromechanical devices that
convert electrical signals into sound waves.
The way a speaker works is surprisingly simple:
when a current is applied to the voice coil (suspended by a
corrugated component called the spider), which consists of
a wire coiled around a metallic tube that surrounds a per-
manent magnet, the cone of the speaker oscillates and in
doing so, it compresses and expands the air immediately in
front and behind it. These ripples in the air produce sound
waves that we eventually hear. This entire assembly is
anchored to a metallic framework called the basket.

The Working of a Speaker
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egory, from speakers that have a cool and funky design to the pure-
ly functional ones without any of the frills and embellishments.
The only 2.1 speaker that offered volume control in the form of a
convenient in-line controller was the Creative Inspire 2.1 2400.
The Sumoku Alpha - 4R was one of the few speakers that came
with an external amplifier that houses the volume, bass, treble,
mute and the power controls. In fact, even the other two 2.1 speak-
er systems from Sumoku (Alpha - 5 and Alpha - 6) featured these
controls—a definite plus point. Having an external volume con-
trol eliminates the need for accessing the volume control in Win-
dows, which can be quite cumbersome. It is also far more
convenient to have the volume control on a separate amplifier
than on the subwoofer as it gives you the freedom to place the
subwoofer anywhere since you don’t have to access it. The Sumoku
speakers were also the most complete speaker systems in terms of
the details and thoroughness of the manuals and documentation.

The Mercury SW480 featured one of the smallest subwoofers
in the 2.1 speaker category. It is usually easy to set up a 2.1 speak-
er system, but this one featured extremely short cables, making
it rather difficult to set it up on a table, especially if you have a
large monitor and need to place the speakers apart. This was also
apparent with the subwoofer—since they are usually placed on
the ground, there was a bit of a problem due to the short cable. 

A four-channel speaker system is ideally paired with a four-
channel soundcard and it would make sense to go in for one of
these if you intend to buy such a soundcard in the near future. You
can even opt to upgrade to a 4.1 setup if you already posses a four-
channel soundcard but are stuck with your old two-speaker setup.
Though referred to as 4.1 speaker systems, it is implied that these
speakers have discrete Line In connections for the front and the
rear stereo channels. The ‘.1’ channel is the subwoofer that is
derived from the front channels and is not a separate channel. 

Interestingly, even though we received some speakers brand-
ed as 4.1 surround speakers, they were in fact pseudo 4.1 sys -
tems. In reality, they were 2.1 speaker systems that featured a
single stereo input that is taken from the Line Out port of your
soundcard—the rear inputs were missing altogether. Therefore,
even though they have four separate satellite speakers, the rear
speakers receive the exact same signal as the front speakers! 

The one that stood out in the 4.1 speaker category was the
Labtec Arena 530. This four-channel speaker system featured satel-
lites that looked like something straight out of a Star Trek studio
set—they had an eye-catching design, with curvy, well-moulded
grilles and speaker enclosures. Apart from the main volume and
the rear volume buttons on the subwoofer, this one also featured
the power button and a special button called M3D (Matrix 3D),
which helps you simulate four channels from a stereo source.

One of the most feature-rich 4.1 speakers was the Logitech
Xtrusio DSR 100. It features discrete inputs for a 4.1 setup and
also sports an environmental equalizer knob, which lets you vary
the crossover frequency of the subwoofer
across two frequencies, namely 100 Hz
and 10 KHz. The shape of the subwoofer
is far from conventional and the black
colour finish and its oval design makes it
look striking. This speaker sys-
tem also features a digital
connector in addition to
the conventional ana-
logue inputs.

The Creative Inspire
4.1 4400 also provides a
very convenient in-line
remote control for control-

Beats: The periodic variations produced in the loudness of a
sound. Beats can be heard when two tones of slightly different
frequencies are produced at the same time.
Crossover: Most speakers consist of just one full-range speaker
cone (driver) that is used to generate all the audio frequencies.
However, in speakers that use a Woofer, Squaker and Tweeter, the
audio frequencies need to be split and delivered to these specific
drivers. The crossover is a circuitry that is integrated into speak-
ers. It splits the audio frequencies before delivering them to the
specific drivers—low frequencies are sent to the Woofer, mid-fre-
quencies to the Squaker and high frequencies to the Tweeter. 
Decibels: A logarithmic scale of measurement, the decibel is used
to indicate the relative loudness of sound.
Dynamic range: The range exhibited by a speaker system in
producing very soft and very loud sounds without distortion.
Frequency: It is the number of complete sound waves that pass a
point each second and is measured in Hertz (Hz). To put things
into perspective, an Audio CD has a maximum output frequency
of 20 KHz, which means that it can effectively playback the entire
spectrum of sounds audible by humans (the ear can detect fre-
quencies between 20 Hz to 20 KHz).
Frequency response: This is the ability of the speaker system to
respond faithfully to a range of frequencies that it is fed with
across a frequency spectrum. Ideally, a speaker system should

have a flat frequency response for all frequencies
between 20 Hz and 20 KHz as this is the audio
range that humans can hear.
LFE: Often confused with the subwoofer channel, LFE
(Low Frequency Effects) is a channel of low-frequency audio
information in surround sound standards such as Dolby Digi-
tal. It contains low frequencies as experienced in sound effects
such as explosions, gunshots, thunder, etc. This channel is 
discrete in the Dolby Digital standard and is the ‘.1’ in the 5.1
naming convention. In the absence of a dedicated subwoofer
in your home theatre system, the LFE channel would need to
be distributed over the other channels. The subwoofer is sim-
ply a speaker that is tailored to handle low frequencies and it
is therefore paired with the LFE channel in a surround sound
system.
Power rating: This is a specification of the maximum power
that a speaker utilises during operation. Obviously, the greater
this value, the louder the speaker will sound.
Woofers, Tweeters and Squakers: The names of speaker driv-
ers (cones) that are built to reproduce specific frequency
ranges. Woofers are low-frequency drivers, Tweeters are high-
frequency drivers, while Squakers are mid-range drivers. Speak-
er systems are generally based on a Woofer-Tweeter or a
Woofer-Squaker-Tweeter combination.

Jargon Buster

Logitech Xtrusio DSR 100: A feature-rich
4.1 speaker set
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ling the volume. This enables the speakers to be placed anywhere
as the volume control is comfortably within your reach. It con-
nects to the subwoofer through a composite interface, though
the length of the wire seemed abit short.

The Artis S800 4.1, on the other hand, had no discrete con-
nections for the rear channels. All that was provided was a Line
In port, from which the cable connects to the front Line Out port
of the soundcard. What’s interesting is that the subwoofer itself
houses two pairs of ports to connect the rear speakers and front
speakers even though the rear channels received the same signal
as the front channels. The subwoofer also had a 3D sound switch,
which simulates surround sound by adding echoes to the rear
speaker output. The other speakers that follow the same pattern
of pseudo four-channel sound were the Sumoku Alpha - 7, the
Mercury SW 1980 and the Typhoon 5D. 

At the high end of the spectrum, among the 5.1 channel speak-
ers, it’s hard to beat the Artis X8 5.1 when it comes to features. It
sports a mean-looking and very large subwoofer with a black wood-
en finish along with the five satellites, making up a discrete 5.1 sys-
tem. There is no surround sound decoder onboard—this is a
standard six-channel speaker system and therefore it would need
to be linked to an external decoder (such as a Dolby Digital-capa-
ble soundcard like the Creative Audigy) to operate optimally. The
satellites are built such that two cubes are stacked on each other
with a swivel joint and they sport a very sturdy and robust con-
struction. Setting up the speaker was a fairly simple job—the setup
guide in the documentation provided with the speaker set is fairly
detailed. The cables for connecting the rear speakers to the sub-
woofer are sufficiently long, allowing you the freedom to place the
speakers up to 12 feet away from the subwoofer. The front of the
subwoofer has soft-touch buttons for controlling the volume and
bass. The panel also features LED indicators for displaying the mode
of operation of the speaker system. The ends of the cables are tipped
in solder, thus preventing the wire-ends from separating. Also pro-
vided with the set is an infrared remote control, so you don’t have
to budge from the couch when watching a DVD movie. 

The only other 5.1 speaker to provide a wireless remote control
was the Mercury SR-301 F. However, it only featured a volume con-
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Sumoku Alpha - 4R
This 2.1 speaker system was one of the few that provided

an external amplifier unit that contained the bass, treble,
volume and mute controls, making it very
convenient to change the different settings.

It featured a 12-watt subwoofer with
a pair of 2.5-watt satellite speak-
ers. The speaker set is based on a
wooden construction and the

subwoofer is especially striking
with its bolster-like shape. This
speaker system is accompa-
nied with very good docu-

mentation, and for its
audio performance, is
priced very well at Rs
2,150. It’s a good choice for
those who have a stereo
soundcard and are looking
for an upgrade.

Sumoku Alpha - 4R
Features
Performance
Warranty & support
Value for money
OVERALL

AA
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trol without any control for audio parameters such as bass and tre-
ble. The external amplifier also has buttons for choosing any one
of the four preset sound equalization settings, namely rock, clas-
sic, jazz and pop. The front panel of the amplifier houses a 3.5 mm
socket for connecting a pair of external earphones. 

Nowadays, most of the manufacturers have started to provide
speaker stands for satellites. The stands impart a good grip to the
satellites and provide greater control over the positioning of the
satellites. The only 5.1 speaker system that did not feature speak -
er stands was the Typhoon Acoustic 5.1.

Performance
The truest measure of a speaker’s performance is the quality of its
sound reproduction with different types of audio signals. Speak -
ers with higher power ratings don’t always translate into better
sound. For a speaker system to sound good, it should be able to
reproduce sounds across the audible frequency range with a flat
(constant) response and with the lowest possible distortion across
volume levels.

In-game sound quality: In the 2.1 speaker category, the
Sumoku Alpha - 4R is a good choice if you like playing games at
high volumes—it was very clear even when the volume was
turned up to 80 per cent. This was a rare accomplishment com-

pared to the rest of the 2.1
speakers. Also the mid-fre -
quencies were especially well
defined.

Other 2.1 speakers that
did well here were the two
Labtec speakers—the Pulse
424 and the Pulse 325. The
only thing that gives the
Labtec Pulse 424 an edge
over its kin is the higher
power rating for the sub-
woofer and satellites. When

running Quake III Arena, the Labtec Pulse 424 was able to output
good treble effects and the bass delivered a well-rounded punch
when played loud, especially during rocket launcher and
machine gun skirmishes. The only problem with this speaker was
that at very high volume levels, the treble and mid-ranges were
distorted. Even at 50 per cent volume level we could hear a creak-
ing sound from the subwoofer, though this is not loud enough
to be immediately apparent. The Sumoku Alpha - 4R, the Labtec
Pulse 325 and the Labtec Pulse 424 also sounded pretty good
when playing Serious Sam: Second Encounter. The gunfire and the
background audio track were very sharp even when playing at
higher volume levels.

On to the 4.1 speaker systems, the in-game sound quality of
the Logitech Soundman Xtrusio DSR 100 was commendable and
this was apparent from the defined audio effects and in the
reproduction of the background gaming music. Its 52 watt RMS
subwoofer thumped with power while playing back the in-game
audio effects. But the avid gamer who likes to play games at high
volume levels might be disappointed because at higher volume
the overall sound quality starts to drop considerably. The other
speaker systems that did very well in this test were the Typhoon
5D, the Sumoku Alpha - 7 and the Artis S800.

The speaker that delivered sub-par performance was the Cre-
ative Inspire 4.1 4400—
the in-game sound
effects were not as
immersive as the others
in this test. This was
apparent from the fact
that it lacked the power
to reproduce the effects
of the machine gun fire
and the faint echo that is
heard when firing the
rail gun in Quake III.

If you want to enjoy
the full experience of a
Dolby Digital encoded
movie DVD and if you
also want to be future-
ready to play the next
generation of games that will support Dolby Digital audio, 5.1
speakers are the only way to go. Here the Artis X8 5.1 sneaks ahead
of its partner, the Artis S5100, by a hair’s breadth. But there is no
question about the power and the sound quality of the Artis X8—
while running Serious Sam: SE, one could feel the thunderous sound
of the spacecraft exploding overhead in the map Sierra de Chiapas.
As this game also supports EAX and Direct3D, the overall experi-
ence was nothing short of truly immersive! We couldn’t wait to
find out how a rocket in Quake III would sound. After firing up the
game, the sound effects of the machine gun and rocket launcher
firing was powerful and seemed to hit you right in your gut! The
zing of the rail gun was reproduced perfectly, complete with the
faint and distant echo that accompanies the firing of this weapon.
The Artis S5100 came in a close second to the X8 in terms of over-
all gaming sound quality as its overall punch of the low frequen-
cies was not as convincing as the X8. If you are heavily into playing
games, both these speakers are good choices as they reproduce the
audio effects well with the power and clarity that gaming demands.

The 5.1 speaker that trailed in this test was the Mercury 
SR-301 F; it lost out on fidelity at high volume.

Artis S880
This quad-channel speaker system features a black wooden

finish and sports a very sophisticated workmanship. The
subwoofer carries the controls for master volume, subwoofer
volume and rear volume along with the power switch. The

quick setup guide makes it very simple to install. It was
also one of the few speakers to bun-
dle stands for the satellites making

it very simple to
place them around
the listener for 
optimum surround

imaging. At Rs
4,000, it strikes a good bal-
ance between price and
audio performance. If you
already have a four-chan-
nel soundcard or if you
intend to buy one, this
speaker is a good choice.

Artis S880
Features
Performance
Warranty & support
Value for money
OVERALL

A-A-

Speakers that do espe-
cially well in gaming audio

are those that have a good
transient response—this type
of audio response occurs
when there is an extreme
change between sound sig-
nal levels delivered to the
speaker as in the case of gun-
fire, explosions and thunder.



Movie sound quality: Even though the 2.1 speakers category
essentially comprised of stereo speakers, we tested them for DVD
movie playback to ascertain their ability to handle loud and
defined audio for voice and stereo panning. While most of the
speakers delivered average results, the Typhoon DS1032 and the
Artis S320 really stood out in terms of power output. These speak-
ers were able to simulate surround sound even though they are
essentially stereo speakers—the panning effect of sound flying
from one speaker to another was reproduced very well.

In the 4.1 category, the speakers that delivered especially pow-
erful audio and positioning during movie playback were the Labtec
Arena 530 and the Artis S880. The Frontech JIL 1885 didn’t do too
well, with its very average response in playing back the surround
audio. The Sumoku Alpha - 7, the Mercury SW 1980 and the
Typhoon 5D were unable to position audio around the listener as
they are basically stereo speakers bundled with four satellites. 

A 5.1 speaker set can transport you into the middle of a sur-
round sound-rich DVD movie. To test this, we hand-picked some
VOB files with an array of pan and fade effects that send sounds fly-
ing all around you. For those who like to watch DVD movies at
room-shaking volume levels, the answer is the Artis X8—the over-
all panning and background effects were excellent with this speak-

er. One of the VOB
files consisted of a
camera flyby inside
an ice cave: here, the
sounds reproduced
by the rear speakers
were simply stun-
ning. The overall
movie experience is
further enhanced by
the subwoofer’s abili-
ty to reproduce low
frequency sounds
faithfully and with
the room-thumping
power that DVD
movies warrant. The
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Artis S320
The Artis S320 sports good looks and was one of the few

that provided stands for the satellites. The controls
for adjusting the main volume,
treble and bass levels are provided

on the subwoofer. This
was one of the few speak-
ers in the category that
was able to reproduce tre-
ble effects with utmost
clarity and is a good
choice if you prefer to lis-
ten to pop and instru -
mental music. At Rs
2,000, it offers a good
choice for a 2.1 speaker
system.

Artis S320
Features
Performance
Warranty & support
Value for money
OVERALL

A-A-



Mercury SR-301 F, on the other hand, wasn’t able to hold its own—
its surround sound quality and power output was relatively poor.

MP3 and Audio CD sound quality: Here, we evaluated the
ability of the speakers to play back compressed audio (MP3) and
uncompressed audio (Audio CD). Among the 2.1 speakers, the
Sumoku Alpha - 4R had no problem reproducing mid and high
frequency sounds and the audio was pure and sharp across these

frequency bands. This translated into smooth vocals and sharp
definition in instruments such as cymbals and acoustic guitars.
While playing English tracks, the Labtec Pulse 424 came out tops.
It was able to reproduce bass and treble quite well; this was appar-
ent in the clear and defined bass line and percussions. However,
it performed under par when playing back the Hindi CD.

Speakers that fell short of performing well in this test were the
Creative Inspire 2.1 2400, the Mercury SW-480 and the Mercury
880—the overall sound lacked clarity and definition and the out-
put was distorted at higher volume levels.

Among the 4.1 speakers, the clear winner was the Artis S800
with very good performance across the board. This was especially
apparent from the well-defined bass and the sharp trebles. Anoth-
er speaker that delivered good fidelity here was the Typhoon 5D.
Though this pseudo 4.1 speaker is not suited for surround sound
applications, it delivered good response while playing back music. 

The Logitech Soundman Xtrusio DSR 100 also performed well
with crisp and distortion-free audio at volume levels up to 50 per
cent. However, when the overall volume level was increased fur-
ther, the sound output was distorted and clipped. Another prob-
lem was that the subwoofer started to shudder when playing
audio that consisted of low frequency sounds, especially at high
volumes. However, this speaker system scored well as the music
reproduction was very good at normal listening levels (we lis -
tened to the audio tracks at 50 per cent volume level). Also of
worthy mention here is the Sumoku Alpha - 7 which was also a
pseudo 4.1 speaker system but is well suited for music playback.

Among the 5.1 speakers, the Artis X8 once again came out as
the top performer. Its bass reproduction was simply stunning. Even
as we kept pushing the volume levels higher, the X8 didn’t seem
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Dolby Digital (AC-3): The AC-3 (Audio Code number 3) sur-
round sound standard was created by Dolby Laboratories. It
delivers five audio channels in addition to a Low Frequency Effects
(LFE) channel, which is denoted as 5.1 surround sound. Here, the
audio information (in a DVD movie for example) consists of a dig-
ital stream of encoded information, which needs to be correctly
decoded by an external component—in this case, a Dolby Digital
decoder—so that you can hear the separate channels of audio.
Once the channels have been split up, they are sent to the corre-
sponding speakers to give you a surround sound experience.
Technically, Dolby Digital uses six channels, with 18 bits allocated
to each at a sampling frequency of 48 KHz. The first movie to fea-
ture a Dolby Digital soundtrack was Batman Returns.
Dolby Pro Logic: This is an older standard that packs audio
information for a centre and a surround channel into your nor-
mal stereo channel. This is far easier to implement compared to
Dolby Digital. The main difference here is that there is no dis-
crete left and right channel for the surround audio informa-
tion—the same surround signal goes to both the surround
channels (rear speakers). 
DTS: An Acronym for Digital Theatre Systems, this is a standard
that was formulated by Steven Spielberg and is a competitor to
Dolby Digital. It was first debuted in the movie Jurassic Park. It
uses a sampling frequency of 96 KHz with 24 bits allocated to
each of the six audio channels. There are some DVD movies avail-

able with both Dolby Digital as well as DTS sound-
tracks encoded.
Dolby Digital EX and DTS ES: These are new sur-
round audio standards that add an additional surround
sound channel to the 5.1 picture—the rear centre channel. In
the case of Dolby Digital EX, this is done by adding a special
type of Dolby Pro Logic decoder to the surround channels and
creating one more rear centre channel, thus resulting in 6.1
channel sound. A similar strategy is employed by the DTS ES
standard where an additional rear centre channel is supple-
mented to the two surround channels.
THX: An acronym for Tomlinson Holman’s eXperiment, THX is
often misunderstood as another surround sound technology.
Instead, this is a ‘seal of approval’ standard that involves certifi-
cation and approval of the components that go into a home
theatre such as amplifiers, video playback equipment, speakers,
equalizers, etc. THX aims to ensure that the movie-watching
audience experiences the highest standard of audio and video
in theatres and home audio-video equipment. There are two
other sub-standards to the original THX standard—THX Select
and THX Ultra. Among other specifications, these were formu-
lated according to the size of the areas the THX system is to be
installed in. THX Select is for installations up to 2,000 cubic feet,
while THX Ultra is for installations between 2,000 and 3,000
cubic feet.

Surround Sound Standards

Labtec Arena 530
The Labtec Arena 530 is bound to grab your attention

with its subtle contoured body. The overall build qual-
ity is very good with the satellites featuring grips so that
they remain anchored to your desk even at high volumes.

The system provides a function called
Matrix 3D (M3D), which can be acti-
vated through a button on the sub-

woofer and which simu-
lates four channels of
audio from a stereo source
such as MP3s or Audio
CDs. The connecting
cables are fairly long, giv-
ing you more freedom in
placing the speakers. It’s
priced at Rs 5,999 and
gives impressive audio
performance.

Labtec Arena 530
Features
Performance
Warranty & support
Value for money
OVERALL

B+B+



to complain. Even at
80 per cent volume
level, the overall
sound quality was
good and the bass
didn’t sound flat.
However, the vocals
sounded a little over-
powering while play-
ing Audio CDs.
Another area where
the speaker was
found to be slightly
lacking was in the

reproduction of high frequency sounds. This however, was reme-
died with equalisation through the audio playback software.

Special audio test: A good set of speakers should be capable
of playing different types of sound as they are going to be used
for everything ranging from movies to different genres of music.
To evaluate these parameters, we used a special CD that con-
tained a variety of such sounds across 17 audio tracks.

Among the 2.1 speakers, the Mercury SW-980 should get a
worthy mention here as it was able to reproduce different back-
ground effects such as the chirping of a bird or nuances like
breathing noises during songs. The Artis S400 also exhibited
good characteristics here—it produced commendable audio
effects ranging from gunshots to explosions and thunder. The
speaker that did not perform well in this test was the Mercury
SW-480. There was loss in clarity and definition while playing
back certain subtle sounds.

The 4.1 speakers that stood out were the Artis S880 and the
Sumoku Alpha - 7. Here the Artis S880 adequately reproduced
background effects with good overall clarity. Especially impressive
was the reproduction of sounds such as thunder, gunshots, etc.
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Artis X8 5.1

Sporting a black finish, the first
thing that strikes you with this

speaker system is its enormous sub-
woofer. This speaker system
has six discrete channels of
input and is therefore ideal-
ly suited to a Dolby Digital

setup. With adequate documentation
and a quick setup guide, setting up this speaker system is a
simple task. The long cables ensure that there is adequate
room for setting up the speakers. Additionally, there is also
an infrared remote control provided for controlling volume,
mute, bass and treble settings. The front of the subwoofer
has soft-touch controls for main volume, bass, etc. The panel

also features an LED indi-
cator for displaying sound
setup. It is priced at Rs
12,000 and if power is
what you’re looking for,
this speaker system defi-
nitely fits the bill.

Artis X8 5.1
Features
Performance
Warranty & support
Value for money
OVERALL

A-A-
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Background effects such as the chirping of a bird, the beating of
drums and a person’s breathing while singing were reproduced
with excellent clarity. Though the Typhoon 5D struggled when
reproducing subtle sound effects, its bass and treble effects were
almost flawless. The ones that did not do well in this category of
speakers were the Typhoon Acoustic 4.1 and the Frontech JIL 1855.

The Artis S5100 left the other 5.1 speakers behind with its
impressive sound quality for different audio effects. Background
sound effects like the drag of a guitar, the double beat while a
piano is being played, etc were reproduced with complete finesse.
Coming in a close second was the Artis X8, which also exhibit-
ed impressive sound quality in reproducing these special effects
and music tracks. In particular, it was able to clearly reproduce a
detail that was missed by most speakers—the clunk of the shell
falling after a cannon is fired. The Typhoon Acoustic 5.1 per -
formed poorly in this test. Its effect was noisy and distorted, espe-
cially for loud sounds.

Sound frequency test: In this test, we evaluated the speaker’s
response to four bands of frequencies. The overall frequency
response of all the speakers was good, with just a handful of them
falling under par. The 2.1 speakers that stood out in this test were
the Artis S320, the Mercury 880, the Mercury SW-980 and the
Frontech JIL 2002—all exhibited very sharp response in the satel-
lite speakers at a frequency of 15 KHz. The overall performance
in the mid-frequency range was acceptable for all the speakers in
this category. However, in reproducing bass frequencies, we
found that the Mercury SW-480 and the Artis S100 exhibited
very poor response at the 30 Hz reference frequency. This was
also the case with the Sumoku Alpha - 6 and the Aplha - 5 speak-
er systems. The speaker that stood out in the bass test (30 Hz) was
the Creative Inspire 2.1 2400 with clear and room-filling low-
frequency response.

The Labtec Arena 530 took the crown among the 4.1 speak-
ers by accurately reproducing the 30 Hz sound file and is there-
fore very suited to applications where you would want good bass
frequency response as in R&B music or gaming. The Typhoon

Acoustic 4.1 and the Mercury SW 1980 also did very well in this
test. Both reproduced the test tones reasonably faithfully. The
Mercury SW 1980 exhibited a slight loss in the mid-frequencies
while the Typhoon Acoustic 4.1 fell just a shade under par over
all the frequencies.

Among the 5.1 speakers, the Mercury SR-301 F failed to play
the 30 Hz file. Another speaker that had problems here was the
Typhoon Acoustic 5.1. This speaker played the 30 Hz file but the
sound was barely audible at the reference 50 per cent volume
levels. As opposed to this, the Artis X8 played the same 30 Hz
audio file with ease at the same volume level. The X8 displayed
its strength in playing the other frequency bands too, where it
played the test audio without distortion.

Power handling test: We played two MP3 files at maximum
system and speaker volumes. Among the 2.1 speakers, the Labtec
Pulse 325 played the ultimate bass and treble test file with sur -
prising ease and there was hardly any perceptible distortion at
high volume levels. Coming in a close second was the Sumoku
Alpha - 4R with good response at high volume levels. The
Typhoon DS1032 and the Mercury SW-480 suffered in this test.
These speaker systems exhibited a high level of distortion when
operated at high volume levels. When we played the ultimate
bass test file, the overall sound quality started to get noisy even
at 70 per cent overall volume tests—avoid these speakers if you
like listening to music at very high volume levels.
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Artis S5100

The Artis S5100 5.1 features good looks and very acceptable
sound quality. The setup features true 5.1 surround sup-

port with discrete inputs for the front left, front right, center,
rear left, rear right and subwoofer channels. The subwoofer

carries controls for adjusting master
volume, rear volume and bass levels.

The quick setup guide provided gives
basic details about setting up the

speakers. The satellites
have stands, making
them easy to place for
optimum surround
imaging. If you are look-

ing for a fully Dolby Digi-
tal compliant speaker sys-
tem, this one is a good
choice. And considering
its performance, it is rea-
sonably priced at Rs 6,500.
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Artis S5100
Features
Performance
Warranty & support
Value for money
OVERALL

B+B+
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Features
Speaker Specifications
Physicial Dimensions 
(LxWxH, in cm)

Subwoofer
Satellites
Centre

Power Rating (RMS)
Subwoofer
Satellites (Front/Rear)
Centre

Frequency response range
Amplifier/Dolby Digital 
Decoder
Connectors

Front
Rear
Centre/Subwoofer
Coaxial
DIN
S/PDIF
Optical

Speaker Controls (Vol, Bass,
Treble, Mute, Balance, Rear Vol)
Bundled Accessories 

Power Adapter
Speaker Stands
Remote Control/Wireless

Manual & documentation (Y/N)
Listing of specifications
Quick setup guide
Troubleshooting
Contact information for after-
sales support
Performance
Sound Quality Tests
In-game Sound (Scale of 5)

Quake III Arena 
(Map: The Longest Yard)
Serious Sam 2 
(Map: Sierra de Chiapas)

DVD Movie (Scale of 5)
Music Quality (Scale of 5)

English Audio CD
Hindi Audio CD
MP3

Special Audio Test Files 
(Scale of 5)
Sound Frequency Test 
(Scale of 5)
30 Hz
250 Hz
10,000 Hz
15,000 Hz
Power Handling Test (Scale of 5)
Ultimate Bass Test
Ultimate Treble Test
Warranty & Support
Number of authorised service
centres
Number of cities where service
centres are present
Period of warranty (months)
Overall Score
Features (20%)
Performance  (50%)
Warranty & Support (10%)
Value for Money (20%)
Overall Product Rating
Overall Grade
Vendor name

Phone
E-mail

Price (In Rupees)

Artis S100

15 x 27 x 20.7
9.2 x 9.7 x 9
NA

NA
NA
NA
40 Hz - 18 KHz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass

✔

✔

✖

✔

✔

✖

✖

2.5

3

2.5

3
2.8
2.5
2.88

2.5
4.5
4
4

2.5
3

2

8

12

9.31
38.70
4.00
8.63
60.64

Kunhar Peripherals
Pvt Ltd
022-2345758
salesbom
@kunhar.com
2,000

Artis S320

26.5 x 14 x 21.5
11.5 x 10 x 15
NA

NA
NA
NA
40 Hz - 18 KHz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass, Treble

✔

✔

✖

✔

✔

✖

✖

3

2.5

3.5

3
3.3
3.3
2.88

4.5
4.5
4
4.5

2.5
4.5

2

8

12

9.98
44.29
4.00
9.88
68.14

Kunhar Peripherals
Pvt Ltd
022-2345758
salesbom
@kunhar.com
2,000

Artis S400

26.5 x 15 x 20
10 x 9 x 9
NA

NA
NA
NA
40 Hz - 18 KHz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass

✔

✔

✖

✔

✔

✖

✖

1.5

2

2.5

2.5
3
2.5
3.15

4
3.5
4
4

2
3

2

8

12

9.31
37.91
4.00
6.29
57.51

Kunhar Peripherals
Pvt Ltd
022-2345758
salesbom
@kunhar.com
2,600

Creative Inspire
2.1 2400

19.2 x 19.2 x 21.1
9.5 x 9.5 x 8.7
NA

12
4.5
NA
42 Hz - 20 KHz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass

✔

✖

✔/✖

✖

✖

✖

✖

2.5

2.5

2.5

2
2.8
2
3.00

5
3.5
4
4

2
3

18

18

12

6.65
35.78
5.32
5.05
52.80

Compuage Infocom
Ltd
022-8305500
info@
compuageindia.com
2,818

Frontech JIL 2002

22 x 16 x 25
14 x 11 x 18
NA

NA
NA
NA
NA
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass 

✔

✖

✖

✖

✖

✖

✖

3

3

2.5

2.5
2.3
2.5
2.65

4.5
4.5
4.5
4.5

3
3

12

12

12

5.32
38.57
5.32
5.78
54.99

Jupiter Infosys India
Ltd
022-2001211
frontech@bom5.
vsnl.net.in
2,600

Labtec Pulse 325

18 x 23 x 15
6 x 7 x 8
NA

5
2.5
NA
40 Hz - 20 KHz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol

✔

✖

✖

✖

✔

✖

✖

3.5

3.5

3

2.5
2.8
2.8
3.09

4.5
4.5
4
4

4.5
4.5

15

15

12

5.32
43.23
5.32
8.06
61.93

Aditya Infotech Ltd

022-6338555
aditya_mmb
@adityagroup.com
2,149

Labtec Pulse 424

25 x 23 x 23
7.5 x 7 x 12.5
NA

20
6
NA
35 Hz - 20 Khz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass

✔

✖

✖

✖

✔

✖

✖

3.5

3.5

3

3.5
2.5
2.5
3.06

3.5
3.5
4
4

3
3

15

15

12

6.65
40.70
5.32
3.24
55.91

Aditya Infotech Ltd

022-6338555
aditya_mmb
@adityagroup.com
4,499

CATEGORY



Mercury 880

17 x 16 x 21
15 x 11 x 20.5
NA

NA
NA
NA
NA
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass, Treble

✔

✖

✖

✖

✖

✖

✖

2.5

2.5

3

2
2.3
2
2.50

4.5
4
4.5
4.5

2.5
3.5

2

4

12

5.99
36.04
4.00
13.64
59.66

Kobian India Pvt Ltd

080-5566626
rohit@kobian.com

1,150

Mercury SW-480

13 x 11 x 15
11 x 7 x 13.5
NA

NA
NA
NA
NA
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol

✔

✔

✖

✖

✖

✖

✖

2.5

2

2.5

2
2.5
2
2.26

0
3
3.5
3.5

2.5
2

2

4

3

5.99
29.79
1.33
18.09
55.20

Kobian India Pvt Ltd

080-5566626
rohit@kobian.com

750

Mercury SW-980

26 x 15 x 20
11 x 9 x 14
NA

NA
NA
NA
NA
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass 

✔

✔

✖

✖

✖

✖

✖

3

3

3

3
2.8
2.5
3.21

4.5
4.5
4.5
4.5

2
4.5

2

4

12

6.65
42.03
4.00
13.44
66.12

Kobian India Pvt Ltd

080-5566626
rohit@kobian.com

1,350

Sumoku Alpha -
4R

23 x 23 x 40
9 x 9 x 12.5
NA

12
2.5
NA
50 Hz - 18 Khz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass, Treble,
Mute

✔

✖

✖

✔

✔

✔

✔

3.5

3.5

3

3
3
3.5
3.00

4.5
4.5
4
4

3.5
4.5

5

5

12

11.97
44.82
4.00
9.59
70.38

Palesha Electronics
Industries
9520-6355702
palesha@vsnl.com

2,150

Sumoku Alpha - 5

29 x 21 x 44
15 x 12 x 21
NA

15
4.5
NA
50 Hz - 18 Khz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass, Treble,
Mute 

✔

✖

✖

✔

✔

✔

✔

2

2

2.5

2.5
2.5
2.5
2.50

0
3
3.5
3.5

2
3

5

5

12

11.97
32.72
4.00
6.01
54.70

Palesha Electronics
Industries
9520-6355702
palesha@vsnl.com

2,560

Sumoku Alpha - 6

29 x 21 x 44
15 x 12 x 21
NA

15
7.5
NA
50 Hz - 18 Khz
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol, Bass, Treble,
Mute 

✔

✖

✖

✔

✔

✔

✔

3

3

2.5

2
2.3
2.5
2.38

0
3.5
3.5
3.5

2.5
3.5

5

5

12

11.97
33.12
4.00
4.66
53.75

Palesha Electronics
Industries
9520-6355702
palesha@vsnl.com

3,200

Typhoon DS1032

19 x 20 x 25
10 x 8 x 13
NA

20
5.5
NA
18 Hz - 20 Khz
✔ ✖ 

✔

✖

✖

✖

✖

✖

✖

Vol, Bal

✔

✖

✖

✖

✖

✖

✖

3.5

2.5

3.5

2.5
2.8
2.5
2.62

3.5
4
4
4

2.5
3.5

7

7

12

5.32
38.97
4.00
4.97
53.26

Hitech Computers 

022-4927323
bom@hitechit.com

2,980

Typhoon
Superwoofer

19 x 20 x 25
10 x 8 x 13
NA

NA
NA
NA
NA
✔ ✖

✔

✖

✖

✖

✖

✖

✖

Vol

✔

✖

✖

✖

✖

✖

✖

2.5

2

2.5

2.5
2.5
2.5
2.56

4.5
3
4
4

1.5
2.5

7

7

12

4.66
35.11
4.00
17.30
61.06

Hitech Computers 

022-4927323
bom@hitechit.com

870

2.1 SPEAKERS



Features
Speaker Specifications
Physicial Dimensions 
(LxWxH, in cm)

Subwoofer
Satellites
Centre

Power Rating (RMS)
Subwoofer
Satellites (Front/Rear)
Centre

Frequency response range
Amplifier/Dolby Digital
Decoder
Connectors

Front
Rear
Centre/Subwoofer
Coaxial
DIN
S/PDIF
Optical

Speaker Controls (Vol, Bass,
Treble, Mute, Balance, Rear Vol)
Bundled Accessories 

Power Adapter
Speaker Stands
Remote Control/Wireless

Manual & documentation (Y/N)
Listing of specifications
Quick setup guide
Troubleshooting
Contact information for after-
sales support
Performance
Sound Quality Tests
In-game Sound (Scale of 5)

Quake III Arena 
(Map: The Longest Yard)
Serious Sam 2 
(Map: Sierra de Chiapas)

DVD Movie (Scale of 5)
Music Quality (Scale of 5)

English Audio CD
Hindi Audio CD
MP3

Special Audio Test Files 
(Scale of 5)
Sound Frequency Test 
(Scale of 5)
30 Hz
250 Hz
10,000 Hz
15,000 Hz
Power Handling Test (Scale of 5)
Ultimate Bass Test
Ultimate Treble Test
Warranty & Support
Number of authorised service
centres
Number of cities where service
centres are present
Period of warranty (months)
Overall Score
Features (20%)
Performance  (50%)
Warranty & Support (10%)
Value for Money (20%)
Overall Product Rating
Overall Grade
Vendor name

Phone
E-mail

Price (In Rupees)

Artis S800

30 x 10 x 23.5
8.5 x 9.5 x 9.5
NA

NA
NA
NA
40 Hz - 18 KHz
✔ ✖

✔ 

✖*
✖

✖

✖

✖

✖

Vol, Bass

✔ 

✔ 

✖

✔

✔

✖

✖

3.5

4

3.5

4
3.5
3.5
3.06

0
3.5
3.5
3.5

3
4.5

2

8

12

9.31
40.30
4.00
5.23
58.84

Kunhar Peripherals
Pvt Ltd
022-2345758
salesbom@
kunhar.com
3,200

Artis S880

28 x 17 x 23.5
9 x 10 x 11.5
NA

NA
NA
NA
40 Hz - 18 KHz
✔ ✖

✔ 

✔ 

✖

✖

✖

✖

✖

Vol, Bass, Rear Vol

✔ 

✔ 

✖

✔

✔

✖

✖

3

3

3.5

3.5
3.5
3.5
3.41

3.5
4.5
4
4

3
4.5

2

8

12

11.31
46.68
4.00
4.83
66.81

Kunhar Peripherals
Pvt Ltd
022-2345758
salesbom@
kunhar.com
4,000

Creative Inspire
4.1 4400

21.1 x 19.1 x 19.2
8.7 x 9.5 x 9.5
NA

17
6
NA
40 Hz - 20 KHz
✔ ✖

✔ 

✔ 

✖

✖

✖

✖

✖

Bass

✔ 

✖

✔/✖

✖

✖

✖

✖

2.5

2

3

2
2.3
2.5
2.88

3.5
4.5
4
3.5

2.5
3

18

18

12

7.32
36.58
5.32
3.16
52.37

Compuage Infocom
Ltd
022-8305500
info@
compuageindia.com
4,255

Frontech JIL 1855

26.5 x 15 x 20
11 x 8 x 11
NA

NA
NA
NA
30 Hz - 20 KHz
✔ ✖

✔ 

✔ 

✖

✖

✖

✔ 

✖

Vol, Bass

✔ 

✖

✖

✖

✖

✖

✖

2.5

2.5

2

3
3
2.5
2.74

3
2.5
4
4

3
3

12

12

12

7.98
34.45
5.32
10.34
58.08

Jupiter Infosys India
Ltd
022-2001211
frontech@bom5.
vsnl.net.in
1,500

Labtec Arena 530

19 x 19 x 22
10 x 10 x 14
NA

15
4
NA
40 Hz - 20 KHz
✔ ✖

✔ 

✔ 

✖

✖

✖

✖

✖

Vol, Rear Vol

✔ 

✔ 

✖

✖

✔

✖

✖

2.5

3

3.5

3.5
3.5
3
3.00

5
4.5
4
4

4.5
4.5

15

15

12

9.31
45.89
5.32
2.71
63.23

Aditya Infotech Ltd

022-6338555
aditya_mmb@
adityagroup.com
5,999

Logitech
Soundman
Xtrusio DSR 100

18.5 x 27.5 x 30.5
8 x 7.5 x 5
NA

52
12
NA
28 Hz - 20 Khz
✔ ✖

✔ 

✔ 

✖

✖

✔ 

✔ 

✖

Balance

✔ 

✖

✔/✖

✔

✔

✔

✔

4

3.5

3

4
3.3
3.5
3.06

4.5
4.5
4.5
0

2.5
2.5

25

25

12

14.63
43.36
4.00
0.97
62.95

Rashi Peripherals

022-8260258
ho@rptechindia.
com
12,000

Mercury SW 1980

26.5 x 15 x 20
9 x 8.5 x 13
NA

24
6
NA
NA
✔ ✖

✔ 

✖*
✖

✖

✖

✖

✖

Vol, Bass 

✔ 

✔ 

✖

✖

✖

✖

✖

3

3

2.5

3
2.5
3
3.06

4.5
4
4.5
4.5

2.5
3.5

2

4

12

6.65
38.57
4.00
7.25
56.47

Kobian India Pvt Ltd

080-5566626
rohit@kobian.com

2,200

4.1 SPEAKERSCATEGORY

Disclaimer: * Pseudo-4.1 speakers (four satellites, but they only have front stereo inputs)



Sumoku Alpha - 7

29 x 21 x 44
15 x 12 x 21
NA

16
8
NA
50 Hz - 18 KHz
✔ ✖

✔ 

✖*
✖

✖

✖

✖

✖

Vol, Bass, Treble, Mute

✔ 

✖

✖

✔

✔

✔

✔

4

3.5

3.5

4
3
3.5
3.12

4
3.5
4
4

3.5
4.5

5

5

12

11.97
42.56
4.00
4.55
63.08

Palesha Electronics
Industries
9520-6355702
palesha@vsnl.com

3,950

Typhoon 5D

23 x 22 x 30
10 x 9 x 9.5
NA

NA
NA
NA
100 Hz - 20 KHz
✔ ✖

✔ 

✖*
✖

✖

✖

✖

✖

Vol, Bass, Treble, Rear
Vol

✔ 

✔ 

✖

✖

✖

✖

✖

4

3.5

3.5

4
3.3
3.5
2.88

2.5
3.5
3.5
2.5

1.5
2

7

7

12

9.31
41.90
4.00
5.05
60.26

Hitech Computers 

022-4927323
bom@hitechit.com

3,400

Typhoon Acoustic 4.1

20 x 19 x 25
9 x 8 x 12
NA

20
4
NA
48 Hz - 20 KHz
✔ ✖

✔ 

✔ 

✖

✖

✖

✖

✖

Vol, Rear Vol

✔ 

✔ 

✖

✖

✖

✖

✖

2.5

2.5

3

2.5
2
3
2.47

4
4
4
4

2.5
3

7

7

12

7.98
36.97
4.00
2.23
51.18

Hitech Computers 

022-4927323
bom@hitechit.com

5,625

Artis S5100

30.5 x 16.5 x 26
10 x 8 x 8
10 x 8 x 8

NA
NA
NA
30 Hz - 20 KHz
✔ ✖

✔ 

✔ 

✔ 

✖

✖

✖

✖

Vol, Bass, Rear Vol

✔ 

✔ 

✖

✔ 

✔

✖

✖

3

3

3.5

2.5
2.8
3
3.06

4
3.5
4
4

3.5
3.5

2

8

12

11.31
41.76
4.00
2.30
59.36

Kunhar Peripherals Pvt
Ltd
022-2345758
salesbom@kunhar.com

6,500

Artis X8 5.1

45 x 19 x 35
10 x 11.5 x 16
10 x 11.5 x 16

NA
NA
NA
40 Hz - 18 KHz
✔ ✖

✔ 

✔ 

✔ 

✖

✖

✖

✖

Vol, Bass

✔ 

✔ 

✔/✔ 

✔ 

✔

✖

✖

3.5

3

3.5

4
3.3
3
2.88

5
4
4
4

4.5
4.5

2

8

12

14.63
45.89
4.00
1.05
65.56

Kunhar Peripherals Pvt
Ltd
022-2345758
salesbom@kunhar.com

12,000

Mercury SR-301 F

17 x 17 x 24
13 x 7.5 x 15
10 x 8 x 16

NA
NA
NA
NA
✔ ✖

✔ 

✔ 

✔ 

✖

✖

✖

✖

Vol

✔ 

✔ 

✔/✔

✖

✖

✖

✖

2

2

2

2
2.3
2
2.76

0
3.5
3.5
3.5

2
3.5

2

4

12

11.31
31.12
4.00
2.57
48.99

Kobian India Pvt Ltd

080-5566626
rohit@kobian.com

4,800

Typhoon Acoustic 5.1

28 x 17 x 23.5
9.5 x 8 x 12
9.5 x 8 x 12

20
16
16
30 Hz - 18 KHz
✔ ✖

✔ 

✔ 

✔ 

✖

✖

✖

✖

Vol, Bass, Rear Vol

✔ 

✖

✖

✖

✖

✖

✖

3

2.5

3.5

3
2.3
2.5
2.35

2.5
2.5
3.5
3.5

2.5
2.5

7

7

12

8.65
34.85
4.00
2.82
50.31

Hitech Computers 

022-4927323
bom@hitechit.com

4,590

5.1 SPEAKERS



test drive ■
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The Labtec Arena 530 4.1 speaker per-
formed well here too. There was minimal
distortion at the maximum volume level.
This means if you really like low frequency
response, it would be a good idea to go in for
this speaker system. However, one glaring
disadvantage is that the Labtec Arena shud-
ders quite a lot while playing low frequency
sounds at considerably higher volume lev-
els. Coming in a very close second was the
Sumoku Alpha - 7—in spite of being a pseu-
do four-channel speaker system, this one
exhibited very commendable power han-
dling capabilities. The other speakers that
performed well in playing back high fre -
quencies at high volumes turned out to be
the Artis 800 and the Artis 880. One of the speakers that was
really battered in the ultimate bass test was the Typhoon 5D. It
exhibited a very high amount of distortion and the overall
sound quality was exceedingly noisy. The Logitech Soundman
Xtrusio DSR 100 also performed poorly here as its sound quali-
ty fell drastically once the volume levels were raised beyond the
60 per cent mark.

The undisputed winner among the 5.1 speakers was once
again the Artis X8. We expected an overall distorted sound but
the X8 was able to hold its own and play both the ultimate bass
test and the ultimate treble test file with minimum distortion.
If you like playing songs and movies at the highest volumes
possible, the Artis X8 should be your pick. On the other hand,
the Typhoon Acoustic 5.1 was audibly stretched under the stress
of the power-handling test. It generated a lot of distortion 
when playing at maximum volume levels—we could hardly
hear any vocals while the sound file was being played at the
maximum volume.

Warranty and support
In terms of the product warranty and service infrastructure,

there is a wide variation among the brands. The most com -
prehensive after-sales support and coverage is by Logitech,
which has 25 service centres over the same number of cities.
Coming in a close second is Creative with 18 service centres
in the same number of cities and Labtec with 15 service cen-
tres in 15 cities.

The brands that are lacking in service support are Mercury,
Artis, Typhoon and Sumoku. Mercury has just two service cen-
tres each in four cities. Though Artis has authorised dealerships
in eight cities, it has authorised service centres in just two of
these. Typhoon has service centres in seven cities, while Sumoku
has only five.

What it all leads to
Sound for your computer has truly evolved over the past year,
where it is now being given the importance it is due. In the
face of applications that are more demanding on the audio per-
formance of your PC such as MP3 audio and DVD, you will
never really be satisfied with the plain-Jane stereo speakers.
Let’s take a look at the speakers that lived up to these new age
applications.

You need
Look for

The models

Price range

To play music and day-to-day work
Stereo speakers that have a good
frequency response, decent power
and accessible volume controls

Price-conscious
Typhoon
DS1032, 
Mercury SW-980
Rs 800 to 
Rs 1,400

Performance 
Artis S320,
Sumoku 
Alpha - 4R
Rs 2,000 to 
Rs 2,200

Surround gaming and home theatre
Support for at least four discrete chan-
nels (ideally 5.1), good transient
response, separate inputs for front and
rear channels (stay away from pseudo
four-channel speakers), adequate
power for reproducing movie audio
effects like gunshots and explosions

Decision Maker

Price-conscious
Artis S880, Log-
itech Soundman
Xtrusio DSR 100
Rs 4,000 to 
Rs 12,000

Performance
Artis X8 5.1,
Labtec Arena 530

Rs 6,000 to
Rs 12,000

Power rating: Always go by the RMS power rating of a speaker
system rather than the Peak Music Power Output (PMPO). RMS is
the true technical measure of a speaker’s capability to handle
continuous power. For your computer-based surround speaker
system, a rating of 40 watts RMS is a good place to start.
Frequency response: If your speaker system has a frequency
range that is limited at the upper end (if it cannot perform above
16 KHz, for example), you will not hear any of the high trebles
and will lose definition in your music, especially if you listen to a
lot of classical music. Similarly, if your speaker system cannot go
below 50 Hz, it will not be able to correctly reproduce the low
frequencies such as bass drums and explosions in movies.
Stands: When buying 2.1 speakers primarily for music playback,
you wouldn’t need speaker stands as you would most probably
place them directly on your desktop. However, for a 4.1 or 5.1
speaker system, ensure that each satellite has a base or a stand.
This is useful for placing them behind you on a wall or even stand-
ing on the floor at ear-level for proper surround sound imaging.

Controls: Speakers with an in-line volume control
give you the freedom to control the master speaker
volume without having to reach troublesome locations
like the subwoofer where the volume controls are generally placed.
Audio inputs: If you have a standard 2.1 stereo speaker system,
you only need standard analogue left and right channels. How-
ever, in the case of a four-point surround sound system, look
out for four separate channels of analogue audio inputs to your
speaker system. This would be in the form of two 3.5 mm
stereo inputs (left/right for front and left/right for rear) or four
separate RCA inputs. Also watch out for pseudo four-channel
speakers—these are basically just stereo speakers. In the case of
5.1 speakers, you would need either six separate RCA inputs for
the discrete AC-3 channels (if the signal is already being 
decoded by an external decoder like the Sound Blaster Live! 5.1
DE soundcard) or a DIN connector that is fed by the digital 
output of your soundcard in order to have true Dolby 
Digital compliance.

Buying Tips



2.1 speaker systems
Among the stereo 2.1 speaker systems, the one that stood out in
terms of sheer performance was the Sumoku Alpha - 4R, which
bagged our Best Performance Award. With very definitive gaming
performance, this speaker system is ideal if you want to hear the
tinker of the machine gun shells as they fall around you.

The Best Value Award in this category goes to the
Mercury SW-480. Featuring one of the most com-
pact subwoofers in its
category, this speaker
delivers acceptable
performance at a sur-
prisingly low price of
Rs 750, making it a
good choice if you
want a subwoofer-
satellite stereo speak-
er system.

4.1 speaker systems
The 4.1 speaker that bagged the Best Performance Award was the
Artis S880. This all-black speaker system stood out for its supe-
rior sound quality in gaming, as well as the movie tests where it
provided powerful and well-defined sound. It was also able to
handle high volume levels with ease and should be your choice
if you like to ‘bring the house down’.

The Frontech JIL
1855 bagged the
award for Best Value
in this segment with
its very competitive
price of Rs 1,500
while still providing
all the functionality
of a 4.1 speaker system.

5.1 speaker systems
Among the 5.1 speaker systems, the one that stood out was the
Artis X8 5.1. It delivered stellar performance in nearly all the
tests and exhibited the power to withstand any amount of stren-
uous audio applications you could care to throw at it. It wins the
Best Performance Award.

The Typhoon Acoustic 5.1 bagged the Best Value Award
in this category. This system provides complete support for sur-

round sound standards
such as Dolby Digital or
DTS and is priced very
well at Rs 4,590, making
it an ideal choice for
those making their first
foray into the world of
true surround sound on
their PC.

Catering to a varied
array of needs and budg-
ets, today’s computer

speaker systems have the mettle to deliver the performance
required for immersive audio on your computer; it is only a mat-
ter of time before other high-performance standards such as THX
reach your desktop PC. Until then, pump up the volume! 

YATISH SUVARNA and MARCO D’SOUZA
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Typhoon Acoustic 5.1: Compact, power-
ful and AC-3 capable

Frontech JIL 1855: Powerful quad-
channel support at a good price

Mercury SW-480: Decent 
performance at a great price
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T
he thought that a bland, beige box that at best
beeped an error at you through an internal
speaker, would one day evolve into every
audiophile’s dream sound machine was
unimaginable. Yet within a span of 10 years,
the PC has gone from beeps and now proudly

offers Dolby Digital surround sound in all its 5.1-channel
glory. This mini-revolution has been headed by the unas-
suming soundcard that can be found nesting inside most
computer systems.

A few years back, a musician would have been forced to buy
a sound system that ran into lakhs of rupees. Now, thanks to
the evolution of the soundcard and the introduction of fea -
tures such as wavetable synthesis, 24-bit recording depth at 
96 KHz, digital input and output connectors, a computer and
a good soundcard will let you create professional music at an
affordable price. The computer has also become the primary
source of entertainment, replacing both the TV and the silver
screen. Armed with the right soundcard, it can deliver theatre-
quality movies in the comfort and convenience of your home.
And if you enjoy playing computer games, the experience has
never been better. 

We approached this test with the intention of suggesting
the best sound solution to suit your needs. We tested six
soundcards that were available in the market. Also, as newer
motherboards now come with in-built sound support that
offers above average audio quality, we included two mother-
boards with integrated sound chipsets in our tests. 

Digit Test Process
The test system consisted of an Intel Pentium 4 2.53 GHz
processor on an Intel 845GBV motherboard, along with 
256 MB of DDR SDRAM and an 8 GB (5,400-rpm) hard 
disk. All sound tests were conducted under Windows XP 
Professional. 

As the speakers can affect the sound quality, we chose the
most appropriate speakers for each card. Thus for those that
supported 2.1-channel output we used Labtec Pulse 424 2.1
speakers. For both 4.1 channel and 5.1 channel soundcards
Creative DTT 2500 Digital, (5.1 speakers) was used. By choos-
ing the best speaker set for each card, we hoped to eliminate
the speakers as a potential bottleneck. 

Digit Test Methodology
We evaluated each soundcard both in terms of what it can the-
oretically deliver and what it actually offers. We evaluated the
different soundcards on performance (40 per cent weightage),
features that they sport (30 per cent weightage), warranty and
support (10 per cent weightage) and value for money (20 per
cent weightage). 

Features: Certain features should be looked for before purchas-
ing a soundcard, such as the number of channels it supports,
whether it is compatible with the major sound APIs and the build
quality of both the card and the cables that accompany it. A card
was awarded points based on these criteria. 

Performance: We defined the performance of a soundcard
based on both subjective and analytical tests. The subjective tests
evaluated the card for the music quality while playing audio CDs
and the sound quality in games. Even the best soundcards stress
the CPU to some
extent. We used
both a game and
a benchmark tool
to determine the
impact that a
soundcard might
have on CPU util-
isation. Finally,
RightMark Audio
Analyzer (RMAA)
was used to deter-
mine the techni-
cal performance
of a soundcard.
a) Sound quality: This was a subjective test to ascertain the per-
formance of a card while handling both music and games. We
played four different music tracks—two Hindi and two English.
This helped us access the ability of a soundcard to reproduce dif-
ferent musical tones and notes. To determine the sound quality
that a soundcard delivers under a game, we chose Quake III Arena
(map DM9). We ran the game with High Quality sound enabled
and at 1024x768 with 32-bit colour and texture depth.
b) CPU utilisation: We used Quake III Arena to ascertain the stress
a soundcard puts on the CPU while playing back High Quality

audio. We used an
in-game pre-record-
ed demo (Demo
Four) and noted the
fps count under
Normal and High
Quality sound set-
tings. The screen
resolution was kept
at 1024x768x32.
We also used 3D
Audio WinBench,
which is an effec-
tive test that gives

3D Audio WinBench was used to measure the
CPU utilisation of each soundcard

The RightMark Audio Analyzer was used to
determine the technical performance of a card

PCs no longer play little whooshes and tinkles. New-age entertainment applications such as DVDs and
next-generation games provide a total surround sound experience… if your soundcard supports it
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the percentage of system resources that a soundcard consumes
while it processes and outputs sound at 16 bit and 22 KHz 
frequency. 
c) Technical test: RMAA (version 3.4) is an exhaustive test for a
soundcard. This suite runs five subtests, namely, Frequency
response, Signal-to-Noise level, Dynamic range, THD + Noise and
Stereo Cross talk. 

Warranty and support: Here we took into account the war-
ranty period for the soundcards, the number of authorised serv-
ice centres appointed by the companies and the number of cities
in which authorised service centres are present. The information
here is as provided by the respective companies. 

Value for money: This provides us with a price-performance
ratio. A card offering good performance at a great price will score
higher than one offering excellent performance with a hefty 
price tag. 

How they fared
We tested all the major soundcards that are available in the mar-
ket today. Products from Creative Labs dominated our test line-
up with five out of the six cards coming from their stables; the
other card was provided by Zoltrix. We also tested two integrat-
ed sound chipsets—these reside on the motherboard and are an
ideal solution for those on a budget. 

Features
The number of output channels supported by a soundcard is an
extremely important feature to keep in mind while making a pur-
chase, as this cannot be upgraded or modified. The price of 2.1
and 4.1 speaker sets has come down drastically and games and
movies are a joy to experience on these multi-speaker sets. The
Creative Vibra 128 was the only soundcard that did not support
more than a 2.1 speaker set, while the remaining supported either
4.1 or 5.1 speakers. Older cards had a built-in amplifier that cre-
ated distortion and caused loss in the purity and clarity of the

sound output (this was a neces-
sary evil as most speaker sets
those days were non-ampli -
fied). All newer soundcards pro-
vide a non-amplified, pure out-
put to the speakers with only
the Vibra 128 still amplifying its
line-out and MIDI jacks. 

For a theatre-like audio
experience, a soundcard should
support Digital Dolby 5.1
decoding. Unfortunately, this
feature is only available in Cre-
ative’s Audigy Platinum, Sound
Blaster Live! DE 5.1 and Extigy
solutions.

Although not an issue for a
majority of users, the nature of
drivers available for those using
niche operating systems such as
Linux and Windows 3.1 can be
a point of concern. Without the
proper drivers, users will get
sound of questionable quality.

Some cards only have FM
synthesizers and these
should be considered a
bad choice to create quali-
ty music. A musician
should buy a soundcard
that features Wavetable
support and optionally
supports the SoundFont
technology (see
www.soundfont.com for
more information). Finally,
if you wish to reduce sig-
nal loss, make sure that
your soundcard has two
things: gold-plated con-
nectors and an S/PDIF
connection port, along
with the requisite cables.

Solutions for
the Musician

Duplex: A full-duplex soundcard can make
and receive sounds at the same time. A full-
duplex soundcard is thus essential if you intend
to use telephony over the Internet. For instance, walkie-
talkies are half-duplex, while telephones are full-duplex.
MIDI Channels: These channels offer a musician greater
control over the instruments connected to the soundcard.
He can set them all to respond to different channels and
therefore have independent control over each one.
Polyphony: Is the maximum number of voices a synthesiser
can play at any one time. A soundcard functions around a
Digital Signal Processor (DSP) that mixes sound samples
from the on-board wavetable to produce the requisite musi-
cal notes. The maximum number of notes available is
dependent on the processing power available in the DSP
and is referred to as the card’s ‘polyphony’.
Recording/Playback Depth and Rate: In order to store
sound in digital form, its waveform is converted into a
series of bits via a process called sampling. A higher sam-
pling rate will give a more accurate digital representation
of the sound. The maximum sampling rate at which a
sound signal can be recorded by a soundcard is called the
recording rate of the card; the higher this value, the better
the recording. Similarly, a higher playback rate will give
better sound quality. The clarity and fidelity of the sound
sample improves with the number of bits used to describe
it. Thus, a 16-bit sample recorded at 24 KHz sampling rate
will have less clarity than a 24-bit sound sample recorded
at a rate of 96 KHz.
Signal-to-Noise Ratio (SNR): SNR is the ratio of the largest
sound signal that can be handled by a card with minimum
distortion, to the noise that is present at that time. It thus
tells us how ‘cleanly’ the card in question produces sound.
Sony/Philips Digital Interface (S/PDIF): It is a standard for
transmitting data in a lossless digital format to preserve
sound quality. Soundcards that feature an S/PDIF connector
are thus a better choice.
Stereo Cross talk: Cross talk is the mixing of the left and
the right-channel sound information. The effect being,
when listening to a set of stereo speakers (or head-
phones), the left ear can hear sounds meant for the right
speaker, and the right ear can hear some of the audio
coming from the left speaker. A well-engineered sound-
card (one with gold-plated connectors and shielded wires,
for instance) will suppress this interference and produce a
more accurate sound.
Total Harmonic Distortion (THD): Non-linear distortion is
a processing error that creates output signals at frequencies
that are not necessarily present in the input. THD is deter-
mined by measuring the size of each of the new frequencies
that are created by the source of the distortion and then
taking their geometric sum. 
Wavetable: A Wavetable stores the digitised samples of
actual recorded instruments, which are then combined dur-
ing music creation and playback. They are commonly used
by professionals to synthesise music.

Jargon Buster
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Creative Audigy Platinum outshone the others in this depart-
ment, providing drivers for all major operating systems.

For those using their PCs as machines to create and mix
music, the number of MIDI channels supported and SoundFont
support are critical features. MIDI channels are nothing but the
number of instruments or vocals that a soundcard can support
through a synthesiser. Out of the lot, only Creative’s Vibra 128
supported a meagre 16-channels, the rest offered an excellent
48-channel solution. Although home users would hardly find
any difference while listening to MP3s or playing games, for a
professional sound artist this could be the most crucial factor.
SoundFonts allows users to create their own sample music and
play them back, create some beats, or even grab some music from
a digital audio file. It also lets you play most of the known musi-
cal instruments available, through your PC. Only the Audigy
Platinum, Extigy and the Sound Blaster Live! DE 5.1 sported this
feature. If you are looking for a card that will let you record your
own audio, keep the following in mind: the more the recording-
depth and bit rate that a soundcard offers, the better the quali-
ty of sound that can be recorded. Creative’s Extigy was the clear
leader here. It offered a high 24-bit depth at a 96 KHz sampling

frequency for both playback and recording, proving to be the
clear choice for the professionals. The Audigy had a playback
depth of 24 bits but the recording was at the normal 16-bit depth.
The other cards lagged behind with 16-bit recording depth and
48 KHz sampling rate. 

Finally, we come to the often-overlooked feature of connec-
tors. Most cards today sport all the necessary connectors like Line
Out, Microphone Out, MIDI and joystick ports, etc. If you are
looking for a normal two-speaker solution, you should not have
any problems with any of the available cards. However, for those
looking at building a home theatre system (with 5.1 speakers),
the connectors become all the more important. An S/PDIF or any
other Digital Out connection is a must here as it provides a pure
digital signal without any interference. It can also act as a pass
through in case the soundcard doesn’t have any Dolby Digital
decoding capability—the speaker’s Dolby decoder
unit will then decode the digital signal. These
connectors were only available in the 
premium soundcards available from Creative:
the Audigy Platinum and the Extigy. The 
others like Zoltrix’s Nightingale Pro 6 did pro -
vide six-channel output, but did not feature an
S/PDIF Out connector. 

A unique feature to note is that Creative Audigy
Platinum has a daughter Audigy drive. The
external drive gives better access to controls
and comes with an SB1394 (FireWire) con-
nector for connecting ultra fast playback
and recording devices. Our opinion is that
instead of FireWire, USB 2.0 support would
have been a better proposition, as there are
more devices supporting this standard. 

The Extigy is aimed at notebook users
and was the only external ‘soundcard’ available. The Sound
Blaster Extigy provides hassle-free installation by easily plugging
into any available USB port on your PC or notebook. But to our
dismay, the Extigy only had support for USB 1.1, which can
become a bottleneck as shown in our CPU utilisation tests below.

Performance
To find out the best amongst the available soundcards, we used
a battery of real world as well as benchmark applications. A 

Centre speaker
and subwoofer

Line In Microphone Front left
and right

Rear left
and right

MIDI/joystick
connector

Games today demand an interactive experi-
ence by definition. When a character speaks in
a game, its voice should pan around the listener
depending on the position of the speaker, or a gunshot
should sound different in a closed room as compared to an
open space. These demands have led soundcard manufactur-
ers and game developers to produce and use what are known
as sound APIs. A game would call on the soundcard and with
the help of the necessary API it would deliver the requisite
effect. If a soundcard supported DirectSound, it was labeled
accordingly and the same logic extends to the other APIs.

DirectSound3D (DS3D) was introduced in DirectX 3.0
and allowed developers to place a sound anywhere in 3D
space. Although DS3D allowed for 3D sound effects, it did
not offer much in the way of simulating a particular environ-
ment. Thus a gunfight in a game would sound much the
same in an auditorium and a cave. This mantle was taken up
by other APIs such as Creative Labs’ Environmental Audio
Extension (EAX) and Aureal’s A3D. EAX took the relatively
easy route and with the help of reverberations and echoes
simulated the properties of a place, rather than the place
itself. Thus under EAX, the echo in a cave would be different
from the sound reverberations in, say, a corridor. A3D went
all out and decided to completely simulate a locale in ques-
tion. This was akin to creating a virtual world in 3D using a
program like 3D Studio Max, but the treatment here was
aural rather that visual.

There are other APIs as well, noteworthy amongst them
being I3DL2. It is a collaborative effort that is aimed at
extending the capabilities of Creative Labs’ EAX open reverb
standard. It defines the space where the listener is located,
takes advantage of the reverberation cues in the current
environment and renders the muffling effects of obstacles
inside environments or partitions between environments. 

Sound APIs Soundcard Connectors Demystified

The Audigy drive packs
a lot of connectors on
the front panel
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subjective analysis was carried out to determine the quality of
sound that a card can deliver under various applications. To ascer-
tain the validity of the technical claims that a manufacturer
makes for its product, we used a very comprehensive evaluation
tool—RightMark Audio Analyzer (RMAA). We also used a game
and a benchmarking suite to evaluate the stress that a card puts
on the overall computer system. Thus, by choosing this mix of
subjective and analytical tests, we were able to obtain a clear pic-
ture of the performance of a soundcard.

Sound quality: To get a handle on the performance of a sound-
card while playing music, we used an audio CD that had a mix
of Hindi and English songs. This mix was chosen for both the
variation in the musical instruments used and the fact that Indi-
an songs tend to be more vocal-heavy than their Western coun-
terparts. Apart from the clarity of each instrument, overall bass
and treble output were given importance while evaluating the
cards. The tracks were played to three different reviewers who
rated each on a scale of 5; the weighted averages of the scores
were then logged.

The scores of all the soundcards ranged between 1.9 and 2.8
(out of a maximum of 5). This was a poor showing on the part
of all the contenders. The Audigy did win, but with a paltry score
of 2.8 out of 5. The other cards barely crossed the mark of 2
points. The Creative Sound Blaster Live! DE 5.1 came in second
with a score of 2.2, but it produced a slight crackling sound and
its bass output was also not up to the mark.

We also accessed the sound quality of a card while playing
games. A quick fragfest under Quake III Arena (map DM9) left our
reviewers with grins on their faces. This game has amazing sound
effects and a very funky music score that consists of some cool
guitar riffs and drum beats. We observed the clarity with which
a card presented these effects. Moreover, the game engine’s use
of Doppler sound effects (for the rocket launcher) also helped us
evaluate the effectiveness of a cards’ multi-channel support.
Amongst the cards, the Zoltrix Nightingale PRO 6 impressed us
the most with a score of 4 out of the maximum of 5. With 5.1
speaker support, the Nightingale brought every fight to life, even
as it offered a thumping bass and an amazingly clear treble. The
Creative Sound Blaster Live! DE 5.1 came in a close second with
3.8 points, whereas the Creative Vibra 128 lagged behind the rest
of the pack with a below-average score of 3 points.

CPU utilisation:A soundcard takes up precious processor resources
while doing its job. This has repercussions in the multi-tasking
environment that current operating systems deliver, as task-switch-
ing can become a painful experience. Needless to say, a low num-
ber in this test indicates a good performance by the soundcard.
We used 3D Audio Winbench, an application that gives the total
CPU usage by a soundcard.  The results were quite interesting, with
the Creative Audigy Platinum topping this test with an excellent
score of 1.59 per cent utilisation. Surprisingly, the Sound Blaster
Live! Value failed this test, despite updating its drivers. The exter-
nal Sound Blaster Extigy was plagued by the limitations of its USB
connection and posted the second worst score of 6.81 per cent. The
worst score however, belonged to the Zoltrix Nightingale PRO 6
(7.71 per cent). A thing to keep in mind while digesting all this is
that current processors are speed demons. If the card consumes 7
per cent of resources out of a total available speed of say, 1 GHz,
you won’t notice any difference in speed.

This became all the more apparent in our game tests using
Quake III Arena. We recorded the fps under both Normal and
High Quality sound mode. By doing this, we hoped to bring to
light the overhead that high-quality sound puts on a system.
We were expecting notable differences in the score under the
two modes—the fps should have been lesser while running the
game with high quality sound enabled. The results belied our
expectations—the scores under both the modes and across all
the cards (except for the Creative Sound Blaster Extigy) did not
vary by much. The performance of the Extigy solution can
again be blamed on its USB 1.1 connection. So, if you have 
a high-end processor in your system, you can be rest assured

Integrated sound chips have evolved to a level where they can closely
compete with the best soundcards in the market and offer an ideal
solution for the cash-strapped consumer  



Features
General Specifications
Chipset Used
Speaker support
In-built Amplifier
API Support

Dolby Digital 5.1 decoding
Operating System

MIDI Synthesizer
Synthesis type (Wavetable / FM Synthesis)
Wavetable Memory

Sample Sets (MB)
Polyphony (Hardware, Software voices)
Midi Channels 
SoundFont Support

Digital Audio Features
Duplex Type 
Maximum Recording Depth & Rate
Max. Playback Depth & Rate
Signal-to-Noise Ratio (dB)
Connectors
Microphone In
Line In
Line Out (Front channel)
Line Out (Rear channel)
Center / Sub Woofer Out
S/PDIF Out (6 channel output)
MIDI / Joystick Port
CD In
Telephone Answering Device (TAD) In
Auxiliary In
Help & Documentation
Listing of specifications
Quick setup guide
Troubleshooting
Contact information for after sales support
Performance
Sound Quality
Sound Tracks (Scale of 5)
Quake III Arena Map DM9 (Scale of 5)
CPU Utilisation
Quake III Arena Map DM9 at Normal /
High Quality Sound (fps)
3D Audio Winbench (%)
Technical Test (RMAA 3.4)
Frequency Response (dB)*
Signal-to-Noise level (dB)**
Dynamic Range (dB)**
Total Harmonic Distortion + Noise (%)***
Stereo Cross Talk (dB)**
Warranty & Support
Number of authorised service centres
Number of cities where service centres are
present
Period of warranty (Years)
Overall Score
Features (30%)
Performance  (40%)
Warranty & Support (10%)
Value for Money (20%)
Overall Product Rating
Overall Grade
Vendor name

E-mail

Price (In Rupees)

Creative Audigy
Platinum

Audigy
5.1
✖
DirectSound, DS3D,
EAX 1.0, EAX
Advanced HD, EAX
2.0, I3DL2 and A3D
1.0
✔

Windows
3.x/95/98/NT/2K/XP,
MS-DOS, 
Linux

Wavetable
Based on System
RAM (up to 1 GB)
4, 8
64, 512
48
✔ (including
SoundFont 2.1)

Full
16 bit @ 48 KHz
24 bit @ 96 KHz
100

✔

✔

✔

✔

✔
✔

✔

✔

✔

✔

✔
✔

✖

✖

2.8
3.3

47.3 / 48.3

1.59

-1.66, +2.37
-80.8
78.5
0.0042
-79.1

18
18

1

28.00
33.21
6.00
2.75
69.96

Compuage Infocom
Ltd
info@
compuageindia.com
13,915

Creative Sound
Blaster Live! Value

EMU10K1 
4.1
✖
DirectSound, DS3D,
EAX 1.0, EAX
Advanced HD, EAX
2.0

✖

Windows
3.x/9x/NT/2K/XP,
MS-DOS

Wavetable
Based on System
RAM (up to 32 MB)
2, 4, 8
64, 512
48
✖

Full
16 bit @ 48 KHz
16 bit @ 48 KHz
96

✔

✔

✔

✔

✖
✖

✔

✔

✔

✖

✖
✖

✖

✖

2.0
3.3

46.8 / 47.7

Failed

-0.58, +3.67
-85.1
81.8
0.0057
-83.0

18
18

1

17.50
24.70
6.00
11.47
59.67

Compuage Infocom
Ltd
info@
compuageindia.com
2,300

Creative Sound
Blaster Extigy

Extigy
5.1
✖
DirectSound, DS3D,
EAX 1.0, EAX
Advanced HD, EAX
2.0, I3DL2 and A3D
1.0
✔

Windows
3.x/9x/NT/2K/XP,
MS-DOS

Wavetable
Based on System RAM
(up to 1 GB)
2, 4, 8
64, 512
48
✔

Full
24 bit @ 96 KHz
24 bit @ 96 KHz
100

✔

✔

✔

✔

✔
✔

✔

✔

✔

✔

✖
✖

✖

✖

2.2
3.7

47.4 / 43.6

6.81

-0.92, +0.66
-104.3
92.5
0.0047
-104.0

18
18

1

28.50
25.16
6.00
2.78
62.44

Compuage Infocom
Ltd
info@
compuageindia.com
12,075

Creative Sound
Blaster Live! DE 5.1

EMU10K1 
5.1
✖
DirectSound, DS3D,
EAX 1.0, EAX
Advanced HD, EAX
2.0, I3DL2 and A3D
1.0
✔

Windows
3.x/9x/NT/2K/XP,
MS-DOS

Wavetable
Based on System
RAM (up to 32 MB)
2, 4, 8
64, 512
48
✔

Full
16 bit @ 48 KHz
16 bit @ 48 KHz
96

✔

✔

✔

✔

✔
✖

✔

✔

✔

✖

✖
✖

✖

✖

2.2
3.8

48.3 / 47.1

5.11

-4.81, +21.56
-79.9
76.9
0.0086
-85.7

18
18

1

22.50
27.04
6.00
11.86
67.40

Compuage Infocom
Ltd
info@
compuageindia.com
2,610

Creative Vibra 128

ES1371
2
✔ (only for Line Out)
DirectSound, DS3D

✖

Windows
9x/NT/2K/XP, 
MS-DOS

Wavetable
Based on System RAM 

2, 4, 8
128, NA
16
✖

Full
16 bit @ 48 KHz
16 bit @ 48 KHz
90

✔

✔

✔

✖

✖
✖

✔

✔

✔

✔

✖
✖

✖

✖

2.0
3.0

28.4 / 28.4

5.33

-0.66, +1.79
-60.7
58.3
32.0379
-34.8 

18
18

1

11.00
23.41
6.00
22.26
62.67

Compuage Infocom
Ltd
info@
compuageindia.com
966

Disclaimer: * Lower the difference, the better ** H igher the better *** Lower the better ✝ Integrated audio
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that the overhead caused by the soundcard would not affect
your work.

Technical test (RMAA): RightMark Audio Analyzer was used to
test the core circuitry of the soundcard and to determine its per-
formance. It is a loop-back test, wherein sound generated by the
card is sent through the Line Out jack and is then reverted back
to the card from the Microphone In or Line In port. This process
effectively removes bottlenecks such as a slow processor or the
presence of older peripherals. RMAA thus tests the raw soundcard
performance. We tested the soundcards for five varied set of
parameters:
a) Frequency response: This checks whether the soundcard dis-
torts the relative loudness of different frequencies in a sound
signal. Errors in frequency response are generally thought to be
the most audible form of lin -
ear distortion. The Extigy
almost touched perfection,
generating a minimal differ -
ence of 1.58 dB. It was closely
followed by the Creative Vibra
128 with a difference of 2.45
dB. The Creative Sound Blaster
Live! DE 5.1 was surprisingly
at the bottom with a frequen-
cy response of 26.37 dB (range
of –4.81, +21.56), indicating
that on the higher pitch the
soundcard produces a lot of
distortion.
b) Signal-to-Noise level: This
test estimates the noise level
that can be heard when noth-
ing is playing and the volume
level on the speakers is turned up high. It also helps to locate
interference caused by electronic circuits, CRT displays and other
such devices. The results here are in the negative and a higher
number means better performance under this test. The Creative
Sound Blaster Extigy was at the top of the pool. With an excel-
lent attenuation of –104.3 dB, this card hardly produces any
noise. The Vibra 128 and Zoltrix Nightingale PRO 6 generated
really poor scores of –60.7 dB and –67.2 dB respectively, which
indicated that a lot of disturbance and humming were produced
by these soundcards. The rest performed adequately with an aver-
age attenuation of –80 dB.
c) Dynamic range: The dynamic range of a card determines
the range of frequencies within which it can produce clean
sound. This test also estimates the noise level in the presence
of a weak audio signal and sheds light on the limit of 
the sound device while operating at low signal levels—
an important aspect for high-quality sound recording and
playback. 

The results were quite as expected with the Vibra 128
remaining at the bottom of the ladder with a score of 58.3 dB
while the Extigy scored 92.5 dB! The Extigy is therefore an
excellent solution for professional quality audio recording 
and playback.
d) Total Harmonic Distortion (THD) and Noise: This test esti-
mates the amount of harmonic distortion that occurs when an
audio signal with large amplitude passes the testing chain. THD
is determined by measuring the size of each of the new 

Zoltrix
Nightingale PRO 6

CMI8738-6CH 
5.1
✖
DirectSound, DS3D,
EAX 1.0, EAX
Advanced HD, EAX
2.0,  and A3D 1.0

✖

Windows
9x/NT/2K/XP

Wavetable
Based on System
RAM
2, 4, 8
128, NA
48
✖

Full
16 bit @ 48 KHz
16 bit @ 48 KHz
85

✔

✔

✔

✔

✔
✖

✔

✔

✔

✔

✖
✔

✖

✖

2.2
4.0

48.1 / 48.8 

7.71

-5.81, +0.09
-67.2
67.9
6.997
-68.1

8
2

1

20.50
26.77
4.00
14.77
66.04

Kunhar Peripherals 
Pvt ltd
salesbom@
kunhar.com
2,000

Intel 845GBV  ✝

AD1981A
2
✖
DirectSound, DS3D, EAX
1.0, EAX 2.0, I3DL2 

✖

Windows 3.x/9x/NT/2K/XP

Wavetable
Based on System RAM 

NA
NA
16
✖

Full
16 bit @ 48 KHz
16 bit @ 48 KHz
90

✔

✔

✔

✖

✖
✖

✖

✖

✖

✖

✖
✖

✔

✖

2.0
1.7

47.4 / 48.8

1.00

-0.03, +0.11
-85.8
83.8
0.0122
-79.2

8
10

1

10.00
23.05
5.00
20.00
58.05

Nebula Technologies

pankaj@
nebulatech.com
8,120 (for motherboard)

MSI 845 MAX2 BLR ✝

AL650
5.1
✖
DirectSound, DS3D, EAX
1.0, EAX Advanced HD,
EAX 2.0

✖

Windows 3.x/9x/NT/2K/XP

Wavetable
Based on System RAM 

NA
NA
48
✔

Full
16 bit @ 48 KHz
16 bit @ 48 KHz
100

✔

✔

✔

✔

✔
✔

✖

✖

✖

✖

✖
✔

✔

✔

1.8
2.8

32.9 / 32.9

2.53

-0.42, +0.24
-80.8
78.5
0.0022
-79.2

15
10

1

22.00
22.77
6.00
20.00
70.77

Priya Limited

salesbom@priyagroup.com

10,600 (for motherboard)

Older ISA cards had an on
board amplifier and did
not require an amplified
speaker set. Due to the dis-
tortion in sound that this
practise caused, newer
soundcards do not come
with amplifiers. So, if your
new soundcard does not
play anything on your old
speakers, you might have a
non-amplified set that will
need to be replaced.

Amplified 
Soundcards
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frequencies that are created by the source of
the distortion. The battle was closely
fought—the Audigy Platinum, the Sound
Blaster Live! Value, the Extigy and the Live!
DE 5.1, each scored within 0.0044 per cent
of each other. The Vibra 128 generated a
dissapointing score of 32.0379 per cent.
e) Stereo Cross talk: The last of our tests
estimates signal leakages from one channel
to another. If a sound device has a poor
score here, you might not be able to get
good stereo sound. Once again, the Extigy
stood tall in front of its competitors with a
score of –104 dB, while the Vibra fared the
worst with –34.8 dB.

Warranty and support
Soundcards hardly experience problems that require servicing;
the only major concern is getting the right drivers for the oper-
ating system used. But given the price of some of the cards
available, extended warranty life is a reassuring benefit. Most
of the vendors provide a flat one-year warranty, which we think
is a bit less. Consider the case of the Audigy Platinum and the
Creative Extigy. With their prices being on the higher side, the
number of years for which the product is warranted against
manufacturing defects gets more critical than having a greater
number of service centres. Service centres, however, have a pret-
ty decent coverage: the Creative series of soundcards being dis -
tributed by Compuage Infocom has 18 service centres in 18
cities. The Zoltrix Nightingale PRO 6 has only eight service cen-
tres across two cities—a stumbling block for potential buyers.
We feel that users will be served better if vendors extend the
warranty period of these products.

What it all leads to
Soundcards have come of age. The quality of sound offered by
the majority of these cards is good enough to satiate the casu-
al listener, while the high-end products are guaranteed to
impress even the most discerning audiophile. The Zoltrix
Nightingale PRO 6 fought hard against the Extigy, scoring a
26.77 in the performnace test, compared to Extigy’s 25.16
points. However, the Creative cards walked away with all 
the accolades.

The Best Performance Award goes to the Creative Audigy
Platinum, which edged out its nearest rival, the Creative
Sound Blaster Live! DE 5.1. This card provides good quality
thanks to the 24-bit sound play-
back depth and its support
for 5.1-channel sound.
Moreover, it put the least
amount of stress on the sys -
tem (only 1.59 per cent CPU
utilisation) and produced
good noise and cross talk
attenuation scores. A bunch
of accessories including an
external Audigy drive that
has FireWire support along
with an entire gamut of
connectors for pure digital sound. It also comes bundled with
good sound and video editing tools like FruityLoops 3, Ulead
VideoStudio and Acid Style 2.0—an excellent solution for an

audiophile as well as a professional
musician. But its price is a bit

steep at Rs 13,915.
The Best Value

Award went to yet
another product from

the Creative stable. The Cre-
ative Vibra 128 , at Rs 966,

came across as an ideal solution for
those on a shoestring budget. It has an
in-built amplifier for the Line Out 

port, which might be a boon to those 
with non-amplified speakers. The sound
quality was alos quite acceptable; it scored

2.03 and 3 points under the sound track and the gaming 
test, respectively.

ASHU MEHROTRA and AHMED SHAIKH

You want

Look for

Your options

Price range 

A basic, no-frills sound-
card

A full-duplex card or a
motherboard with an
on-board sound chip
that provides simple
stereo or 2.1 channel
output 
AD1981A-based moth-
erboard or Creative
Vibra 128
Up to Rs 1,000 (for
external soundcard)

Surround sound at an
affordable price

A card with 4.1 or 5.1
channel support. In-built
Dolby Digital decoding
will be an added bonus

Creative Sound Blaster
Live! DE 5.1 or Zoltrix
Nightingale PRO 6
Rs 2,000 to Rs 2,700

Excellent sound quali-
ty for professional
level editing
A card that supports
24-bit recording at 96
KHz along with con-
nectors like S/PDIF,
DIN or FireWire 

Creative Audigy Plat-
inum or Creative
Sound Blaster Extigy
Above Rs 10,000

Decision Maker

Creative Audigy Plat-
inum, a real treat with
excellent sound clarity

The Creative Vibra
128 is a good bar-
gain for the nondis-
cerning user

■ Define your usage. If you are an avid music
lover, go for a soundcard that supports multiple
channels. If you want a gaming solution, buy a
card that supports the standard 3D APIs, viz., DirectSound,
EAX, A3D and I3DL2.
■ The vendor should provide a minimum one-year warranty
for budget soundcards (under Rs 2,000) and at least a three-
year warranty for costlier variants.
■ Before buying, make sure that the soundcard’s interface is
PCI or USB and not ISA. If you plan to use your soundcard for
playing games or watching DVD movies, get a PCI sound-
card. 
■ See to it that the soundcard you are buying has drivers for
your favourite operating system. Users of Microsoft Windows
should not face problems, but the requisite drivers for the
Linux OS for example, might be hard to come by.
■ If you are an audiophile and appreciate minimum signal
loss, buy a soundcard that uses gold-plated connectors.
■ Check to see if the soundcard comes bundled with a decent
variety of applications (such as games and media players). If
you are a first time buyer, these will prove to be very essential
to get the most out of your purchase.

Buying Tips 
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S
ony’s Walkman introduced us to the world of
portable music. This music device could play cas -
settes, had a good battery life and came in a com-
pact, convenient size. Now many decades later
and various technologies past, we stand witness
to another revolution with the advent of portable

digital music players. And thanks to compressed audio for-
mats like MP3, you can now carry your entire CD or tape
collection and enjoy your favourite music anywhere you go.
Plus, the absence of moving parts in solid-state MP3 players
enables them to handle a lot of shocks and bumps, making
them an ideal companion while travelling or jogging.

Whether you are looking for an MP3 player that will offer
you long playtime or one which is compact enough to fit in
your shirt pocket, the great news is that there is something
for everyone. We test six products that aim to please our ears,
with the intention of finding out the best of the bunch.

Digit Test Process
The test bed used to evaluate the portable players consisted
of Windows 98 running on a Pentium III 700 MHz proces -
sor with 128 MB of SDRAM and an 8.5 GB 5,400-rpm hard
drive. Test MP3 files were burned on a CD to test the CD-
based MP3 players, while with solid state MP3 players, these
files were uploaded into their Flash memory.

Test Methodology
We evaluated the MP3 players on features (40 per cent weigh-
tage), ease of use (10 per cent weightage), performance (20
per cent weightage), warranty and support (10 per cent
weightage) and value for money (20 per cent weightage).

Features: Features like different music formats supported,
presence of an FM tuner, the ability to upgrade the firmware,
bundling of rechargeable batteries, etc were rated. These are
the features you should be looking out for while buying a
player. We also evaluated the ease with which a player lets
you enjoy your music. To do this, we noted down the most
important playback features, like the ability to create cus-
tomised playlists, along with the facility to repeat and shuf-
fle MP3 tracks.

Ease of use: Here we observed the ergonomics and the button
placements of each MP3 player. Since these players are going
to be used more outdoors than indoors, their weight, dimen-
sion and the presence of a backlit display were also noted.

Performance: We used a variety of music files (five in all) to
evaluate the performance of the MP3 players and the 

earphones that were bundled with them. The bass and treble
test was carried to check out how purely the MP3 player pro -
duces these frequencies and whether there were any distortions.
The English songs had a variety of instruments being played at
the same time and they gave us an indication of the frequency
response of the player. The Hindi songs, with their emphasis on
vocals, gave us an indication of the clarity and the fidelity of
the sounds produced.

Warranty and support: Here we took into account the war-
ranty period for the MP3 players, the number of authorised

The birth of compressed digital audio and the arrival of portable MP3 devices 
will have you humming, wherever you go

The MP3 compression algorithm has changed
the way we listen to music and the popularity
of portable players that support the standard has
never been greater. Fraunhoffer developed the algo-
rithm back in 1989. It was meant as a solution to cut
down on the size of the very large WAV files that littered
the music scene. Not only did it successfully deliver on
that front, but the near CD-quality audio it offered,
allowed it to capture the hearts and ears of music lovers
everywhere. There are other solutions available which
run neck-and-neck with the MP3 format, offering a simi-
lar solution—WMA, Ogg Vorbis, AC3, TwinVQ, RealAu-
dio and AAC, to name a few. There are some players
that support the AAC format, but its acceptance is not
as wide as MP3.

Ogg Vorbis is the challenger from the open source
world and delivers a comparable audio quality at zero
cost. Thus, if you wish to upload your music to the Inter-
net, you can use this compression solution to do so—
royalty-free. The only problem is that it is not widely
supported by MP3 players in the market. RCA Lyra was
the only MP3 hardware player that supported the
RealAudio format in the past but abandoned it for the
more popular MP3 and WMA formats. The gaining pop-
ularity of the Windows Media Audio (WMA) format is
two-fold: it offers audio quality that is comparable to an
MP3 file and at a much smaller file size. It is also being
aggressively marketed by Microsoft as an ideal solution
to Digital Rights Management—a move that has attract-
ed the support of a lot of music companies. As things
stand, MP3 and WMA are the only formats supported by
most of the portable MP3 players in the market.

Compressed Audio Formats
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service centres appointed by their companies and the number
of cities in which the centres are present. 

Value for money: This provides us with a price-performance
ratio—a player offering good performance at a reasonable price
will score higher in this category than one offering excellent
performance with a hefty price tag. 

How They Fared 
We tested six MP3 players from vendors such as Creative Labs
and D-Link Corp. We based our evaluation on criteria ranging
from the features that a portable player supports (like the abil -
ity to play both MP3 and WMA files), to its performance (audio
quality and battery life). 

Features
Being a portable device, the playtime that an MP3 player offers
becomes crucial—a longer battery life will keep the device
going and will ease the burden on your wallet as you won’t
have to repeatedly buy batteries. Of course, if the player comes
with a set of rechargeable batteries like the NAPA DAV316,
there is nothing like it. Finally, as a general rule, solid-state
devices consume less power than CD-based solutions on
account of the absence of any moving parts. 

The second most important trait is the space offered to
store the music files. CD-based players rule the roost in this
regard, since a CD can store up to 700 MB of compressed files.
If you are looking for a CD-driven solution, make sure that it
has electronic shock protection. The models that we tested, for
example, all sported a 120 second buffer, which allowed them
to play songs without skipping, while travelling. 

In the case of a solid-state player, the question of future

upgrades comes into play—the D-Link DMP-100, for example
offers a SmartMedia external module and the Creative PA-20
can be upgraded form its internal 32 MB memory to a maxi -
mum of 96 MB. Ensure that the MP3 player supports at least
one of the standard audio formats, viz. MP3 and WMA, or
preferably both like the Creative PA-20. As a rule, a CD-based
player will play both MP3 and audio CDs. 

Most of the solid state devices use a USB port to transfer
songs to and from the computer, the D-Link DMP-100 being
the only exception. A USB port is, of course, not essential for
the CD-based devices, but the extra cost of a CD-Writer that
will be needed to create those MP3 CDs should be considered. 

A cool thing to have in a portable device is a manual equal-
izer. Alas, none of the products we tested had them, though
some did come with preset-equalizer modes that let you choose
between settings such as Pop, Jazz, Rock, etc—the D-Link play-
er being one such solution. 

An MP3 player would not be half as useful if it did not allow
you to customise your favourite tracks. A good player should
support creation of customised playlists, editing of playlists
and should feature a track browser, to let you choose and select
a song from within a list. Moreover, an ability to randomise a
list of songs or to get a 10-second preview of all the songs with-
in a list is considered a bonus. The Creative DAP-CD0001 sup-
ports all these essentials, whereas the M-ANY DAH2005 does
not feature even one.

Ease of use and ergonomics
Ergonomics plays an equally important role in the buying deci-
sion, as do features. Portability, placement of buttons and ease
of navigation are important pieces that fall in to create the per-
fect MP3 player. Thus, while evaluating the contenders, we first
looked at whether the buttons were well within reach or were
put in places that are hard to get at. The Creative DAP-CD0001
and the NAPA DAV316 had the buttons placed in a most logi-
cal way, most of them occupying the front panel. We also deter-
mined the ease with which a player lets you navigate its menu
structure. The Creative DAP-CD0001 again scored high points

Nothing can upstage the pleasure of listening
to your favourite tunes while you are stuck in
bumper-to-bumper traffic. 

If your car deck has a Line In port, connecting an MP3
player to your car deck is just a matter of getting a 3.5
mm stereo cable and plugging it in. Connect the red and
white RCA connectors to the car deck and the single pin
connector to your MP3 player’s Line Out or earphone
jack. If the audio system in your car does not have a Line
In function, you can buy a car MP3 adapter from the

market. This adapter looks exactly like a cassette
with the connection port on one end

where the stereo cable is con-
nected, while the other
end goes in the earphone

jack on the MP3 player.
The trade off here is that

the sound quality will not be
so good because of the mag-

netic coupling between the
adapter head and car audio system’s head. The magnetic
interference will produce noise and hence a loss in sound
quality, but hey, it still beats cassettes!

Music on the Go
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and had the most easy-to-understand menu navigation with
all the important features placed within two clicks. As far 
as portability goes, the Creative PA-20 and the D-Link 
DMP-100 are unbeatable because of their diminutive size and
light weight.

Performance
Although features are important while buying an MP3 player,
its performance under different conditions is equally critical.
The audio quality it offers, as determined by the frequency
response (ranging from bass to treble) and the purity of output
are some of the things that we tested to evaluate the 
contenders.

Audio quality: Each MP3 player was tested using five different
audio tracks. These tracks presented a picture of whether the
player is perfectly balanced in the low, mid and high tones and
whether the bundled earphones cause signal losses in any of
these areas. The Philips eXp401 and the Creative PA-20 both
came up with top scores. The Philips unit gave the best result
in the bass test (it scored 4 points) with no distortion and the

1//2 page ver AD

Creative DAP CD0001

The Creative DAP CD0001 is a CD-based MP3 player. To
enjoy music on this unit, you will need to copy your
MP3 audio collection to a CD. The fact that this unit can

also play normal audio CDs is an attractive bonus. The unit is
reasonably compact, easy on the eyes with its good colour

contrast, and has a matte-finished
front-panel with chrome-plat-

ed buttons. Rubber feet on
the base prevent the

player from slipping
off tables while a good
build quality ensures
that the unit can take
a couple of nasty falls.

All in all, it is a chic unit
to sport around. It also has

a Line Out port that lets you
connect the player to your home

audio system. The bundled DC-adapter lets you run the unit
even when it is out of battery. The DAP has a comfortably
large LCD display and built-in support for ID3 tags, enabling
you to identify the name of the song that is playing. As a CD-
based unit, this player needs some sort of anti-shock protec-
tion, to prevent songs from skipping. It has a 120 second anti-
skip buffer that does just that. The DAP also comes with a use-
ful remote control unit, and has a sufficiently long cable for
both the remote and the
earphones that are bun-
dled along with it. Great
features combined with an
excellent showing in our
test runs and an affordable
price of Rs 8,625 made this
the clear overall winner in
our line-up.

Creative DAP CD0001
Features
Ease of use
Performance
Warranty & support
Value for money
OVERALL

A-A-
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same performance was extended to the treble test, with 5
points. It also presented the English and Hindi tracks with
equally good fidelity. The PA-20 did not reproduce the bass track
with a quality equal to that of the Philips player (it scored 3
points); it did however perform significantly better with the
music tracks, reproducing both vocals and instruments with
equal fervour. The D-Link DMP-100 lagged behind the others in
terms of sound quality. This was mainly because of the quality
of the accompanying earphones. Surprisingly, the sound qual-
ity was decent while playing the vocal-heavy Hindi songs. This
was mainly because earphones can’t deliver high pitch sounds
but perform well while playing songs with lots of mids and
vocals. NAPA DAV316 and Creative DAP-CD0001 were two
players that gave consistently average quality sound across the
entire test.

Battery life: To test the battery life, each player was run con-
tinuously at full volume, while we noted down the time taken
to drain the batteries completely. The Creative PA-20 took the
crown by logging more than 420 minutes of playtime on one
set of batteries. Even if you used this unit for 2 hours daily, a
single pair of batteries will last for at least five days. The PA-20

was followed by the D-Link DMP-100 with 270 minutes of 
battery life. The Philips eXp401 logged the lowest score
amongst the bunch  with all its battery power consumed in 
73 minutes flat!

Shock absorption test: Being a portable music system, MP3
players will be used, by definition, while travelling or during
those long early-morning jogs and walks. This requires a play -
er that will not skip music and is compact. To test the ability of
the CD-based players to output music without skipping, we
impact-tested them. A thing to keep in mind is that this test was
not meant for the solid-state devices, since they have no mov-
ing parts to cause the skipping. An impact force was applied to
the player (by either shaking it or tapping it) to ascertain if
there was any skipping in the tracks being played. Thanks to a
healthy use of buffers, all the players passed this test with fly -
ing colours, and none of the CD-based MP3 units skipped even
a millisecond worth of music.

Warranty and support
Warranty and support are important issues with portable
devices, since they are likely to be roughed up during daily

NAPA DAV316

Elegantly designed with a sweet colour combi -
nation, the NAPA DAV316 immediately cap-
tured our hearts. A CD-based MP3 solu-

tion, this unit performed very well in our
sound quality tests delivering both
good bass and excellent treble. It had
large, easy-to-use buttons on the front
panel and an elegant LCD display for
ID3 information and navigation. The ID3
tag support displays the song being played,
the name of the artiste and the album from
which the number is taken. Its 120-second anti-
shock protection puts it in the same league as the Creative
DAP CD0001—this feature lets you enjoy your favourite

tracks on the move, without worrying about skipping a beat.
The unit supports MP3 audio on a CD, CD-R or a CD-RW
medium, along with normal Audio CDs. It’s bundled with

NiMH rechargeable batteries—a great feature for the
price conscious. The Line Out port the NAPA sports

allows you to connect it to an external music sys-
tem. It also comes with a DC adapter port that lets
you run the
unit off an elec-
tric outlet to

save up on the
batteries. With a

price tag of Rs 5,650, the
NAPA DAV316 managed to
bag out Best Value award. 

■ If you desire a portable and compact device, then make sure
that the MP3 player you are buying is a solid state device. 
■ If maximum storage is your priority, a CD-based MP3 device
would be an ideal solution.
■ See that the player supports both MP3 and WMA 
formats.
■ Ascertain that your player has an upgradeable firmware as this
will future-proof your purchase: in case the MP3 audio format
goes in for a revision, you will be able to upgrade your firmware
via software to support the new format.
■ The player should have a big enough LCD screen that is 
backlit, so that reading the information even in dark areas
becomes easy. 
■ The button placement should allow you to operate the player
while it is buckled to a belt or is inside your pocket. 

■ A rechargeable battery is a must if you intend to
use the device frequently.
■ A case that would allow for easy carrying is also very important.
It will prevent scratches on the LCD screen and will minimise
impact damage that might prove fatal to this delicate device.
■ A good pair of earphones will complete the MP3 player, allow-
ing it to accurately reproduce your favourite songs. 
■ Make sure that the MP3 player has a warranty for at least 
one year.
■ A Line Out port is a definite advantage, as you can plug the
MP3 player to a home or car music system.
■ An upgradeable storage capacity is another great feature to
look out for in an MP3 player.
■ If you are buying a CD-based MP3 player, ensure that it has an
electronic shock protection of at least 100 seconds.

What to Look for while Buying an MP3 Player

NAPA DAV316
Features
Ease of use
Performance
Warranty & support
Value for money
OVERALL

A-A-

➜



Features

Type of Player (Solid-state, CD)
Memory

Inbuilt

Storage Capacity (MB)
External Memory Interface

Battery type/No. of Batteries

Rechargeable Batteries
Inbuilt Display
Remote Control

PC Interface
Audio Formats Supported
Firmware Upgradeable

Voice Recording
AM/FM Tuner
ID3 Tag Support

Electronic Shock Protection (secs)
Line In/Line Out
Power Saving Mode

Manual Equalizers
Preset Equalizer Modes

Playback Features
Custom Playlists
Track Repeat

Track Browser
Shuffle Tracks
Intro Mode

Bundled software

Ergonomy & Ease of Use
Dimensions (L x B x H, in mm)

Weight (gms)
Intuitive Button Placement (Scale of 5)
Interface/Menu Navigation (Scale of 5)

Earphone Comfort Factor (Scale of 5)

Portability (Scale of 5)

Backlit Display
Performance
Audio Quality (Scale of 5)

Heavy Treble Track
Heavy Bass Track
English Track 

Hindi Track #1 
Hindi Track #2 

Battery Life (mins)

Shock Protection Test
Warranty & Support
Number of Authorised Service Centres

Number of Cities with Service Centres
Warranty Period (years)
Overall Score

Features (40%)
Ease of Use (10%)
Performance (20%)

Warranty & Support (10%)
Value for Money (20%)
Overall Product Rating

Overall Grade
Vendor Name
Phone

E-Mail

Price (In Rupees)

Creative PA-20

Solid-state

✔

32
MultiMediaCard
AAA, 2

✖ 

✖ 

✖ 

USB
MP3
✖ 

✖ 

✖ 

✖ 

NA
✖/✖ 

✖ 

✖ 

Treble, Normal, Bass

✖ 

✔

✔

✔

✖ 

MP-Manager
Application, Drivers

75 x 52 x 15 

42
2
0

2

5

✖ 

4
3
5

5
4
420

Pass

18

18
1*

14
6.2
18.4

7
13.66
59.26

Compuage Infocom
022-8305500

info@
compuageindia.com
6,325

Creative DAP-
CD0001

CD

NA

700
CD, CD-R, CD-RW
AA, 2

✖ 

LCD
✔

NA
MP3, Audio CD
✖ 

✖ 

✖ 

✔

120
✖/✔
✔

✖ 

✖ 

✔

✔

✔

✔

✔

NA

141.5 x 130 x 28.5

205
4
4

4

3

✖ 

4
4
4

4
4
242

Pass

18

18
1*

24
4.4
15

7
12.05
62.45

Compuage Infocom
022-8305500

info@
compuageindia.com
8,625

D-Link DMP-100

Solid-state

✔

32
SmartMedia
AAA, 2

✖

LCD
✖

Parallel
MP3, WMA
✖

✔

✖

✔

NA
✖/✖
✔

✖

Pop, Classic, Jazz, Ex-
bass, Flat

✖

✔

✔

✔

✖

D-Link MP3 Manager,
Musicmatch Jukebox
4, AudioCatalyst,

Drivers

85 x 63 x 17.5 

62
3
3

2

5

✖

3
3
4

2
5
270

Pass

16

16
1*

23
6.2
13.8

7
9.81
59.81

D-Link India
022-6526696

sales@dlink.co.in

10,000

M-ANY DAH200S 

Solid-state

✔

64
MultiMediaCard
Proprietary, NiMH

✔

LCD
✖

USB
MP3, WMA
✔

✖

✖

✖

NA
✖/✖
✖

✖

Jazz, Pop, Classical,
Normal

✖

✖

✖

✖

✖

M-ANY Loader 3.0,
Real Jukebox, Audible
Manager, Drivers

63 x 102 x 11.5

50
2
0

2

5

✖

3
3
4

4
3
Failed **

Pass

None

None
None

18
5.2
12.8

0
10.72
46.72

Moon Computers
022-2653390

sales@moonindia.com

7,910

NAPA DAV316

CD

NA

700
CD, CD-R, CD-RW
AA, NiMH

✔

LCD
✖

NA
MP3, Audio CD
✖

✖

✖

✔

120
✖/✔
✖

✖

Classic, Pop, Jazz,
Rock, Normal

✖

✔

✔

✔

✖

NA

150 x 148 x 32 

300
4
3

NA (earphones not
bundled)
2

✖

4
4
4

4
4
189

Pass

None

None
None

25
4.4
14

0
17.93
61.33

Moon Computers
022-2653390

sales@moonindia.com

5,650

Philips eXp401

CD

NA

180 (8 cm)
CD, CD-R, CD-RW (8 cm)
AAA, 2

✖

LCD
✖

NA
MP3, Audio CD
✖

✖

✖

✖

120
✖/✔
✔

✖

✖

✔

✔

✔

✔

✖

NA

175 x 130 x 60

200
3
2

2

4

✖

5
4
4

4
4
73

Pass

174

196
1*

18
3.6
13.4

9
5.76
49.76

Philips India
022-6912000

gautam.dalal@
philips.com
14,990

Disclaimers: * Carry-in Warranty ** Even after repeated attempts, the battery could not be charged
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usage. Philips is the only brand to have a staggering 174 serv-
ice centres across 196 cities in India. The Creative DAP-
CD0001 came in at a distant second with 18 service centres
spread across 18 cities. Except for the M-ANY DAH200S and
NAPA DAV316, all the players came with a one-year carry-in 
warranty.

The Last Note
The arrival of compression algorithms like MP3 and WMA 
has heralded a new era in portable music. MP3 players now
offer a range and quality so diverse that there is something
for every one who likes to jive to the odd beat or two. We have
compact, solid-state portables for the travellers, while 
CD-based players offer an amazing amount of storage space,
making carrying your entire music collection within just 
one single device a distinct possibility. And our tests show 
that the quality of audio offered by most of these MP3 play-
ers is good enough to satisfy even the most discriminating
audiophile. 

The Creative PA-20 that was priced at Rs 6,325, won our
Best Performance Award, scoring an impressive 18.4 points
out of 20 in the features test. The PA-20 also did very well 
in the audio quality tests, scoring full points for both the Eng-
lish and the Hindi tracks. The fidelity of the musical instru -
ments and the clarity of vocals that it offered remained
unmatched to a great extent. It also comes with an in-built
memory of 32 MB, which can be upgraded with the help of a

MultiMediaCard.
The NAPA DAV 316 bagged the Best Value

Award. A CD-based player, it was one of the
few that came with rechargeable bat-

teries. Not only does it support
MP3 files, but it can also play

normal Audio CDs, thanks
to its support for CD,

CD-R and CD-RW
media. Its LCD display
and the support for ID3
tags provide complete
details of the audio track
that is playing. The NAPA
is thus a feature-packed,
user-friendly device and

for the low price of Rs 5,650, it is a solution within the reach
of almost everyone.

ALIASGAR PARDAWALA and AHMED SHAIKH

Although small in size the Creative
PA-20 packs a mean punch

You are looking
for

You need

Look for

Price range 

An MP3 player that is
compact and allows
you to store up to 
2 hours of music
A solid state MP3 play-
er that lets you transfer
MP3 files from your
computer via a USB
connection
Creative PA-20 and 
M-ANY DAH200S
Rs 6,000 to Rs 9,000

A portable solution that
lets you store 10 hours
worth of music

A portable player that
supports CD, CD-R and
CD-RW media and a CD-
Writer to burn the MP3s

NAPA DAV316 and Cre-
ative DAP-CD0001
Rs 5,500 to Rs 9,000

Decision Maker
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Flash MX is the first product to be
released from Macromedia’s new
MX line-up. Macromedia’s goal is
to release a new suite of applica-

tions that will enable the development of
next-generation Internet content. The MX
tagline clearly indicates Macromedia’s
intention to tighten integration between
its various products just like Microsoft
2000 and XP. There’s a lot to like about
Flash MX such as dockable and collapsible
panels, revamped user interface features,
expanded video capabilities, improved
ActionScript editor and much more. But
is it worth your time and money?

Interface and ease of use
Flash MX sports a familiar interface, with
the only difference being the incorpora-
tion of the MX panel management sys -
tem. For the first time, layers can be
grouped and neatly arranged—you don’t
need to scroll the layers up and down, or
reduce the work area size while working
with huge animations which involve lots
of layers. To make things even more con-
venient, every object can be easily dis-
tributed as different layers either through

the menu, or by right-clicking on the
object itself. 

The timeline may seem unaltered at
first glance, but you’ll notice the differ-
ences once you start working with it. In
order to select multiple frames, all you
have to do is drag the slider across the
timeline. With the MX panel management
system, you can collapse the timeline to
get even more space for the work area.

The back arrow on the timeline lets
you go back to your previous working
state instead of accessing it through the
menu and the magnification option sits
conveniently at the edge of the timeline.
Knowing the various properties of the
object you are working on is imperative.
The Property inspector panel now sits on
the work area itself, allowing you to
change the various properties of the

object instantaneous-
ly. Since it shows only
relevant, context-sen-
sitive settings when
you work, it dramati-
cally reduces the
number of panels
open at any time. 

Though the MX
panel management
has its advantages, it
may not be conven-
ient to some users—
the panels slide up and
down while accessing
them, forcing you to
adjust your focus
accordingly, which

GRAPHIC DESIGN: Swaroop Biswas
test drive ■

■ flash mx

Flash MX is more than just a Web animation tool—
it’s a full-fledged development platform for creating content-rich Web sites and Web applications

The revamped interface of Flash MX ensures greater ease of use and
flexibility

SEPTEMBER 2002
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can be quite irritating. Another point of
concern is the absence of the shortcut
panel on the status bar that provided quick
access to many functions such as Show
Movie Explorer, Show Actions, etc.

Design features and elements
Macromedia has introduced some out-
standing features that increase produc-
tivity considerably. Flash MX incorpo-
rates an all-new Transformation tool fea-
turing Distort and Envelope modes. The
Envelope mode makes it possible to warp
and edit vector objects. The Distort mode
allows you to distort the object by its
edges or corners and taper it to give it a
3D look. One glitch with both these
modes is that you cannot modify sym-
bols, bitmaps, video objects, sounds, gra-
dients, object groups and text. If a multi-
ple object selection contains any of these,
only the shape objects are distorted. To
modify text, you will have to first convert
the characters to shape objects.

Flash MX also provides a sorely
missed element—pixel perfect alignment
of objects. You can turn on pixel snapping
using the Snap to Pixels command in the
View menu. A pixel grid will appear when
the view magnification is set to 400 per
cent or higher. The pixel grid represents
the individual pixels of your frame and
when you create or move an object, it is
constrained to the pixel grid.

A long-time complaint of Flash users
has been the absence of rich media sup-
port, i.e. video and audio. Flash MX comes
with the Sorenson Spark codec, which
means you can import video into Flash in
different file formats (AVI, MPEG, etc).
When you export the SWF file, the video
will be embedded into your Flash movie.

Loading external files is not restricted

to just MP3s. JPEG images can also be
imported at run time, allowing you to
program events within a Flash movie.
This will significantly reduce the overall
size of the Flash movie and make the con-
tent more dynamic. Another addition is
the Font Mapping feature—if you work
with a document containing fonts that
aren’t installed on your system, they will
be substituted by those already installed.
Alternatively, you could set a default font
under Edit > Preferences > General > Font Map-
ping Default.

You can now update and swap sym-
bols in any Macromedia Flash MX docu-
ment on your computer or on the net -
work. Hence, shared symbols across mul-
tiple documents can be manually or
automatically updated when a change is
made to the original. In case you want to
swap images, you don’t have to go
through the tedious procedure of re-
importing the new image. Simply right-
click on it and select Swap Bitmap, which
will open a panel from which you can
select the correct image.

Flash MX also introduces dynamic
masking support. Previously, masking
could only be done through layers. Now it
is possible through ActionScripts that
allow you to mask one movie clip object
over another, irrespective of the layer it is

on. Lastly, the option
of allowing the user to
save his work as a tem-
plate gives the flexibil-
ity to reuse the saved
document as a starting
point for other Flash
documents.

Development 
and server-side 
features
Those who used Flash
4 were overwhelmed
by the huge set of
ActionScripts, and the
inclusion of XML
socket commands.

JavaScript support in Flash 5 was a wel-
come gesture. But Macromedia wants to
position Flash MX as a development plat-
form for building content-rich Web-based
applications. Hence,  JavaScript support
has been improved while the ActionScript
editor and debugger sport several
enhancements. 

The ActionScript editor now not only
highlights keywords and values in the
ActionScript code, but can also detect the

action you are entering and display a code
hint—a tooltip containing the complete
syntax for that action or a popup menu
listing possible property names and meth-
ods. The editor is now a collapsible panel
in the interface (owing to the MX panel
management system), so you don’t need
to open a new window every time you
want to edit a script. The Script Debugger
has also been improved and lets you set
breakpoints in your code and step
through your scripts one line at a time as
your animation runs in Preview mode.
This considerably reduces the time taken
to debug errors. 

If you are still not impressed, then
check out the all-new Flash UI compo-
nents tool—it allows you to quickly and
easily add simple user interface elements
such as radio boxes, check boxes and drop
down lists to your Flash document. As
with Visual Interdev, once you have the
element on the page, you can modify its
parameters. These UI components can
also be controlled programmatically with
ActionScripts, which in turn can com-
municate with the server-side program-
ming language.

In the previous version, the code
generated by using ActionScripts was
different and more complicated. To
receive data from a server you had to 
use the ‘LoadVariablesNum’ action.
However, in Flash MX it has been
replaced with just ‘.load’.  This will
reduce the amount of coding time put
in by expert coders who like to manual-
ly enter their code.

The Distort and Envelope tools allow you to warp and edit vector
objects

Code Hints make the process of writing scripts
a whole lot easier

Swap Bitmap allows you to enlarge images
without having to reimport the image



Developing rich Internet applications
with Macromedia Flash MX is made eas-
ier with the addition of Macromedia
Flash Remoting components. With
Macromedia Flash Remoting, developers
can easily connect ActionScript client
logic directly to remote services without
writing any extra code. It enables Flash
MX to exchange data with remote serv -
ices, including ColdFusion components,
EJBs, Java classes, and .NET components
and pages.

To help ease development in highly
managed production environments,
Flash MX integrates directly with Site -
spring, Macromedia’s workflow manage-

ment server. Sitespring users can check
content in and out, update status, and
communicate with their teams without
leaving Flash.

One major complaint from most
users was that using too much XML code
would kill the animation. This problem
has been addressed and Flash MX uses
XML more efficiently, resulting in
smoother animation. 

The verdict
So, is Flash MX truly worth the upgrade?
The revamped user interface alone can
provide a huge boost to your productivi-
ty, and the new design and development
features are a big plus while developing
either animations or rich media-based
Web applications. However, in spite of
these new enhancements, one wonders
why there are no graphical tools to sup-
port basic 3D modelling. If you use Flash
primarily as an animation tool, then
there’s no compelling reason to upgrade
from version 5. Flash MX boasts huge
functional advancements when it comes

to programming and if you intend to
develop games, Web-based applications
and multimedia interfaces, then you
would definitely benefit from migrating
to Flash MX. 

MITUL MEHTA and MAYANK JAIN
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Converting your AVI, MPG and Quick Time
files to SWF format before publishing them to
your Web site can result in considerable space
savings and visitors to your site will be able to
watch the movie directly in their Web brows-
er (provided they have the correct plugin).

Click Insert > New symbol. You will
be prompted for the type of symbol

you want to create. Select Movie Clip from
the Behavior options.

Under File > Import, select the video
file that you want to import. At 

the Import Video prompt, select ‘Embed
video in Macromedia Flash document’ and
click OK. 

In the ‘Import video settings’ win-
dow, change the scale setting from

100 per cent to 80 per cent in order to com-
press the video to a decent quality. You can
also adjust the quality of your video file—we
have changed the default quality setting
from 50 to 80. After the file is imported, click
Yes to embed the video file on the timeline.
Save the file on your PC. 

Click on the Scene 1 button that
resides just below the Timeline

panel. Drag the movie clip symbol from the
Library panel to the work area of Scene 1
(the Library panel can be enabled by press-
ing [F11])

Reset the size of your work area to
match the size of the imported video

file by clicking on Modify > Documentand
set the Dimensions according to the movie
size. The Info panel (enabled by pressing
[Ctrl] + [I]) will show you the size of the
imported video file.

Go to File > Publish Settings and
select the Flash and HTML box in

the Format tab. Click on the Flash tab and

with Flash Player 6 selected from the Ver-
sion drop down box, click on the Publish
button.

Browse to the folder in which you
saved the Flash file. You will find that

two files have been saved—one is in the
HTML format and the other is an SWF file.
Upload both files on your Web server using
an FTP program (such as CuteFTP) and link
the HTML file to any of the pages on your 
Web site.

Note: In case the video file is in MPG/MPEG or
QuickTime 4 format, it will not import the
audio along with the movie in Flash. Even a
video file of 1 to 2 MB will take at least 5-10
minutes to import on slower machines.

Putting your Video on the Web

Select the imported movie from the Library
panel and drag it to the work area

Publishing your video

1
STEP

2
STEP

3
STEP

4
STEP

5
STEP

6
STEP

7
STEP

Sitespring allows for efficient project
management amongst Web developers

Price: Rs 24,950
Contact: Macromedia
Tel: 91-22-8201706
Fax: 022-8365167
E-mail: shriram@macromedia.com
Web site: www.macromedia.com

SYSTEM REQUIREMENTS: 
200 MHz Intel Pentium processor, Windows
98 SE/Me/NT4/2000/XP, 64 MB RAM (128
MB recommended), 85 MB hard disk space,
1024x768 resolution, 16-bit colour display
or better, CD-ROM drive 

Flash MX 
Performance
Ease of use
Value for money
Features
OVERALL

A-A-
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The Epson Perfection
2450 Photo is a scan-

ner aimed squarely at
high-end graphics profes-
sional. It allows you to
scan photographs and
transparencies at resolu-
tions of 2400x4800 at 
48-bit colour depth. 

The Epson Perfection
uses a USB 1.1 interface
and also has integrated
FireWire functionality for
faster data transfer. We
found the installation
effortless; Windows XP
detected it immediately. It
performed very well in the
image quality test, produc-
ing an extremely crisp
image with vivid colour
reproduction. In the pho-
tograph test, it scored an
impressive 9 out of 10 and
had excellent tonal range,
scoring 8 out of 10 in that
test. The scanner complet-
ed the image preview in 
an amazing 6.6 seconds,

beating the previous record
of 8 seconds set by HP
ScanJet 5470C in our scan-
ner comparison in the
August 2002 issue. It per-
formed exceedingly well in
the resolution test too,
scoring 4 out of 5 and lived
up to its supported hard-
ware resolution. With bril-
liant imaging qualities, this
scanner is tailor-made for
applications in design 
studios and for print 
production.

Price: Rs 32,500
Company: Epson India Ltd
Phone: 080-5321266
E-mail: azra@eid.epson.co.in
Web site: www.epson.co.in

Epson Perfection 2450 Photo
Photo perfect!

The LITEON CD-ReWriter
requires fast media to

exploit its true potential. We
tested it with Imation’s 40x
compatible media. It wrote
our 700 MB ISO file in a fast 3
minutes 44 seconds, beating

the previous record holder
ASUS CRW-2410S by 17 sec -

onds. In the assorted file test,
650 MB worth of small files
and folders with long file
names were burnt in 3 min-
utes 20 seconds flat! Audio
extraction speeds were pretty
fast too—2 minutes to rip an
Audio CD with 14 tracks
totalling 64 minutes 2 sec-
onds. At 40x write speeds, the
writer burns data at an amaz-
ing speed of 6000 KBps. This
can be a really high number to
sustain for slower systems and

though the CD-ReWriter sup-
ports buffer underrun technol-
ogy, we recommend a 7,200-
rpm hard drive if you intend
to burn at such high speeds.

LITEON CD-ReWriter 40/12/48x
The fast and the furious

Stellar Phoenix 
To data loss and back!

We test the latest and the best hardware and software products available in the market 

SPECIFICATIONS
Resolution of 2400x4800, 48-
bit colour depth, USB 1.1 and
IEEE 1394 FireWire interface

Epson Perfection 2450 
Performance
Build quality
Value for money
Features
OVERALL

B+B+

LITEON CD-ReWriter 
Performance
Build quality
Value for money
Features
OVERALL

B+B+

Price: Rs 4,200
Contact: Mediatech India
Phone: 022-2396696
E-mail: sales@mediatechindia.com

SPECIFICATIONS 
ATAPI Enhanced IDE interface,
supports up to Ultra-DMA
Mode2 33.3 MBps, 80 ms (typ-
ical) access time, 2 MB buffer 
memory  

This tool allows you
to recover data from

a logically damaged
hard disk. It offers
recovery from acciden-
tal formats, partition
loss, virus-related cor-
ruption, file/directory
deletion, even total disk
corruption. It can iden-
tify inaccessible drives,
and locate and present all the
partitions in a list. It need not
be installed prior to a data loss
incident and has no drive
capacity limitation. Strangely,
the product comes with a 
10-count recovery limitation,
limiting your usage. For further
use, you will have to renew the
licence. We tested the software
by doing a quick format of a

partition; it showed us
the exact tree structure
of the directories and
recovered all our data.

The software does
have a few limitations
though—it will not
work if the drive can-
not be detected in the
BIOS. Also, if you acci-

dentally perform a quick for-
mat and then write data onto
the freshly formatted disk, the
chances of data recovery are
reduced dramatically.

Stellar Phoenix
Performance
Ease of use
Value for money
Features
OVERALL

BB
Price: Rs 4,000
Company: Stellar Information
Systems Ltd.
Phone: 011-6418809
E-mail: sales@stellarinfo.com
Web site: www.stellarinfo.com

SPECIFICATIONS 
Minimum System Require-
ments: a working hard disk and
floppy disk drive, 32 MB RAM
(64 MB recommended), MS-
DOS 5.0 or Windows
3.x/9x/Me 
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The new Celeron 1.7 GHz is
based on the old Pen-

tium 4 architecture, but
features only 128 KB
of L2 cache, hin-
dering the
exploitation
of its full poten-
tial. Thankfully
though, the processor
features MMX, SSE and
SSE2 instructions, which
assist in multimedia applica-
tions and gaming. Even
though it uses the older 0.18
micron manufacturing tech-
nology, it uses the new Sock-
et 478 interface, allowing it to
be used on the same boards as

the Northwood Pentium 4,
which means you will be able

to upgrade easily in the
future. We used a 256

MB DDR SDRAM
with an Intel
D 8 4 5 G B V

m o t h e r b o a r d
coupled with a 64

MB GeForce3 graphics
card to test the processor.

The scores were disappoint-
ing: the processor could not
keep up with the GeForce3,
severely bottlenecking the
gaming and multimedia
benchmarks. This was most
apparent in the Quake III
Arena test where the average

Price: Rs 10,000
Company: Priya Ltd
Phone: 022-2663611
E-mail: salesbom@priyagroup
.com
Web site: www.msi.com.tw

This Pentium 4-M 2.0
GHz powered note-

book from ACi comes
packed with 128 MB
DDR SO-DIMM RAM,
20 GB hard drive and
a crisp 14.1-inch
TFT screen.
It comes
with Win-
dows XP Home
Edition along with
the driver CDs. Also includ-
ed is a leather carry bag and
an external USB floppy drive,
which felt out of place in an
otherwise compact notebook.
It is fairly robust and the
Lithium Ion battery ran for
around 102 minutes in the
BatteryMark 4.01 test. In Con-
tent Creation 2001, it scored
a low 37.9, a score that
could’ve been bettered by
about 25 per cent if it had 256
KB of cache memory. A mem-
ory of 256 MB also becomes a
necessity to run Windows XP

Home Edition smoothly. The
integrated SiS 650

graphics chip with
shared memory
architecture of 64 MB
supports a resolution
of 1024x768 with 32-
bit colour depth.  We

ran a VCD on it
and there was
no noticeable

blur in the display
and the speaker sub-

system was pretty decent
too. It can double up as an
entertainment companion
since it bundles a full duplex
soundcard along with an RCA 
TV Out port. 

ACi Emerald 
Mobile powerhouse!

ACi Emerald
Performance
Build quality
Value for money
Features
OVERALL

BBPrice: Rs 89,990 + taxes
Contact: Allied Computer Inter-
national (Asia) Pvt. Ltd.
Phone: 022-6366800
Fax: 022-6366356
E-mail: sales@aci-asia.com
Web site: www.aci-asia.com

SPECIFICATIONS 
Pentium 4 processor, 128 MB
DDR RAM, 20 GB hard disk,
CD-ROM drive, USB floppy
drive, SiS 650 graphics with
shared memory up to 64 MB,
one PCMCIA slot, four USB
ports, one PS/2 port, one IEEE
1394 FireWire port, onboard
56K modem, onboard LAN

Intel Celeron 1.7 GHz
Old P4 in Celeron clothing

frame rates in Normal, High
and Maximum modes were a
playable but not too impres-
sive at 74.2, 74.5 and 68 fps
respectively. In the FPU-
intensive POVRAY test, the
Celeron 1.7 GHz took a stag-
geringly long time of 6 min-
utes 43 seconds. 

The new Intel Celeron is
not recommended if you are
heavily into 3D gaming and

professional 3D applica-
tions, but will be satisfactory
for your day-to-day office
applications and for running
general desktop software
that aren’t too taxing on the
processor.

Price: Rs 5,925
Contact: Nebula Technologies
Phone: 022-6730567
E-mail: sandip@nebulatech.com
Web site: www.intel.com

Intel Celeron 1.7 GHz
Performance
Ease of use
Value for money
Features
OVERALL

B-B-

SPECIFICATIONS
1.7 GHz clock speed; 128 KB
L2 cache; Socket 478 interface;
Willamette core (0.18 micron)

This motherboard packs in
a number of features

including a plethora of over-
clocking options such as FSB
adjustments up to 233 MHz,
AGP over voltage and DDR
SDRAM over voltage. Instal-
lation is a breeze, as
the board
sports no
jumpers or
d ipswi tches .
The MSI package
also features a nifty
utility called Fuzzy
Logic4, which takes complete
control of the overclocking
process and finds the safe lim-
its for a successful overclock.
It is further packed with six
USB ports, D-LEDs (Diagnos-
tic LEDs), onboard LAN,
onboard six-channel audio,
onboard RAID (0+1), USB 2.0
functionality and a rock solid
845E chipset implementation.
Sporting an unconventional
blood red colour, the special
heat sinks mounted on the
MOSFETs (Metal Oxide Semi-
conductor Field Effect Tran-

sistor) makes this board stand
out among the rest. The only
problem is the placement of
the AGP slot and the DIMM
slots; you won’t be able to add
or remove any RAM modules

once the graphics card is
installed since the

AGP card will
block the

DIMM slot
retention clips. We

tested the board with
256 MB of DDR SDRAM, a
Pentium 4 2.53 GHz processor
coupled with a GeForce3
graphics card. The scores
almost matched up with 
our RDRAM-powered test
machine using the same
processor. It scored an impres-
sive 7381 in 3DMark2001SE
and 162.6 fps in Quake III
Arena at maximum settings.

MSI 845E Max2-BLR motherboard
MSI to the max

SPECIFICATIONS
845E chipset; Socket 478
processor interface; support for
266 MHz DDR SDRAM; inte-
grated six-channel audio, RAID
(0+1) controller and USB 2.0

MSI 845E Max2-BLR 
Performance
Build quality
Value for money
Features
OVERALL

A-A-
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organisations that work on
tight deadlines and have
enormous number of tasks
spanning over a number of
years.

Sun’s office suite comes
packed with all the stan-

dard office productivity
tools—word processor, spread-
sheet, presentation, drawing,
formula-design and HTML-
editing applications. This ver-
sion opens and saves Microsoft
Word, Excel, and PowerPoint

files, and the disk require-
ments are modest. Installating
it is easy and automated and
can take up to 230 MB. In
addition, it installs several
fonts, which will replace the
existing ones in Windows, but
the installation process gives
you the option of retaining
your original fonts.

It offers over 130 tem-
plates, backgrounds, and for-
mats, from business letters to
full-blown thesis formats.
When editing large docu -
ments, the Master Document
lets you create styles for mul-
tiple files. The Spreadsheet
software is fairly competent

too. When we imported our
comparison test tables and
formulae-filled Excel files,
conversion was almost per-
fect. Note that these files were
created in Microsoft Office
2000/2002; results could vary
with older versions.

We also imported several
large PowerPoint files with
generally good results, though
we noted some errors in the
reproduction of text format-
ting. As with Microsoft Power-
Point, you have control over
the speed and timing of
shows, you can select from a
wide range of transitions, and
there’s a thumbnail page for
an overall view. All-in-all,
StarOffice 6.0 is an impressive
package. It contains features
you use every day and some
you’ll never touch, all at a rea-
sonable price. However, the
full download version of
StarOffice 6.0 can only be used
for a single operating system.

Price: Rs 50,000
Contact: Kemptron Systems
Phone no: 011-6286258
Fax no: 011-6286260
E-mail: kemptron@del3.vsnl.
net.in
Web site: www.microsoft.com/
products

Microsoft Project 2002
Performance
Ease of use
Value for money
Features
OVERALL

SPECIFICATIONS
Minimum System Require-
ments: Windows 98/98 SE/NT
4.0 with SP6/Me/2000, 234 MB
hard disk space, 112 MB RAM
Pentium 133 MHz processor,
mouse or compatible device,
CD-ROM drive, SVGA monitor

B+B+

The Intel D845GBV moth-
erboard is based on Intel’s

845G chipset, which supports
Intel processors based on the
Socket 478 interface. 
The motherboard features
a DDR memory
interface of
s p e e d s
up to
266 MHz,
an onboard
sound chip
based on the 
Analog Devices
AD1981A chipset and
an onboard video chip based
on Intel’s Extreme graphics
controller. It also integrates a
network adapter. This makes
it an ideal package for those
with a limited budget, but
who are still in need of a fea-
ture-rich solution. This board
has one AGP, six PCI and one
CNR slots, along with two
DIMM sockets. It also sup-
ports a USB 2.0 port and 2 GB
of DDR memory.

We tested this mother -
board with a 2.53 GHz proces-

sor. It scored an impressive
63.2 in the Business Winstone
2001 test. In the Content Cre-
ation 2001, it achieved 89.3,

almost matching the
RDRAM-powered test

machine using
the same

processor.
The inte -

grated graph-
ics core is pretty

decent and it scores a
respectable 105 fps in the nor-
mal resolution in Quake III
Arena.

The board is an excellent
buy if you are looking for an
ultra fast DDR solution and
don’t intend to buy a graphics
card but want room for future
upgradability.

Intel D845GBV motherboard
845 ways to P4 integration

Price: Rs 8,120
Contact: Nebula Technologies
Phone: 022-6730567
E-mail: pradip@nebulatech.com
Web site: www.intel.com

SPECIFICATIONS
i845G chipset, support for
Socket 478-class processors like
Celeron and Pentium 4, 266
MHz DDR SDRAM memory
interface, integrated graphics
and audio

Intel D845GBV 
Performance
Build quality
Value for money
Features
OVERALL

B+B+

Microsoft Project 2002
Manage your projects to perfection

Sun StarOffice 6.0
Performance
Ease of use
Value for money
Features
OVERALL

BB

Price: $75.60 (approx Rs 3,750)
E-mail: csr-customer-service@
sun.com
Web site: www.sun.com

Microsoft Project is the
world’s leading project

management program and
this new release brings
more intuitive tools
and built-in project
management assis-
tance. It includes a
new step-by-step inter-
active project guide
that helps you set up a
new project, manage
tasks and resources,
track schedules and
report project information.

It has improved grouping

and information displays
within the network diagram
(which shows you all the tasks

in a graphical manner)
and new smart tags that
alert you to alternative
scheduling choices
when you make changes
to your project plans.
You can now import
task lists from Microsoft
Outlook or save multiple

baseline estimates for any
project. This software will be
appreciated by everyone,
from small companies to large

Sun StarOffice 6.0
New star on the horizon

SPECIFICATIONS
Minimum System Require-
ments: Windows 95/98/ME/
NT/2000/XP, Pentium/Athlon
processor, 64 MB RAM, 250 MB
hard disk space, 800x600 or
higher-resolution graphics card
with 256 colours
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If you are blessed with a
broadband connection

at home, then take a look
at this three-in-one cam-
era from Mercury. Aptly
called the PenCam, it is
light and compact in
design. It draws power
from the USB port and
can also function on two
AAA batteries. The Pen-
Cam can capture 26
images at 640x480 pix-
els and 107 images at a
resolution of 320x240.
It’s capable of continu-
ous shooting and also
features a self-timer.
However, it isn’t suited
for serious imaging
applications since
the picture gets a
little grainy at
640x480, but can be
used to record movies in
the AVI format. It also doubles
up as a Web cam—the stream-
ing quality is good, but the
camera has to be kept focused
on the user’s face. The rectan-
gular shape of the camera
makes it difficult to take pic-

tures and the stand
doesn’t have a good
grip, causing the cam-
era to slip from its
position due to the
weight of the USB
cable. 

It comes bundled
with PenCam Manag-
er, Microsoft NetMeet-
ing, VideoMail, Ulead
Cool 360, Ulead
Photo Explorer, Ulead
Photo Express and
Ulead Video Studio
SE.

Its relatively
affordable price tag
makes this camera a

good option if you are
looking for a basic,

portable and fun
digital imaging

device.

The Brother P-Touch
2300 is a PC-

c o m p a t i b l e
e l e c t r o n i c
l a b e l l i n g
system. It has
a small LCD
display for edit -
ing your text and
uses a high-quality
thermal printing system.
It supports text framing and
underlining, and also has
support for foreign language
symbols. It prints on a 0.25x1
inch wide label suitable for
any home or commercial

application. You can use
the bundled keyboard

or your PC to create
labels in nine

varying styles
and eight
d i f f e r e n t
point sizes

(up to 52
points). Vertical,

horizontal and mir-
ror printing are also support-
ed. The printer has a 300-
character memory, auto-num-
bering and repeat printing
(one to nine copies) and also
features an automatic tape

Musicians may be laying
down tracks but it’s the

DJs who add flavour to your
music experience.

Club Tracks
from Cakewalk is
a perfect multi-
track remix stu-
dio for generat-
ing Techno, Hip-
hop and other
kinds of club
music. The soft-
ware puts the cre-
ative power in
the user’s hand,
letting you create
your own mixed versions,
built from layers of Fruity-
Loops Express rhythm sam-
ples or recorded samples from
CDs, or even your own tracks.
Unlike other programs, this
one is fairly simple to use and
offers three different views to
work with. The Edit view
allows you to drag and drop
tracks onto the mixing palette
whereas, the Mix view has vir-
tual sliders, pans and other

studio console control knobs
to manipulate the track. The
mixer allows you to add a

final dash of
reverb, echo and
delay, chorus or
flange effects. It
includes a 
30-day trial ver -
sion of Cakewalk
Pro that can be
used to export
your creations to
MP3 files or to
CDs—provided

you already have
the necessary CD writing

hardware.
In totality, Cakewalk Club

Tracks provides all the ingredi-
ents needed to produce profes-
sional-sounding dance tracks
at a very affordable price.

Cakewalk Club Tracks 
Piece of cake

SPECIFICATIONS
Minimum System Requirements:
Windows 95/98/Me, Pentium-
class 200 MHz processor, 32 MB
RAM, 800x600 video display,
Windows-compatible sound-
card, CD-ROM drive

Cakewalk Club Tracks
Performance
Ease of use
Value for money
Features
OVERALL

BB
Price: Rs 975
Contact: Microware Computer Services
Phone: 022-8729725
Fax: 022-8727446
E-mail: sales@mwcdrom.com
Web site: www.mwcdrom.com

Brother P-Touch 2300 label printer
Label this!

Price: Rs 3,000
Contact: Visualan Technologies
Phone: 022-8202688
E-mail: sales@visualanindia.com
Web site: www.kobian.com 

Mercury 3-in-1 PenCam
Performance
Build quality
Value for money
Features
OVERALL

BB

cutter. The package comes
bundled with one labelling
unit, two 12-mm tapes, auto-
transformer, USB connector,
PC software and a tape sepa-
rator. The device gets detected
the moment it is plugged to
the USB port and the bundled
CD installs the driver for the
labeller and application with-
out asking for any restart. In
the absence of a PC, the unit
can also be used with eight

AA batteries. 
The P-Touch 2300 labeller

is a compact, easy-to-use
device that can serve a vast
range of functions from file
labelling in offices, to
labelling products in shops
and even to bring some order
into your home!

SPECIFICATIONS
USB 1.1 compliant, 12 mm
tape, 9.5-volt DC power supply

Price: Rs 14,900
Contact: Brother International
Phone: 022-5797470
E-mail: rsa_brothers@vsnl.com
Web site: www.brother.com

Brother P-Touch 2300 
Performance
Build quality
Value for money
Features
OVERALL

BB

SPECIFICATIONS
CMOS sensor (approx 330
Kpixel), USB interface, support
for 640x480 and 320x240 reso-
lution, 54-degree view angle

Mercury 3-in-1 PenCam 
Finger-sized photography
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I upgraded to a 40 GB hard
disk drive recently, but the
data bloat has caught up with me

already. My wallet doesn’t allow me to buy
a bigger hard disk, so I suppose it’s time to invest
in a CD-Writer and transfer my treasure of MP3s
and DivX movies on to CDs.

We did a CD-Writer comparison for our Feb-
ruary 2002 issue, but since then, much has
changed. The writing speeds have almost
doubled and prices have crashed to a
point where you can get a speedy CD-
Writer for less than Rs 4,000. The change is
coming on fast and vendors are getting rid
of older Writers at unbelievable prices. 

The top CD-Writer speeds have
nearly tripled since the beginning of
this year, going from 16x to 40x, and
48x Writers are expect-
ed later this year.
Buffer underrun
t e c h n o l o g y
(which pro-
tects discs
during writ-
ing) has become
the norm, and the aver-
age price for a leading-edge drive has fallen
from Rs 7,000 to Rs 4,000 within a matter of months.

I’ve been trying to make informed decisions lately, trying
to get the best buy within a reasonable budget, so it was with
only Rs 5,000 in my pocket that I made a trip to Mumbai’s Lam-
ington Road. 

I must apologise for being so Lamington Road-centric, 
but it’s the Sensex of the Indian hardware scene—Lamington
Road is where you can benefit from temporary price drops, mar-
ket fluctuations and vendor dumping. For enthusiasts in
Gawhati and Chennai, the benefits will take a little longer to
trickle down.

The first brand that I came across was a 32x Krypton

CD-Writer, and
the dealer tried to
convince me

that it was a
hot selling
item because

of its price. Yes,
the price was really a
clincher, but none of my
friends had heard of this
brand, so I got a little sus -
picious and moved on. 

LITEON is a brand
that has become increas-

ingly popular lately
and I’ve had several reports that this Writer spews

no blanks. I found a LITEON 40x Writer for Rs
5,200—definitely one of the fastest I’ve seen

so for, but there’s a caveat—as the
drives become faster, the benefits
shrink. A 24x might burn a CD in 3
minutes, but the increase in speed

beyond that is negligible.
I found another cheap brand,

Benq, which offered a 32x CD-Writer
for Rs 3,900 and a 40x CD-Writer for Rs

4,800. I’d heard good reports of its burning
speeds. Sony’s 40x CD-Writer is available for around Rs 4,000-

4,500. And Samsung has a 24x selling for only Rs 3,200! Their
32x and 40x CD-Writers were priced at Rs 4,000 and Rs 5,200
respectively.

Next, I came across a Plextor, the mother of all CD-Writ-
ers—these drives come at a premium. Plextor is to CD-Writers
what Rolex is to wristwatches. The PlexWriter W4012TA burns
CDs at 40x (under 3 minutes) and was available for Rs 10,800.
Their combo drive (CD-RW cum DVD-ROM drive) with 20x
write and 12x DVD speeds was available for Rs 11,400. Plex-
tor’s 48x speed drive, the fastest drive I’ve seen so far, was for
Rs 12,950.  

Speed is not all that sells a CD-Writer; brand name is worth
quite a lot, as is the brand positioning of the Writer. If you
stretch your budget a little bit, you can get an SM-308 Samsung
(8x CD-Writer cum 8x DVD drive) for a cool Rs 5,200. The SM-
316 (16x CD-Writer cum 12x DVD drive) is available for around
Rs 6,000. These models have been marketed as a three-in-one
combo, and have generated a lot of excitement. External drives
for the portable Writer cost more than Rs 10,000 (Benq had a
24x for Rs 10,000, and a 40x for Rs 11,000). Plextor’s W2410TU
external USB drive was going for Rs 15,000. 

After a long day’s work, I opted for the Samsung 24x—it
costs only Rs 3,200 and meets my requirements perfectly. With
stocks disappearing like hot cakes, now is the time to grab that
Writer. Go get one before it’s too late.

■ The right brand of CD is as important as the CD-Writer.
Cheap CDs might last for a few years, but for long-term

storage, use brands such as HP or Sony.
■ CD prices have dropped as well; you can pay as low as Rs 12

a piece if you buy in bulk. 
■ CD-R capacities have increased from 650 MB to a whopping
800 MB. 
■ CD-RW (the CD re-writeable) is the ideal replacement for the
floppy. RW media can be used up to 100 times and costs only 
Rs 120. 

Write Said Fred
Our beloved agent snoops around Lamington Road, investigating the price drop in CD-Writers 

ReWrite choice
An external CD-

ReWriter used to
cost nothing less
than Rs 15,000,

but you can now
get one for half the price!
The fully USB 2.0-compli-
ant LITEON 24x10x40x
external CD-ReWriter is
available for a throwaway
price of Rs 7,195.



88 SEPTEMBER 2002

C
ontent is king, and nowhere
more so than in the enter-
tainment industry. It brings
in the money, reins in the
audience and is thus zealous-

ly guarded by the corporate moguls of the
music and movie world. Lately, technolo-
gy has been the prime cause of angst for
these sectors. A rise in music and motion
picture piracy has been directly blamed on
advances such as the rise of the Internet,
the advent of efficient compression tech-
nologies and the falling prices of both CD
recorders and recordable media. Experts
in these industries readily blame the fall in
the sales of their products on these factors.
Hilary Rosen, president and chief execu-
tive officer of the Recording Industry Asso-
ciation of America (RIAA) has this to say
about the scenario: “A large factor con-
tributing to the decrease in overall ship-
ments of music CDs is online piracy and
CD burning. Global piracy on the physi-
cal side costs the recording industry over
$4 billion a year.” The music industry was
especially caught off-guard by the spread
of MP3 files on the online service, 
Napster. Peer-to-peer services such as

Gnutella and KaZaA have had a similar
impact on the movie industry—pirated
copies of DVD movie discs trickle down
from the Internet and appear in potential
markets much before the release of the
feature film in cinema halls. 

To consolidate their position and mar-
ket share, both these industries have taken
measures to dampen the technological
fallout and ensure that such scenarios do
not repeat themselves. One such measure
is the use of copy-protection technologies
to guard their valued content against
would-be pirates. Join us as we take a look
at how copy protection techniques used
on both CD-ROM and DVD-ROM drives
are affecting the buying public and how
they are implemented.

Wherever you may ROM
A CD is ubiquitous; it brings us
entertainment in the form of
video CDs, audio CDs and games.
Content on this medium is also
the most pirated. A survey suggests
that sales of CD recorders have
tripled since 1999, that there 
are approximately 29.9 million

unauthorised CD-ROM copies in US
households, and that almost half of the
software copied are games, with educa -
tional software coming in at a close sec-
ond. The paranoia over protection of
media has spawned an entire industry that
aims to provide solutions to the content
generators. Some of these schemes bend
the standards that are laid down for the
production of CD-ROMs. Some even go as
far as breaking them. The issue is real
enough to have caused Philips (the co-cre-
ator of the CD-ROM standard) to raise
concerns that users might be buying discs
that are not ‘true CD-ROMs’. 
Breaking the standards: The easiest
means of content protection involves
increasing the size of the CD medium.

Dummy files, which merely
act as pointers to other files
on the CD are used to do just
this. This way the CD is
made to look bigger than it
is—greater than its standard
600 MB capacity, and any
attempt to copy files from
the CD to the hard disk (a
process that some pirates use

According to
the International
Planning and
Research Corpo-
ration, the losses
due to software
piracy in 2001
amounted to
$10.97 billion 
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To
stop 

a
Content companies struggle to safeguard their content

even as crackers find new methods of defeating them. In the
end, it’s the consumer who pays for products that don’t work
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to copy content) will fail. This is because
the CD will appear to hold data that
exceeds its capacity and the OS will refuse
to copy the files. The application that uses
the content on the CD has pre-knowledge
of the nature of the copy-protection
scheme used. It thus knows the true length
of the files involved and the CD works as
intended. This was one of the first meth-
ods used and is no longer effective, thanks
to the prevalence of 80-minute CD-R
media and the arrival of software that lets
you overburn a CD—that is, attempt to
write more content on a CD than what it
can actually store. Other protection tech-
niques create an illegal Table of Contents
(TOC) to similar effect, i.e., making a disc
appear larger than it actually is. (Every CD-

ROM has an indexed listing of its contents
that forms the TOC). Other methods use a
non-standard means of storing data on the
CD. Data is stored on a CD in the form of
tracks. To protect Audio CDs, atypical gaps
between audio tracks or the use of tracks
with an uncommon length of less than 4
seconds are used. 
Introduction of errors: Some CD-
ROMs are physically damaged by a line or
a ring across the data track to protect their
content. Most CD-Writers are not able to
copy data from a medium which has this
kind of an error. Other protection schemes
introduce errors while mastering a CD-
ROM disc. The application that is meant
to use the CD, checks for the anomaly and
will accept the CD as a legitimate version
only if the introduced errors are present. If
someone tries to copy the CD, the writing
software will use its error-correction facili-
ty to correct the inaccuracies that were
introduced during the mastering process.
The copy will then be faultless, but the
application will fail to detect the error and
will thus refuse to run. This form of pro-
tection is generally used in CD-ROMs con-
taining non-audio data content.

A somewhat fancier method of intro-
ducing a protection scheme on an Audio
CD involves changing the ECC (Error Cor-
rection Code) information. ECC allows

data that is being read or transmitted to
and from a CD-ROM to be checked for
errors and, when necessary, corrected on
the fly. It differs from parity-checking in
that errors are not only detected but also
corrected. To guard the content of an
Audio CD, the ECC data present is scram-
bled to appear as a non-correctable error.
When an Audio CD is played on a com-
puter system, the data is transported from
the CD-ROM drive to the soundcard via
an analogue path. Along this path are
logic elements that are designed to detect
any errors and use software techniques to
smoothen out the flawed audio. When an
audio track is copied through a CD-Writer
however, the data takes a digital path
meant for generic non-audio data. The

error correction is absent along this route
and thus the original error that was intro-
duced remains. This error comes across as
scratching and hissing noise in the copied
audio track. Newer writers use data cor-
rection at lower speeds and this protection
method can be thus bypassed.
Encryption: Encryption technology has
been successfully used as a means to safe-
guard content. The main executable files
on a protected CD-ROM are first encrypt-
ed using a special digital signature. The
signature is then mapped to a software
decryption key. The decryption will thus
only happen if the signature is present.
The required protection is offered by the
fact that the digital signature is not repro-
ducible by either counterfeiting (re-mas-
tering) or disc burning. When an authen-
tic disc is used, the signature is present,
decryption occurs and the application
runs. A pirate who attempts to replicate
such a disc will only be able to copy its
content and not the embedded signature.
When a copy is thus used, the signature is
not present, no decryption occurs and the
application does not run. 
Inherent protection: Every CD has
important information on the disc itself
which is called ATIP (Absolute Time In Pre-
groove, or pre-groove for short). The ATIP
contains information that indicates the

Code Breaker
A software to decrypt content scrambling
system (CSS),
called DeCSS,
was released
in October
1999. The
DeCSS infor-
mation can be
used to guess the
master keys that
form the base of
CSS protection scheme, a move which is
considered illegal under the Digital Mil-
lennium Copyright Act (DMCA). On Jan-
uary 14, 2000, the seven top US movie
studios—Disney, MGM, Paramount,
Sony, Time Warner, Twentieth Century
Fox and Universal—backed by the
Motion Picture Association of America
(MPAA), filed lawsuits in an attempt to
stop the distribution of DeCSS on Web
sites. On January 24, 2000, 16-year-old
Jon Johansen, the Norwegian program-
mer who first distributed DeCSS, was
questioned by the local police who raid-
ed his house. Johansen said that the
actual cracking work was done by two
anonymous European programmers,
who called themselves Masters of Reverse
Engineering (MoRE). But the cat was
already out of the bag as the DeCSS
code was made public during the court
proceedings. It can now be found on the
back of T-shirts everywhere! 

Marked as Defeated
A copy-protected Celine Dion album
offended music lovers around the world
as it hung PCs and crashed some iMacs
so hard that they had to be serviced by
dealers. Use of a mixed-mode disc (con-
taining both audio and data) was identi-
fied as the
cause of the
problem. By
simply mask-
ing the sec-
ond Table of
Contents on the
disc (which appears
as a thin ring on the recorded
surface, about half an inch from the
outer edge), music-buffs bypassed the
protection scheme. The masking was
done via decidedly low-tech means—by
using a black marker pen!

Foiled again!

We’re working very hard to make buying
music as easy as stealing music. And 

we’re also working hard to make stealing a hell
of a lot harder“ — Jay Samit, 

EMI’s senior vice president ”
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capacity of the CD, the manufacturer of
the medium, supported writing speeds,
last possible address where data can be
written, etc. Only a CD-Writer can read
the pre-groove, since this information is
only needed when writing a CD. When
an application starts, it checks whether
the ATIP information is present. If it is,
then the program assumes that it is run-
ning on a CD-Writer and will refuse to
run. If however, the same CD is put in a
normal CD-ROM drive, the ATIP infor -
mation will be invisible to the application
and it will run normally. A disc using this
means is thus prevented from running on
CD-Writers.

Save thy DVD
DVD content has been relatively safe till
date. A copied DVD movie runs in excess
of 1 GB of space. Compared to the 3 to 
5 MB that a typical audio file takes up
when compressed as MP3, it is an unruly
size to say the least. Thus, movie distri -

bution over the peer-to-peer networks
that lace the Internet is not as brisk an
activity as music-swapping. The movie
industry thus has some breathing space
to come up with a viable solution before
things take a turn for the worse for them. 
Watermarking: DVD audio is copy -
right protected by a digital watermark.
Signal processing technology is used to
apply a digital signature (and
optional encryption keys) to
the audio. Watermarking per-
manently marks each digital
audio frame with noise that is
supposedly undetectable by
human ears. An attempt to copy
a watermarked DVD will fail in
recreating the signature. Equip-
ment that support this tech-
nique will recognise copied
audio (by virtue of the absence
of added noise) and refuse to play it.
Watermark signatures can be recognised
by playback and recording equipment
to prevent copying. Even when the sig-
nal is transmitted via digital or analog
connections or is subjected to video
processing, the watermark is retained

and can thus continue to tag a protect -
ed content. 
Content Scrambling System (CSS):
This is a data encryption and
authentication scheme intend-
ed to prevent copying video
files directly from DVD-Video
discs. The content is stored in a
scrambled state on a DVD-ROM
disc. Every DVD player is coded
with a small set of player keys
which identify that player as an
authorised CSS playback mech-
anism. These keys are provided
by the DVD licensing authorities for a size-
able fee. Once a DVD disc is inserted into
a DVD player, the disc and the player
exchange information and if the player key
is valid, the disc unlocks a title key. The
title key is then used to unscramble the
data on the DVD. The actual process of
content protection thus involves the vali-
dation of a DVD player, rather than that of
the medium.

The fallout
What can be made can just as easily be
broken. There is a silent war going on
between the content creators and the
crackers. While the former strive to keep
one step ahead of the race, the latter
would like nothing better than to rub the
noses of the giants in the dirt, by defeat-
ing their protection schemes. Caught

between the two is the end-
user. These efforts for media
control have had an immedi-
ate repercussion on the buy-
ing public. 

Music lovers, for instance
have been forced to return
CDs of their favourite artistes
because the media would not
play on their computer sys -
tems. Take the case of the
soundtrack for the movie The

Fast and the Furious. Media giant, Univer-
sal, tapped a copy-protection technology
to lock up on ordinary CD audio files.
These songs, which appeared to be MP3s
or related to MP3s, could not be played
through common media players such as
Windows Media Player, Winamp or

RealOne. Nor could the digital files be
played on anything other than a Windows
operating system. Other copy protection
efforts have run into trouble with the pub-

lic. Natalie Imbruglia’s music
album, White Lilies Island, used
an encoding process to protect
its content. This process cor -
rupted the music stored on the
disc. A hi-fi CD player’s error cor-
rection mechanism was meant
to compensate for the corrupt
data and recreate the sound to a
level that was claimed to be

undetectable by the listener. Put the CD
into a PC, however, and the drive would
pick up the corrupt content and claim the
disc to be unreadable. The furore created
by this move forced BMG, the distributors
of the album, to issue unhappy consumers
with replacement discs that lacked the
offending technology.

Cases like these are not limited to
the music industry. Game distributors

have opted to use copy protection
schemes such as Macrovision’s SafeDisc
and many a gamer has found himself on
the receiving end of the problems
caused by such solutions: games bought
off store shelves refuse to run on their
computer systems because they have
older CD-ROM drives. The authentica-
tion process also takes up system
resources and slows down a gaming ses-
sion. Some of the games have also been
known to cause frequent system crashes.

Situations like these are a common
occurrence and will continue to plague
the buying public. It is thus the end-user
who finds himself caught between the
horses of pirates and copy-protection
schemes. But perhaps the key lies with the
consumer himself—if he is made aware of
the evils of piracy and is encouraged by
the content owners to buy the real deal,
there will be no need to employ schemes
with potential pitfalls. Until that hap-
pens, the industries involved will always
try to find solutions to protect their con-
tent and keep the customers happy...and
they will always fail! 

AHMED SHAIKH

SEPTEMBER 2002

BBC reports
that Napster,

the online music
swapping service,
had an estimated
60 million users
at the height of
its use

The Interac-
tive Digital

Software Associa-
tion estimated
that the piracy of
games amounted
to a loss of over
$3.2 billion
worldwide

The consumers started getting back saying that it doesn’t play 
on car CD players and several types of normal players. We were
really shocked...“ — Mathias Immel, 

Head of product coordination and new media at BMG, Germany”
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If the PC is where your entertain -
ment is, here is a way to enhance
the experience. Each of these hand-
picked software is easy to use and

provides several features to pump up
the capabilities of your system for a
smooth playback, high-quality record-
ing and encoding, and smart media
management.

Music on your desk 
A relatively recent development, online
radio came up around a year ago, when
broadband was just making an appear-
ance. Spinner 4.0 (www.spinner.com) is a free
online music player with thousands of
songs categorised into over a hundred
channels. You can choose from Techno,
Country, Hip-Hop, Latin, etc and enjoy a
continuous stream of music right on your
desktop, without installing an additional
software or plugin. It also hosts a feature
that gives you complete information
about your favourite artiste or song.

MP3 players are increasingly becom-
ing the popular carriers of music for those
on the move. But you need to convert
your music into MP3 format first and you
can’t trust just any software to do that.
You need high-quality conversion that

will optionally encode MP3 files with vari-
able bitrates, if your player supports it.
AudioCatalyst 2.1 (www.xingtech.com) con-
verts audio CDs to MP3s in one easy step
and incorporates a player and playlist
manager. It’s very fast and features sever-
al functions for enhancing the audio. You
can also use AudioCatalyst for encoding
MP3s from other file formats such as WAV. 

Winamp (www.winamp.com ) needs no
introduction; you’re probably playing it
on your desktop right now, and if you
aren’t, waste no time! Not only does this
very light player have an excellent suite
of features, but with its support for plug-
ins, it’s scalable to any level. The latest
version, Winamp 3.0 (currently in beta
stage), supports video playback, making
it a complete multimedia suite! There are
virtually thousands of plugins available

Must-have software for playing, encoding and managing audio and video on your PC

The Entertainers

Find it on the Mindware CD
under Software > Multimedia
Spinner 4.0, AudioCatalyst
2.1, Winamp 2.80, PowerDVD XP 4.0,
SmartRipper 2.41, aMPEG2Avi GUI 2.5
Beta 1, EasyDivX 0.82, TMPEGEnc
2.57.41.146, VCD Cutter 4.03, MUSIC-
MATCH Jukebox 7.2, eDonkey 6.1

insight ■
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for Winamp already, such as SqrSoft
Advanced Crossfading Output, which
ensures hours of uninterrupted music. It
automatically detects the end of an audio
stream and the beginning of the next
track on your playlist, and cuts out the
silence between them. The Gapless Audio
Output plugin also provides the same fea-
ture. With the MP3 Output plugin, you
can encode MP3 files directly from
Winamp, which means you don’t need a
separate tool for ripping CDs. The Out-
put Stacker plugin lets you use multiple
output plugins together. This is very use-
ful for a perfect audio experience, since
no single plugin has all the enhancement
features. Thus, you can mix the Cross-
fading Output plugin with the Direct-
Sound output plugin and save money on
a DJ at your next party. Or better still, use
the DJamp plugin that uses Microsoft
Agent and Text To Speech technology to
provide an animated talking DJ—when
Winamp finishes a song, DJamp displays
a character that says a few words before
playing the next song. The comments are
configurable and can be in sequence
or random.

Video for your PC
If you have a DVD player, get the Cyber-
Link PowerDVD XP (www.gocyberlink.com).

This is probably the most versatile DVD
player with a whole load of features. This
completely skinnable player supports
DTS Digital Surround Sound and Dolby
Pro Logic II to deliver the most rich and
lively 5.1 channel audio experience, even
if the original source was not encoded for
5.1 channel output. The evolved screen-
capture feature lets you save high-quali-
ty snapshots from video. PowerDVD XP
supports all current DVD formats such as
DVD Video, DVD Video Recording,
cDVD, miniDVD, etc. It can also play
back video files from DVD-ROM, DVD-

ROM/RW combo, DVD-RAM, DVD-R/RW
and DVD+RW drives. 

You can avail a whole suite of soft-
ware from www.afterdawn.com/software/,
especially cool utilities for ripping DVDs.
SmartRipper is a free DVD ripper that can
extract VOB files from DVDs. It comes
with an easy interface and automatically
detects and reads the DVD, calculates the
required drive space, splits VOB files per
chapter and more. It also displays statis -
tics such as length, size, and bitrates for
every chapter or selection. aMPEG2Avi
GUI is a great package for converting VOB
files to AVIs. It contains pretty much all
the software required for DVD to DivX

conversion from DVD rippers to bitrate
calculators.

EasyDivX (easydivx.does.it) is a free tool
that encodes AVI files using the DivX
codec. It supports DVD ripping and con-
version to DivX AVI, MP3 or AC-3, making
it a must-have for anyone who wants to rip
DVDs, store movies on the hard disk or
burn them on to CDs. 

For burning VCDs, you just need the

Enhance your movie experience with PowerDVD

DivX: an easy way to encode video 

SmartRipper rips DVDs to VOB files

MUSICMATCH Jukebox (www.musicmatch.
com) is a complete multimedia suite for all
your audio requirements. You can play, rip
and burn MP3s
and audio CDs,
and transfer
songs to MP3
players. It can
even record
from tapes!
mp3PRO
enhances the music quality in real-time.
The software supports creation of CD
labels and inlay cards with up to 150 track
titles. You can even broadcast your
playlist. The song catalogue and media
management features are probably the

best—Super Tagging gives you faster,
more accurate results for finding informa-
tion about your tracks. You get names of

your
favourite
artistes,
tracks and
albums, and
you can even
automatically
search and

tag your tracks in just one click. 
MUSICMATCH can keep track of all

your downloaded files by monitoring cer-
tain folders. You can now set up multiple
folders to synchronise with your music
library. 

MUSICMATCH Jukebox

The complete audio solution for your desktop

A codec (encoder-decoder) is an algorithm
used to compress and decompress a file.
Multimedia files in raw format are unman-
ageably huge. Unlike regular compression
algorithms, codecs compress a file, yet
allow them to be played back in regular
media players—the decoder is bundled
with the encoder, so the player simply
picks up the correct codec for decoding
the media file on the fly while it is playing.
Again, unlike compression algorithms,
codecs do not completely preserve the
original image, audio or video—some parts
of it are dropped to save space. Thus, as
more data is dropped, so is the quality and
file size. GIF and JPEG are compression
algorithms for bitmap images. There are
several codecs for audio and video, but the
best ones are MP3 (MPEG II Layer 3) for
audio and DivX (www.divx.com) for video.
These afford the highest quality playback
with compression ratios averaging around
10:1 (a 10 MB raw file can be compressed
to a 1 MB encoded file without much
noticeable loss in quality).

Anatomy of Codecs
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movie in MPEG-1 format. For this you can
use TMPGEnc (www.tmpgenc.net), a free tool
that converts almost any movie to this
format by just selecting the input file and
one of the available templates that has
default settings for the kind of output
file. The conversion speed depends on
the PC configuration, the movie length
and frame complexity. Almost any CD
burning software can burn the MPEG-1
file to a VCD that can be played on stan-
dard VCD players. Nero Burning ROM
(www.nero.com) is one of the best CD writ-
ing applications around. Launch the soft-
ware and a wizard guides you through
the CD creation process in just a few
clicks. Select VideoCD as the CD type,
drag the movie file into the project and
Nero will take care of the rest.

Ripping VCDs is a different ball game.
VCD Cutter (www.seller-club.com/~vcdcut/)
saves the entire movie or parts of it on the
hard disk and scales the movie size. It can
also save just the movie audio or merge a
video source (M1V file) with an audio
source (MP3 file). It has a built-in AVI to
MPEG converter

Get a hold of these cool applications
and turn your PC into a complete enter-
tainment studio. You needn’t look too far;
most of these are on the Mindware CD
accompanying this issue.

VEER KOTHARI

A relatively recent development, P2P
tools allow you to share music, videos
and other files over the Internet. eDonkey
(www.edonkey.com) is one such network
with millions of users worldwide. The
network monitors media across all sub-

scribers, so all you need to do is install a
client, search for what you want, select
one from the results and download it.
The file will be downloaded directly from
the person who has it. This is extremely
convenient and fast, since files don’t
need to be hosted on an Internet server
first and the software unobtrusively
downloads files in the background.

Sharing Media

Peer-to-peer file-sharing with eDonkey

VCD Cutter outputs MPEG files from VCDs

Encoding movies with TMPGEnc 

1/2 page H. AD
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The screen fills with the image of
the cars lined up at the start line.
A heavy silence hangs in the air.
only to be shattered suddenly by

a shrill whistle and the screech of tires as
the cars zip down the street, going from
zero to 100 kmph in less than 5 seconds.
Your hand freezes on its way to the pop-
corn bag and the hair rises at the back of
your neck as the room reverberates with
the sound coming at you from different
directions.

No, you are not sitting in a movie the-
atre with Dolby Digital sound. You are
lounging in a chair in your room, with
your feet propped up on the desk, watch-
ing The Fast and the Furious…on your PC!
Surprised? Don’t be. It’s easy to set up a
home theatre system on your PC. The
most critical component of a home the-
atre system is surround sound and you can
set that up for less than Rs 10,000.

Even if you are not a movie buff, a
killer sound system on your PC could give
you that extra edge in games by allowing
you to hear an enemy sneaking up behind
you or simply rendering crystal clear 
MP3 playback with all the finer nuances
audible.

What do you need?
Most PCs only come with stereo support
in their audio system and though this is
sufficient for general computer usage,
the entire effect of today’s DVD
movies and games that fea-
ture surround sound
audio tracks would be
lost in a convention-
al stereo setup.
Therefore, you
would need to add
some form 
of surround sound

equipment to your PC. Each of these
components plays a very specific role in
bringing you an overall surround sound
experience. 
Multi-channel soundcard: The
majority of soundcards today can handle
only two channels of sound (stereo).
However, to experience surround sound,
the audio should come at you from all
directions, not just in front of you. There-
fore, at its most basic level you would

need a soundcard that can output
at least four channels of

audio—two front chan-
nels (left and right) and
two rear channels (left

and right). 
The soundcard of choice

here is the Sound Blaster Live! 5.1
DE. It also features EAX which will
enhance your gaming experience as well.
With its proven audio performance, this

Let your senses reel. Set up surround sound on your PC for under Rs 10,000 
for that immersive home theatre experience

insight ■
■ workshop

Sound Blaster
Live! 5.1 DE:
Fidelity with value

IMAGING: Swaroop Biswas PHOTOGRAPH : Mexy Xavier
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Dolby Digital-capable soundcard is quite
affordable and is ideal for movies that
include surround sound.
Price: Rs 2,610
Multi-channel speaker system: The
next thing you need is a multi-channel
speaker system that can render surround
sound. The more powerful your speaker sys -
tem, the more profound will be your audio
experience. Multi-channel speakers can be
as costly as you want them to be. However,
a good place to start is with a simple four-
channel satellite-subwoofer system. These
speakers are priced very affordably nowa-
days and have adequate power for deliver-
ing a good movie-watching experience in
an average-sized 15x20 feet room.

We chose the Artis S880 for its power
and great overall performance at a good
price. With very good results in the movie
playback tests, the surround positioning
and definition was great with this speaker
system. It also sports good frequency
response, making it very suited to music
playback as well.
Price: Rs 4,000

DVD-ROM drive: This is the compo-
nent that will allow you to play back
high-quality movies that contain sur-
round sound information such as Dolby
Digital, Dolby Surround and DTS.
Besides, the visual quality of DVDs is far
sharper because of the native resolution
support of 720x480 compared to the sig-
nificantly lower resolution of 320x240
supported by VCDs. 

Sporting a cool slot-loading disk inter-
face, the BenQ 1648A is a 16x DVD drive
with a 48x CD read speed. It boasts of very
impressive performance—with an average

access speed of 85 ms and a data transfer
speed of over 21 MBps when reading
DVDs, this drive will get you through the
most demanding applications. It has sup-
port for a wide array of DVD standards,
ensuring that you won’t have a problem
reading even DVD-R disks.
Price: Rs 3,300
19-inch monitor (optional): If your
budget allows it, consider getting a large-
screen monitor. This would  make your
home theatre experience complete. 

The Samsung 995DF flat-screen 19-
inch monitor is capable of a flicker-free
resolution of up to 1280x1024 at 80 Hz.

To get the best out of your home theatre
system, place the left and right speakers
along the width of your room. From where
you are going to be sitting, the front speak-
ers should be approximately 60 degrees
apart from each other with the listener at

the reference central position. The rear
speakers should form a 110 degree angle
from this reference position. For optimum
effect, the four speakers should be kept at
or slightly above ear level. You can place
the subwoofer anywhere. If you find that

the bass in your system is a little
low, place the subwoofer facing a
wall, preferably in the corner of
the room. If the surround sound
channels are too faint, ‘toe-in’ the
surround speakers such that they
point toward the listener. Con-
versely, if they are too prominent,
place them facing the wall as this
helps disperse the sound from
the rear channels, resulting in a
more enveloping effect.

Artis S880: Experience immersive surround sound

Optimum Speaker Placement for a 
Conventional Home Theatre System

1 col Strip

BenQ 1648A: Great for movies
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The INVAR coating ensures that you do
not get eyestrain while sitting through
even three-hour DVDs. And the good
news is that it is one of the lower priced
monitors in its size category.
Price: Rs 21,000

Getting it all together
Once you have the tools for enabling
surround sound on your PC, the next
thing is to grab a screw-
driver—we need to get
under the hood of your
computer!
Install and configure
the soundcard: Find a
vacant PCI slot on your
motherboard and insert
the soundcard, taking
care to exert even pres-
sure along the entire
soundcard. Now start up
your computer; Windows
will find the new sound-
card as it loads up. Keep
the soundcard’s driver
CD handy and insert it
into the DVD drive (or
CD-ROM drive) when
prompted. Your sound-
card will get detected and
the drivers will be
installed by the system.

To enable true four-channel
sound in your system, you will
need to set your soundcard’s con-
figuration to recognise four chan-
nels instead of the default two
channels. Right-click on the speak-
er icon in the system tray and
select Adjust Audio Properties > Advanced
Properties for Playback . From the Speaker
Setup drop-down list, select Quadro-

phonic Speakers.
Connect and place the
speakers: A four-point
surround speaker set will
have four satellite speak-
ers and one subwoofer.
Therefore, these speakers
will have four inputs—
two for the front speakers
(left and right) and two
for the rear (left and
right) that will have to be
connected to your sound-
card. The satellites will be
connected to the sub-
woofer itself. First place
the front speakers on
either side of your moni-
tor. Then, place the rear
speakers behind you.

Connect the 3.5 mm
stereo jack from the
Front Out of your sound-

card to the Front In on the subwoofer,
and the Rear Out from your soundcard to
the Rear In on the subwoofer. Finally,
connect the front speakers to the Front
channel output on the subwoofer and
the rear speakers to the Rear channel
output. The front/back, left/right chan-
nels would be clearly indicated on the
subwoofer.
Calibrate the speakers: If your speak-
ers are not running at the optimum signal
levels, you will either hear distortion due
to a high signal level or the volume would
be too low with some channels during
playback.

Until not too long ago, surround sound on
your computer meant four-point surround.
Soundcards that offered two front and two
rear stereo outputs were the de fecto stan-
dard for budget home theater computer sys-
tems as they were cheap and adequately
placed audio around the listener.

Today, thanks to standards such as Dolby
Digital and DTS (Digital Theatre System),
you have fully compliant six-channel sound-

cards that can decode Dolby Digital audio
streams. The best part is that these cards are
now available for outrageously low prices,
bringing home theatre to your PC. This
includes cards like Creative’s SoundBlaster
Live! 5.1 DE, which is available for just a cou-
ple of hundred rupees more than its four-
channel counterpart. This new breed of
cards features six descrete channels of sound
output and the job of decoding the Dolby

Digital audio stream is done onboard instead
of by the system’s processor. They also fea-
ture pass-through functionality where the
Dolby Digital audio signal can be passed
onto an external decoder as well, if neces-
sary. What’s more, sound subsystems on
motherboards such as those based on the
nForce chipset already exhibit full Dolby Dig-
ital compliance. This has effectivley raised
the bar on the audio subsystems on PCs.

Say Goodbye to Stereo

1. Insert the soundcard into a vacant
PCI slot
2. Connect the satellite speakers to the
subwoofer
3. Connect the speakers to your
soundcard’s front and rear outputs 
4. Finally, connect the soundcard to the
subwoofer

2

3

4

Every multi-channel
soundcard bundles its own
dedicated application that
lets you test the various
channels and configure it
for optimum surround
sound playback. Creative
soundcards have an appli-
cation through which you
can verify if all your chan-
nels are properly function-
ing. Through this applica-
tion, you can also set the
levels of these channels so
that you have balanced
audio from each of the
speakers in your surround
sound system.

Tweak to 
Perfection

1
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To set up the levels, first
lower the volume of the speak -
ers to the mid level from the
Windows Volume control on
the task bar. Keep the bass and
treble settings on Windows and
on the speakers (if present) at
their mid positions. Next, raise
the Master volume control on
the speakers to about 70 per
cent of the maximum position.
Now play an audio track
(preferably use a loud rhythmic
track) and adjust the bass and
treble settings to a level that
you like. Increase the Master
volume control in Windows
until it is playing at the loudest
possible without any audible
distortion—ensure that the
bass is defined and the treble is
sharp. Your speaker system is
now playing at its maximum

safe volume level and this is your speaker’s upper limit. Keep
this Windows volume control level fixed. To subsequently
change the volume settings, use only the master volume control
on your speakers.
Install the DVD drive: If you already have a CD-ROM drive
in your system, you would need to replace this with your new
DVD drive—a DVD drive can be used to read CDs as well and
therefore having a CD-ROM together with a DVD drive is useless.
To remove the CD-ROM drive, unplug the IDE cable and power
connector from the rear of the drive and then unscrew the drive
from the bay.

Otherwise, install the DVD drive into a vacant 5.25-inch drive
bay in your system cabinet. Screw in the drive securely. Plug the
power cable to the drive and finally connect the IDE cable from
the drive to the IDE channel on your motherboard. If you have

only one hard disk in your
system, you should connect
the DVD drive as the sec -
ondary master IDE device in
your system for better DVD
and CD performance.
Install the DVD play-
back software: You will
now have to install a soft -
ware DVD player that will
be used to playback your
DVD movies. This will let
you hear the surround
sound audio in your DVD

movies. We recommend PowerDVD XP 4.0. Access the configu-
ration menu by right-clicking on the PowerDVD screen. In the
Audio section, select the Audio Output to Four Channel from the
drop-down menu.

Now that you’ve installed and configured the various com-
ponents of your surround sound system, all that’s left is for you
to grab a bowl of popcorn and get ready to enjoy your favourite
film on DVD.

MARCO D’SOUZA

1/2 page
V. AD

Besides support for Dolby
Digital, PowerDVD also
features support for Dolby
Headphone, which simu-
lates the effect of surround
sound speakers on a con-
ventional pair of head-
phones. There are addi-
tional tweaks in PowerDVD
to enhance audio playback
depending on your envi-
ronment (quiet, normal
and noisy) and there is
also support for the LFE
(Low Frequency Effects)
channel which gives you
room-shaking bass, if your
speakers are up to it.

Dolby Digital
on the go

PowerDVD: Surround yourself in sound
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T
he Internet has changed our lives irreversibly. It has given us new
avenues to gather information on everything from politics to reli -
gion, sports and gardening. It has brought our family and friends
closer together and connected us across all corners of the world. But
more importantly, it has kept us talking—with people we know and

with those we don’t. With the ones we love and the ones we love to hate. 
But there is a darker side to the innovation: viruses that bug us every day,

asinine ads that put a strain on the already miniscule bandwidth, e-mail and
message spamming that clog our mailboxes and Denial of Service attacks that
are a corporate headache, to name just a few. We take a look at the top 10 annoy-
ances that drain billions of dollars of hard-earned currency every year. Come
meet the Net Nasties. 

AHMED SHAIKH

The Internet is the best thing that ever happened to those 
who like to stay connected. But every Jekyll has a Hyde…

SEPTEMBER 2002

Net Nasties

insight ■



SEPTEMBER 200299

MAIL ATTACHMENTS
Less is more
E-mail attachments are not only
an essential part of daily com-
munication but also a source of
fun and amusement. Remember
the document with jokes that

had you in stitches for hours? Or the spread-
sheet-based quiz that passed a cool 20 min-
utes of an otherwise mundane day? And sure-
ly the important presentation to your boss
could not have gone as smoothly if you were
not able to mail yourself that 200 KB Power-
Point slide! The fun ends when the e-mail
attachments grow bigger though. Attach-
ments that exceed 1 MB in size are not
unheard of. And this is where things take a
frustrating turn. If you know that the large
attachment in question is important, then you
grit your teeth and bear the agony of down-
loading it. But what if the source of the file is
unknown? Is it something essential? Could it
be a virus? Perhaps another one of those stu-
pid ads? A prank? You will never know until
you download and open the attachment. And
heaven help you if you are stuck on a dial-up
line! 

Most e-mail clients offer options to filter
your mail. This feature lets you sort mail on
the basis of the size of the incoming mail. You
can also reject mail that exceeds a particular
size limit. The latter option is the best, albeit
a risky means to escape large attachments. If
you go for this option, remember to turn off
the filter when you are expecting a large and
important e-mail. A safer alternative is to set
up a Web-based account. The nature of such
services means that you need not download
an attachment to your computer until you are
absolutely certain of its content. Some Web-
based services also offer a nifty preview mode
that lets you take a peek inside an attachment
before you decide to junk it.

PORN
Sex sells
Even if you do not buy the above truism, you can do lit -
tle to escape the inevitable: pornographic material is as
ubiquitous on the Internet as oxygen is in the offline
world. And like air, adult content essentially keeps a lot of
people alive by raking in the much-needed money. There

is no avoiding porn; it will not go away anytime soon, or anytime at
all. If it offends your sensibilities, all you can do is take precaution-
ary steps. Almost any Web-browser lets you turn off images and ani -
mations. Use this feature if you are browsing a site that hosts adult
images and banner ads. A lot of advertisements touting sex take the
form of popup and pop-under ads. These can be eradicated as
explained in Net Nasty 4. Newsletters and mailing lists can also be a
source of pornographic material. If you do not know whether a par-
ticular service is guilty of such practices, create a public e-mail
account and use that to ascertain the facts. Remember that these
steps will only reduce an encounter with pornographic content and
not eliminate it all together.

SPYWARE
You are being watched
Chances are that one of the pro -
grams that you gleefully installed the
other day is spyware. A spyware is a
program that offers you services such
as a funky toolbar for your favourite

browser, then promptly and secretly steals your
personal details! It has been known to collect
information ranging from your browsing habits

such as the Web sites you frequently
visit and the ads you often click on, to
your credit card details. It then sells this
vital knowledge to interested parties for
a healthy exchange of money. It is a sad
state of affairs and things will only get
worse. But there is a respite in the guise
of software programs that scan your
computer system to identify spyware
and help you banish them. One such
program, perhaps the best of the lot, is
called Ad-Aware (www.lavasoftusa.com).

The World Wide Web came of age in the year 1996. Web sites then were crude rudimentary creations with bad
colour choices, pathetic navigational solutions and poor programming. People were still learning the ropes and
things were expected to get better. 

Six years down the line, poorly designed Web sites still form a rather large percentage of the online world. Let
it be known that blue text on a black background isn’t retina friendly. And do all those images need to be 500 KB? Mr Program-
mer, will you please read the W3C (the World Wide Web Consortium) recommendations so that your elite Web site displays like
it should on my Mozilla browser? Get with it people!

POORLY DESIGNED WEB SITES
Aaarrgh! It’s hurting my eyes!

According
to a conser-

vative estimate,
there are a
total of 927
spyware pro -
grams out
there, a majori-
ty of them
being Peer-to-
Peer services
such as KaZaA

SpamNet, AntiVir, Pop-Up
Stopper, Ad-Aware
Find it in Software > Internet
on the Mindware CD



POPUP ADS
In your face and painful
Ever since the Internet caught the media’s attention, the
fact that it reaches a large and varied segment of people
caught every marketing department’s eye and banner
ads were born. The logic was simple—if they put ads on
a Web page, surely the people would be interested and

click on them. This led to bigger and more eye-catching ads and soon
there were animated ads that played sound effects and music. This is
where things began to go woefully wrong and increasingly irritating.
What followed was the popup ad: a devious ploy to get the attention
of users who were obviously giving no love to the ad makers. These
nasties pop up and out of a Web site, and the ads themselves run the
gamut of stupidity. 

Two worthy competitors to Microsoft’s Internet Explorer (IE)
browser have elegant solutions that help put these ads where the
sun don’t shine. The latest version of both Opera and Mozilla fea-
ture ways to prevent ads, but if you prefer to stick with IE and not
jump browsers, then Pop-Up Stopper (www.panicware.com) will take
care of just such a need.

SPAM
You’ve got
spam!
It is a beautiful
morning, one of
those days when you
feel that you can

conquer the world. You take care
of your chores, open your mail-
box and out flood messages that
promise a free trip to Hawaii, a
better love-life and other such
mails that overwhelm both your
senses and your computer system.
You have been spammed. What
are you going to do about it? 

There are certain practices
that help reduce the amount of
spam you receive—they vary in
effectiveness and ease of use. The
first thing to do is to create two 
e-mail IDs: a personal one for
friends, family and colleagues,
and a second public ID for the
rest of the online world. Services
that require your e-mail address,
such as newsletters or message-
boards, should be given the pub-
lic mail ID.

A second option is the filter
offered by most e-mail clients and
services. These let you sort your
inbound mail according to the
address of the mail sender, direct-
ing the mail sent by someone on
your address book into a separate
folder, while another folder holds
the mail that has originated from
an unknown source.

Finally, there are software solu-
tions such as
SpamNet (www.cloud-
mark.com) that protect
you against 80 per
cent of spam. These
work on the strength
of blacklists: databas-
es that contain
addresses that are
known to generate
spam mail. These
services are largely
effective but have
been known to slip-
up occasionally and
block a valid e-mail.

Nevertheless, a combination of all
three solutions can be formidable,
reducing spam to a number close
to, if not quite zero.

VIRUSES
They’re out to get you!
Just like their biological counterparts, computer viruses are
malicious, destructive and unwelcome. Anything from that
innocuous little file, to the floppy that your best friend lent
you could carry one of these miscreants. They infect and
destroy everything including the boot sector of your system,

your documents, your precious e-mails and operating system essentials.
Like their biological cousins, they mutate and propagate, making them dif-
ficult to track and kill. And just as thousands of years of progress hasn’t rid
the world of the common cold virus, computer viruses are also here to stay
and will remain a rather large and irritating thorn in our sides. Moreover,
as the sands of progress seep into every nook and cranny of our lives, the
havoc wreaked by viruses will only increase manifold. A virus is indiscrim-
inating by nature—your cell-phone or the PDA are equally susceptible to it.
The omnipresence of computer viruses has made anti-virus solutions an
integral part of every computer user’s life. Such software is largely preven-
tive in nature, snipping a virus in the bud and monitoring your system for

possible attacks. So, even though the software takes
up precious system resources, ensure that it is
always running on your computer and is monitor-
ing it. Anti-virus software track down malevolent
viruses using a database that lists all identified virus-
es and the means to remove them. This list is fre-
quently updated and in order to ensure maximum
protection, it is vital that you update the software at
least once every month. 

And beware of floppies! They are infamous for
spreading viruses and their ilk. Before using a flop-
py, ensure that you have scanned its contents—
more so, if you plan to boot from it. Extend the
same preventive measure to e-mail attachments and
to unknown macros. Whenever you doubt the
nature of a file, or your system seems to act unnatu-
rally, run a virus scan.

According to
the research
company Com-
puter Economics,
the Code Red
virus caused dam-
ages worth about
$2.6 billion in the
year 2001. The
same research
group estimated
the Love Bug to
have caused dam-
ages worth a
colossal $10 bil-
lion worldwide

According to
analyst Jupiter
Media Metrix,
each e-mail user
in the US
received an esti-
mated 595 spam
e-mails in 2001.
The number is
expected to rise
to 1,671 by the
year 2006
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LACK OF FREE SERVICES
The first one is free
The past few years have seen a dramatic decrease in
the number and the quality of free services being
offered. Big names like Yahoo! are now charging
money for solutions that were not-so-long-ago free,
even as they discontinue other free features in their

services. Taking candy from a baby wouldn’t hurt so much if the
sweet wasn’t offered in the first place. The fact is that we have tast-
ed blood and nothing else comes close—the only comfort is the
services that are left.

For e-mail services there is always Yahoo!, MSN and Indiatimes
to turn to. But if you are looking for something a little more fea-
ture-filled, then we have two such services for you—the first one
is OutGun.com (www.outgun.com). It offers a cool 10 MB of inbox
space along with extras such as a calendar, a file manager, a file-
sharing feature and a place for all your favourite bookmarks. The
other service is MyRealbox (www.myrealbox.com), which too offers
a generous 10 MB of space. It also features effective anti-spam and
anti-virus capabilities, an address book and a calendar service. The
most attractive feature of MyRealbox is its support for Internet
protocols such as SMTP, IMAP, POP, LDAP, HTML, SSL and TLS.
You can thus receive e-mail from a variety of clients such as
Microsoft Outlook/Outlook Express, Netscape Communicator,
Qualcomm Eudora, Novell GroupWise and more.

If you want to create your own Web page and share it with the
rest of the world for free, then give Brinkster (www.brinkster.com) a
try. It’s ad-free, supports ASP and Flash, and offers 30 MB of space
for your creation. And it makes file syncing a breeze with its Web-
based file manager. Or try Crosswinds.Net (www.crosswinds.net),
which offers unlimited space and Web-based e-mail, but at the
cost of banner ads. 

Yahoo! Briefcase is a service worth mentioning for sharing files
online. It offers a sufficient, if not a comfortable 30 MB of Web
space and if you use its mail service, you can save mail attach -
ments directly to your Briefcase.

INFRASTRUCTURE 
IN INDIA
Promises and lies
By now, we should’ve been
receiving moving pictures,
streaming music and up-to-the-
minute news broadcasts over the

Internet—at least in theory. The multimedia
heaven that was promised is still far away. So
what happened? Blame it on bandwidth or
rather, the lack of it. Still damned to surf over
modems that offer a piddly 5 to 6 KBps of
download speed, the majority of us are forced
to remain content with text and ads that fea-
ture animated monkeys. Then there are the
backbreaking charges levied by both, the
phone company and the ISP. And it’s not as if
a dial-up service is reliable either—a little driz-
zle can herald the death of your phone line at
worst or a noisy connection (leading to data
loss) at best. The so-called ‘broadband’ serv-
ices are here, but the affordable ones offer
only 30 to 40 Kbps of speed. The ones that
offer a decent 1 to 2 Mbps of speed charge an
arm and a leg. 

If you plan to subscribe to such a service,
ask for a trial to ensure that it delivers a speed
that you find satisfying. Make sure that you
test it at a location as close to your place as
possible. If you cannot get a broadband serv-
ice, then your best bet is a download utility
such as FlashGet (www.flashget.com) or
GetRight (www.getright.com). Such a utility will
not speed up your browsing but will help you
download large files and lessen the pain of a
dial-up connection.

PEOPLE
Hell is other people
There will always be those who will take advantage of the
anonymity of the online world. They are the ones who
will write the most destructive virus, just because they can.
They will bring down your corporate Web site, just because
they fancy it. As a matter of fact, they are the fountainhead

from which springs all the Net Nasties. Sadly, there is no escaping them.
And then there are the mischief makers who hang around your

favourite online forum, eager to derail and spoil a heated discussion.
Known as ‘Trolls’, they indulge in anti-social activities that range from
spamming a fellow forum-user, to posting offensive messages and
images. The social nature of the Internet makes running into these pests
a very likely event. 

What can you do? Absolutely nothing. What you can take solace in
is that these form a minority. After all, the most interesting aspect of the
online world is the interaction between you and the rest of humanity.
Realise that these Trolls do not own the Net and like a bad headache,
they too will go away if we ignore them! 

Kevin Mitnick, a 37-
year-old US resident
faced 25 charges
for a series of
attacks on systems
belonging to
software makers,
ISPs, and
educational
institutions such as
Netcom, Motorola,
Nokia, Fujitsu, Sun
Microsystems and
the University of
Southern California

Bringer of Bad News: If you
see this posted on a forum,
the topic of discussion is
already dead, courtesy your
friendly neighbourhood
forum Troll
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Have you ever wanted to copy a
song or a game from a friend, but
found it too small to burn on a

CD and too large to waste floppies on, so
ultimately downloaded it from the Net?
Or have you needed to work from home
and the only way to synchronise your
work with your office PC was via e-mail?
Here’s a way to share files across PCs with-
out an Internet connection. All you need
is a modem connected to a phone line on
each PC and they can be connected
directly to each other.

You can set up Windows 98 to
receive incoming dial-up connec-

tions by setting up Dial-Up Server on one

PC and Dial-Up Networking on the other.
Open Control Panel > Add/Remove Programs >
Windows Setup. Select Communications and
click Details. Check the box next to Dial-
Up Server and click OK. You will need the
Windows 98 installation CD for the files
to be copied. Once installed, you can con-
figure the machine for incoming connec-
tions from Start > Programs > Accessories > Com-
munications > Dial-Up Networking . Here, open
Dial-Up Server from the Communications
menu and enable Allow Caller Access.
You may assign a password by clicking the
Change Password button. 

Next, you need to configure TCP/IP
on both machines for them to be

able to communicate with each other.
First, set the IP address on the server (the
machine that will receive the calls). Open
Control Panel > Network , select TCP/IP > Dial-Up
Adapter and click Properties. Select ‘Speci-
fy an IP address’ and enter the IP address
and Subnet mask. You can enter 192.168.0.1
as the IP address and 255.255.255.0 for the
subnet. Note that you will need to reset it
to ‘Obtain an IP address automatically’ if
you want to make dial-up connections
(for example, to your ISP) from this
machine. On clicking OK, you will be
asked to restart the machine.

To set up the client machine, open
Dial-Up Networking from Start > Pro-

grams > Accessories > Communications. Create a
new connection with default settings,
entering the phone number of the line
connected to the server. Once the con-
nection is created, right-click it and click
Properties. Under the Server Types tab,
disable ‘Log on to network’, click TCP/IP
Settings and again select ‘Specify an IP
address’. Enter an IP address for this
machine (e.g. 192.168.0.2) and click OK. In
this case the IP address has been specified
only for this connection, so other dial-up

connections will work just fine without
having to change any settings.

To be able to share folders over a
dial-up connection, you will need

to have ‘File and printer sharing’ enabled.

This can be done from Control Panel > Net-
work. Simply double-click the connection
on the client and it will connect with the
server. The machine should be visible
from Network Neighborhood, but if you
can’t see it, you can browse the shared
resource by using its IP address. For exam-
ple, you can access a shared folder called
‘share’ on the server by typing
\\192.168.0.1\share in the Windows Explor-
er address bar. Another way to access the
machine is from Start > Find > Computer —
again, you have to enter the IP address
here.

You can even set up remote 
desktop management software 

on the server and have complete 
control over it from the client. We will
use a software called RemotelyAnywhere 
(www.remotelyanywhere.com)—this is com-
pletely TCP/IP based and works off a
Web browser. When installing the soft-
ware, you can configure which ports it
should use for HTTP (for remote con-
trol), Telnet and SSH. You can leave all
settings to default (HTTP is on port
2000). After connecting from the client
machine, open up a Web browser and
go to http://192.168.0.1:2000/. This will open
up the RemotelyAnywhere screen from
where you can manage all files, system
settings and even control the remote
desktop as if it were the local
machine.

VEER KOTHARI

RemotelyAnywhere 4.51.298
Find it in Software > Home
on the Mindware CD

Enable Dial-Up Server to receive incoming
modem connections

Configure TCP/IP settings on the Client

These software let you connect to
another machine over dial-up, LAN or
similar connections and use it as if it
were your PC. Some of the most popu-
lar software are Virtual Network Com-
puting (www.uk.research.att.com/vnc),
pcAnywhere (www.symantec.com),
ControlIT (www.ca.com), Carbon Copy
(www.altiris.com) and Remote Admin-
istrator (www.radmin.com).

Remote Control Software
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Crashing Visual Basic
I seem to be having a very queer

problem. Whenever I work with Visual
Basic 6.0, I get the following error mes-
sage: “This program has performed an
illegal operation and will be shut
down. If the problem persists, contact
the program vendor. VB6 caused an
invalid page fault in module VB6.EXE
at 0167:004581f1.” 

I have thoroughly scanned my sys -
tem for viruses and also uninstalled
and reinstalled the application a num-
ber of times. Please tell me the cause of
this error and the solution.
Vaibhav Bhawsar
Bhopal 

Since you haven’t mentioned when
the program crashes, it will be difficult
to point out the exact cause of the error.
Visual Basic has many documented
bugs; monitor the program when you
are working with it and you will notice
a pattern of events every time it crash-
es—say, while using a particular ActiveX
control, an API (Application Program-
ming Interface), loading certain kinds of
images, etc. You can trace the cause of
the error from here and fix the required
component. The best solution is to
install the latest patches and Service
Pack. You can get Service Pack 3 at
http://www.microsoft.com/msdownload/vstudio/
full.asp . 

Relentless Me
Whenever I try to use Windows Me

Help, I get the error message, ‘The ini -
tialization of the Help Center failed’. I
tried reinstalling Windows Me, but to
no avail. Whenever I run MS Access XP
and some other programs, I get an error
message that reads, ‘ActiveX compo-
nent can’t create object’. Please advise.
Neil
Via e-mail

This can happen if the Help and Sup-
port Center in Windows Me is not prop-
erly configured because the Windows
Management Instrumentation (WMI)
Setup failed. Open the command

Uninstalling Linux, converting videotapes to VCDs, sharing Internet connections, synchronising e-mail
across PCs—find all your answers here

Repairing Windows XP 
I have Windows 98 and Windows XP

installed on different partitions. I was play-
ing a game on XP when suddenly the
lights went out. Since then, the Start
Menu and taskbar just don’t appear. Now
I have to open Task Manager every time
I want to start an application. Please
suggest a way to get the taskbar back
without re-installing Windows.
Harsh
Via e-mail

This can happen if the
Windows settings for one or
more user accounts are cor-
rupted. The simplest way to solve
this would be to repair Windows XP. Run the installation

from the Windows XP installation disc and
choose ‘Repair the existing installation’. The
repair option will only replace Windows
files, leaving all other programs intact.

You can also get around the problem by
creating a new user account. Press [F8] as

Windows XP starts booting and select Safe
Mode on the Windows Advanced Options

menu. When prompted to select which operating
system to start, select Microsoft Windows XP. Choose

Administrator as the user and enter the administrator
password. Click Start, right-click My Computer and click

Manage. You can create a new user under Local Users
and Groups. Restart Windows normally and log on as

the new user. This should solve the problem, but you
may need to reinstall some of the programs and copy

data such as documents from the My Documents folder or 
e-mail from the old user account.

ILLUSTRATIONS : Mahesh Benkar
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prompt from Start > Programs > Accessories
> MS-DOS Prompt. Type the following
commands (assuming C:\Windows is
where Windows is installed):

cd c:\windows\system
copy regsvr32.exe wbem
cd wbem
for %%f in (*.dll) do regsvr32 /s %%f
winmgmt /regserver
exit
This will register the WMI compo-

nents and you should not get the errors
henceforth. The Access error could hap-
pen due to a number of reasons but is
most probably due to a corrupted or
inaccessible file. Try repairing the Office
XP installation or entirely removing and
reinstalling it from Control Panel >
Add/Remove Programs.

CD-ROM not detected
My system has a 466 MHz Celeron

processor with 256 MB RAM. I have a 
17 GB hard disk as primary master, a
CD-Writer as secondary master and a
48x CD-ROM drive as secondary slave.
Once in a while, when I use the Auto
Detect HDD option from the BIOS, all
the drives are detected and work fine,
but later the CD-ROM drive is not avail-
able through Windows. Two or three
boots later the BIOS fails to detect it, giv-
ing an error: ‘ATAPI Error, secondary
slave incompatible. Press F1 to continue’.
The Auto Detect function in the BIOS
does not work either. When I asked 
a technician to look at it, he said that
there was a problem with the lens. 
I got the lens changed, but the problem 
persists. 
Hrishikesh Thite
Via e-mail

You haven’t mentioned what version
of Windows you are running. However,
there are a few things you can try, assum-
ing that all the jumpers are set according
to the instructions on the drives. First, try
switching the IDE channels. Set the CD-
ROM drive to primary slave, or set the
CD-Writer to secondary slave and the
CD-ROM drive to secondary master. If
this does not help, revert to the current
configuration and set the secondary slave
as ‘None’ in the BIOS. Reboot to Win-
dows and see if it detects the drive.

Access denied
I use WinZip and have password-

protected certain archives but have for-
gotten the password to a very important

file. Can it be retrieved by any means?
Deep Choudhury
Via e-mail

There are some tools to recover pass-
words from archives, but none of these
are free. Some use dictionary-based pass-
word recovery techniques (trying vari-
ous possibilities from a predefined list),
others use brute force to crack the pass-
word (trying every possible combination

of characters). You can try out Zip Key
from www.lostpassword.com. 

Printer setup
I had an assembled PC running

Windows Me and a dot matrix printer
TVS-E Novo 130. With this, I was able
to change the page setup as I wanted.
Now I have bought a Compaq Presario
700 laptop, with Windows XP as the
OS. I installed Office XP and the same
printer on this laptop. When working
with Excel, I am not able to change the
page setup to 9x6 inches. It provides me
with some odd paper sizes, which are of
no use to me. Please help me.
Kamal
Kolkatta

The available paper sizes are just a
function of the printer driver. You can
download the latest drivers for the
printer from http://www.tvs-e.com/products/
novo130.html, or try using different dot
matrix drivers for the printer from the
Windows XP list of printers (Control Panel
> Printers > Add Printer).

VHS to VCD
I have a Pentium 4 1.6 GHz proces-

sor with a 32 MB Riva TNT2 M64
graphics card, a 40 GB hard disk and 
a Sony 24x10x40x CD-Writer. Can I use
my PC for VHS to VCD conversion with
a VCR as input? What will I need to do
this? What will be the procedure?
Dhande Yogesh
Via e-mail

Your system is adequate for process-
ing video—all you need is a video cap-
ture card. There are several available,
such as the ones from PixelView, Adcom
and Tekram, all under Rs 3,500. Just
install the card, connect it to your VCR
and record the video using the bundled
software. For converting the movie to
VCD, you will have to encode it in
MPEG-1 format. Any standard CD burn-
ing software will be able to burn this to
a VCD.

Internet sharing
We use seven Celeron 700 MHz

machines with 64 MB RAM, networked
with Cat5 cables and the server has 
256 MB RAM with Windows 98 SE. A 56
Kbps external modem from this shares
the dial-up Internet connection on the
network using ICS (Internet Connection
Sharing). The clients do not open Web
pages fast enough. Please suggest how I
can improve the Internet speed.
Robert Larinawma
Aizawl

You can’t really expect very high
speeds on your connection since theo-
retically, you are sharing a speed of just
over 5 KBps across eight machines.
Thus, even if you are indeed getting the
full bandwidth from the connection,
each machine is getting only over 600
bytes per second, which is very slow.
You may want to use a better proxy serv-
er such as WinGate (www.wingate.com), by
which you can monitor the total band-

width to know
exactly how
much band-
width you are
receiving at dif-
ferent times of
the day. If you
are getting the
full 56 Kbps,
there’s not
much you can
do to improve
the speed,
except add a

modem to one of the machines and set
it up as a proxy server for half the 
network. 

Failing hard disk
Recently, my Windows did not boot

and showed a ‘VFAT Initialization
Error’. Scandisk fixed some errors and I
formatted the hard disk and reinstalled

Use Zip Key to recover passwords from zipped
archives

WinGate can log
bandwidth usage when
sharing an Internet
connection
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Windows. It boots properly now, but
the machine hangs often and Scandisk
regularly reports that drive C is showing
incorrect space. What is the actual
problem and how can I fix it?
Koushik
Via e-mail

The VFAT error occurs if the
ifshlp.sys file is missing or corrupted.
You can simply replace this file for
Windows to work. However, since
you’ve already fixed that, the new
problem looks like it’s related to the
hard disk. Run a thorough Scandisk
and repair any problems with the hard
disk, first from DOS, then from Win-
dows. The Scandisk that runs automati-
cally does not do a thorough check.
Once all the disk errors are fixed, so
should the problem.

No sound
I have recently installed a TV-Tuner

card with FM support, but when I con-
nect the sound cable from the Audio
Out on the TV-Tuner card to the Audio
In on the motherboard, I can’t hear any
sound. If I directly connect my speakers
to the Audio Out of the TV-Tuner card,

I can hear the sound. What could be
the problem?
Pradip Makwana
Via e-mail

The volume for the Line In for the
soundcard is probably set very low or
may even be muted. Double-click the
Volume icon on the taskbar to bring up
the Volume Controls. Click Properties
and enable all devices to be displayed
on the Volume Control. Look for
options such as Auxiliary, Line In or TV-

Tuner (depend-
ing on the
soundcard
installed) and
check the vol-
ume. Make sure
it is not set to
mute and raise
the volume
until you can
hear the sound.

Burning issues
I have a Pentium III 600 MHz sys-

tem running Windows 98. I use Nero to
burn VCDs, but these days I am facing a
peculiar problem. When the CD is

burnt to 100 per cent and the software
is writing the Lead Out, the CD-Writer
stops working, but sometimes it burns
successfully. I write the CDs at 8x. Is
this happening due to a software error
or is there a fault with the hardware?
Please help.
Deep Sanjay
Via e-mail

There could be several reasons for
the burn to fail. The media itself could
be a problem, especially since some CDs
burn well and others don’t. You can try
changing the CD-Rs to see if that helps.
It may also help to reboot the machine
once and turn off all other applications
before burning a CD. Also, ensure that

the burn settings are all correct. Do not
keep the compilation open when burn-
ing VCDs. Also, you may want to turn
off Simulation and enable the Burn-
Proof feature. Also try reducing the
burning speed. 

Inconsistent disks
I have a PC with an AMD Duron

800 MHz processor, 128 MB RAM, one
8.4 GB and one 1.2 GB hard disk. The
first disk has two partitions—the first
partition has Windows 98 and the sec-
ond partition has Linux. Recently, I
upgraded from Windows 98 to
Windows 2000 Professional. The instal-
lation went smoothly, but whenever I
start the machine, I get the following
error: ‘Checking File System on C:,
Type of File System is FAT32. One of
your disks needs to be checked for con-
sistency. You may cancel the disk
check, but it is strongly recommended
that you continue’. If I allow the disk
checking to continue, no problem is
found. This happens every time
though I shut down the system 
properly.
Vaibhav Sharma
Via e-mail

FAT32 on Linux
I have a Pentium III system with

128 MB SDRAM and a 20 GB Samsung
hard disk. I had three operating sys-
tems: Mandrake Linux 7.1, Windows
XP and Windows 98. Earlier I was able
to access all Windows partitions from
Linux, but I recently switched from
Mandrake to RedHat Linux 7.2. Now I
am not able to access the FAT32 parti-
tions. Is there any way to access these
in RedHat?
Ezhil
Via e-mail

Mounting a FAT32 filesystem
requires FAT32 support either in the
kernel or as a module. First, create a
mount point using the following com-
mand:

mkdir /mnt/windows
You can use the following com-

mand to mount the FAT32 partition
on Linux:

mount /dev/hda1 /mnt/windows
If this does not work, use this

mount command instead:
mount -t vfat /dev/hda1 /mnt/windows

You will now be able to access the
FAT32 partition from /mnt/windows/.
Note that here it is assumed that hda1 is
the FAT32 partition. Replace this with
the appropriate device ID on your sys-
tem. Instead of vfat as the module, you
can also use msdos , though in this case
you will lose out on FAT32 features
such as long filenames.

To mount the partition every time
the system boots, add its entry to the
/etc/fstab file in any text editor.

Enable Volume Control
for the Line In channel
on the soundcard

Finalise the CD and enable Burn-Proof when
writing VCDs with Nero
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Windows 2000 has much stricter
consistency checks on all hardware
devices than earlier versions of Win-
dows. It probably does not recognise the
Linux file system and thus shows the
inconsistency error. However, since it
also cannot read that partition at all, it
fortunately does not check it either—if
it did, it would try to fix it and your
Linux installation would be corrupted. 

SCSI interrupt error
I have a Dell PC with a Pentium 4

1.8 GHz processor, 512 MB RAM, a
GeForce3 TI200 graphics card and a
SoundBlaster Live! soundcard. The OS is
Windows XP. I would like to know how
to view the output from the PC on a TV

without using a TV Out card. Also, I
have a 16x CD-RW drive using a SCSI
card. However, I get an I/O interrupt
error during startup. Can this be
solved? Is there anyway of taking a
backup of the address book in Outlook
Express?
Manish Golder
Via e-mail

There are external TV Out boxes
using which you can connect the moni-
tor connector from the graphics card to
the TV. The SCSI card could be conflict-
ing with one of the PCI slots for a free
interrupt. It may be possible to get rid of
the interrupt error by changing the
BIOS settings. As the machine boots,

press the [Delete] key to enter the BIOS
setup. Under PnP/PCI configuration, set
the configuration settings to Auto and
enable PnP OS Installed. All devices
should now be assigned free interrupts
automatically and you should stop
receiving the error. To backup the 
Outlook Express address book, look for
*.wab files on your hard disk and 
copy them.

Uninstalling Linux 
A friend of mine installed Mandrake

Linux 8.2 on his PC, but later tried to
use an HP recovery CD to return to
Windows. The Linux installation was
on the only partition on the disk and
the recovery CD couldn’t work, as it
could no longer access this. I tried delet-
ing the partitions but was unsuccessful.
Kindly help me return to Windows.
Rahul Srinivasan
Via e-mail

You can boot to Linux, login as root
and use the Fdisk tool to delete the
Linux partitions. Alternatively, you can
boot using a Windows Startup disk and
use the DOS-based Fdisk. If you are
using the Linux Fdisk utility, you can
type m at the prompt to get help. Type p
to display partition information and
Type d to delete partitions, upon which
you will be prompted for the partition
number you want to delete. Delete all
Linux partitions one at a time. Type w
to commit the changes. Enter q to quit
Fdisk. Reboot the machine using a DOS
bootable disk and use the DOS Fdisk
tool to create FAT32 partitions. You will
have to restart after creating the
partitions and format them. From here,
you can use the HP Recovery CD or a
Windows installation disc to install
Windows.

Two PCs, one mailbox 
I use a desktop and a laptop for

accessing e-mail and need to synchro-

nise them often. I would like to have
all the e-mail in one place—move the
mail from my laptop to the desktop,
while maintaining the ones already
there. How is this possible? I use
Outlook Express 5 and Windows 98 SE
on both machines.
Michael Jeyabalan
Via e-mail

There is no direct way to do this in
Outlook Express, but there are a few
workarounds. The easiest thing to do
would be to create a new identity (File
> Identities > Add New Identity). Outlook
Express stores each identity’s mailbox
files in separate folders (in C:\
Windows\Application Data\Identities),
so to synchronise the laptop with the
desktop, you would have to simply
replace these files on the desktop PC.
However, switching identities can get
irritating over time. Another thing you
can do is create separate folders for 
e-mail from the laptop and, as above,
replace the files for these folders from
the laptop. Again, if you do not wish

to store the mail this way, you can use
these folders as temporary holders—
you can select all the e-mail in a folder
and simply drag them to the folder
where they are actually meant to 
be stored.

Dual booting Windows
I have an 8 GB hard disk with one

2 GB FAT partition and rest as an NTFS
partition. I had Windows NT 4.0
Workstation installed on drive C. Later
I installed Windows 95, now I can’t
boot to Windows NT. I no longer get
the option to start Windows NT as I
used to earlier. Is there any chance of
recovering it?
Nirav Patel
Via e-mail

The Windows NT Flex Boot Loader
has been overwritten by the Windows
95 installation, but don’t worry, 
it’s possible to restore this and have 
a dual-boot option. Boot the
computer using the Windows NT
Setup boot disk. You will soon be
prompted for Setup Disk 2. On the
setup options, press [R] to repair the
installation. You will now get four
repair options. Select the option to
Inspect Boot Sector and continue. 
The Windows NT Flex Boot Loader
will be restored on completing 
the repair. You may need to edit 
the c:\boot.ini file to include
information about the Windows 95
installation.

FAQs

Adding a new identity in Outlook Express

Send your computing
problems to
sos@jasubhai.com
or write to Digit, 

D-222/2, Om Sagar, MIDC, Nerul-400
706, and we may answer it here!
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thing special to
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Cut those every-day tasks in half with these simple and efficient solutions to some of the 
most common problems we all face at work
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I spend most of my
morning sorting through
heaps of mail and
newsletters.
Sorting through mountains
of mail is a morning ritual
for most of us, but the
process can be streamlined.
Both, Outlook and Outlook
Express, and most other 
e-mail clients, host powerful
automatic filtering features.
Called Mail Rules or Mail Fil-
ters, these tools determine
how to handle incoming
mail based on a few defined
parameters. They can sort
your mail depending upon
the sender—the newsletters
from ZDNetIndia.com will be
stored in a particular folder,
while all the spam mail from
spammers.com will be auto-
matically deleted.

To set up rules, click Tools
> Message Rules > Mail . Click
New to create a new rule.
Select the criteria (say,
‘Where the From line con-
tains people’) and click on

the criteria in the Rule
description box. Here you
can add the specific values
for the criteria (e.g.
zdnetindia.com). Similarly,
select the action for the rule
(Move it to the specified

folder), click the action item
in the Rule Description box
and enter its value. Enter a
name for the rule and you’re
done. You can even set up
multiple criteria and multi -
ple actions for rules.

One really cool utility
lets you separate the e-mail
you receive from a particular
account (say, company
account) from the rest. To do
this, set up the rule as ‘Where
the From line contains peo-
ple’ and enter the company’s
domain name (e.g. jasub-
hai.com). Click Options and
choose ‘Message does not
contain the people below’.
Set the action to move the
message to a specified folder
and choose a folder to store
the messages. Now your cor-
porate e-mail will come into
your Inbox and other mes-
sages will wait in the other
folder till you find the time
to sort them.

My boss asked me to
send this letter to all our
customers in Delhi. He
asked me to e-mail those
who have e-mail access. 
This task is very simple if
you have the list of cus-
tomers in a database.
Microsoft Excel is the easiest
to work with, so request your
database operator to give
you the list in Excel. Type
your letter in Word, leaving
blanks where the customer’s
information (name, for
example) should appear. In
Word, open Tools > Mail
Merge, and click Create > Form
Letters. Click Active Window
and then Get Data > Open
Data Source. Select the Excel

file and then edit the docu-
ment. The Mail Merge tool-
bar will automatically
appear. Click Insert Merge
Field to insert the customer’s
name. You can filter out the
residents in Delhi in the
Excel sheet itself, or when
extracting the list from the
original database or even
from the Mail Merge func-
tion itself. Once you’ve
added all the fields, click the
Mail Merge icon. Select
Merge to Printer and click

Query Options. Here, set the
criteria to select only the
people who don’t have 
e-mail addresses (select the
E-mail column under Field
and set the Comparison to
‘is blank’) and set the city to
Delhi if you want. Click
Merge to print all the letters.
Similarly, select Electronic
Mail in the ‘Merge to’
options and set the query to
pick up only the records that
have an e-mail address.
These can be sent automati-
cally via e-mail. Again, open
Tools > Mail Merge in Word.
This time select Create  >
Envelopes (or Mailing Labels).
Following the same process
as above, you can print
envelopes (or labels to stick
on the envelopes) for those
who will be receiving the
printed letter.

My temp who enters all
these forms into the data -
base is quite slow. He’s
probably never used
Access.
Give the data entry operator
a form on the screen that
looks similar to the form he’s
entering data from. In
Access, open the database

and click the Forms tab.
Click New and select Auto-
form: Columnar. Access will
automatically create a data
entry form that is linked to
the table. Once the form is
created, you can rearrange
the text fields to look exact-
ly like the paper form—just
drag the elements to the cor-
rect positions!

Every time I go out,
they just start surfing the
Internet. The other day
he was looking at… ugh!
The Internet can be an excel-
lent resource for research
and information; however, it
can also be a distraction,
bringing down productivity.
This can be controlled in
Internet Explorer without
having to install any addi-
tional programs. Open Con-
trol Panel > Internet Options .
Under the Content tab, click
Enable and enter a pass-
word—you will be asked for
this password every time you
modify the settings. Click
Settings to set up what sites

■ tips and tricks

Create rules for your mail

Filter data before merging it
with the document

Make Access user-friendly with
forms
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are allowed. Under Ratings,
you will notice that by
default the Content Advisor
does not allow any explicit
language, nudity, sex and
violence—sites that contain
such content will simply not
open. You can configure
these by adjusting the slider
for each item. Under the
Approved Sites tab, you can
enter a list of sites that are
always or never allowed.
Under the General tab, if you
disable ‘Users can see sites
that have no rating’, they will
not be able to open any site
that is not in the allowed list.
If you enable ‘Supervisor can
type a password to allow users
to view restricted content’,
every time a page that is not
allowed is loaded, the brows-
er will ask for a password.
Entering the correct password
will override the restrictions
and the page will load.

The last time I sent a
mailer, everyone com-
plained about the huge
attachment.
Attachments are usually
quite irritating, especially if
they are very large. Not only
does such e-mail take long to
download, it also holds up all
the other mail queued up
behind it. Most mailboxes
have only 2 to 5 MB of space;
hence it’s downright
thoughtless to send large files
that will bounce all the other
mail. Compressing docu -
ments and images using a
standard compression like
Zip is an easy solution. How-
ever, multimedia files cannot
be compressed much. Com-
pressing the files before 

sending them involves an
additional step, but most
compression tools such as
WinZip add shell extensions
(functions that are accessible
by right-clicking a file) that
make it unobtrusive.

We’ve got so many dif-
ferent kinds of customers.
How can I find all those
situated in Delhi?
If you have the list of clients
in Excel or can convert it to
Excel, simply click Data > Fil-
ter > AutoFilter . All column
headings will be converted to
drop down lists from where
you can filter the records to
any level. The drop down will

automatically pick up all
unique values in the column,
so click any value to see rows
that only have that value
(e.g. Delhi). The filtering is
additive: selecting values in
the various drop down lists
will apply all filters simulta-

neously. Click Custom and
set an advanced rule for fil-
tering. This is very powerful
with both, numbers and text.
You can return to the original
view by choosing All in the
drop down list box. If you are
using Access, you can simply
right-click a cell and select
Filter By Selection to filter the
column by that value, or
enter a value for the Filter For
box for a custom filter. 

I regularly need to send
e-mail to everyone in the
company.
If you send e-mail regularly to
the same people, create a
group for them in the address
book. If these names are
already present in your
address book, creating a group

is much simpler. Open up the
address book and click New >
New Group from the toolbar.
Enter a name for the group
and click Select Members.
Here, you can select all the
people you want included in
the group. When you want to
e-mail these people, enter the
name of the group instead of
the individual e-mail address-
es and the mail will be sent to
every member on the list.

I just switched from
Outlook Express to Out-
look. I have to type the
address every time I 
send a mail. In Outlook
Express, it used to come
automatically.
This is the most irritating part
for Outlook Express users
who migrate to Outlook. All
you have to do is type in a
part of the e-mail address and
press [Ctrl]+[K]. If Outlook
finds the address, it will auto-
matically complete it. If it
finds more than one possibil-
ity, it will show you the
options—double-click on the
right one to fill it in.

I get a lot of e-mail and
spam, but that’s the least
of my problems; these
days there are so many
viruses going around!
Installing a good anti-virus
software will take care of the
virus-related problems, but it
needs to be updated regular -
ly, since they become outdat-
ed quite fast. Understanding
the mechanisms of certain
kinds of viruses and cultivat-
ing practices to avoid them
altogether is much more
effective. Most new viruses

Powerful filters in Excel 

Create a group to send e-mail
to multiple recipients
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and worms spread via e-mail
by enticing users to open
attachments. If you get 
e-mail with attachments,
open it only if you were
expecting it. Worms send
themselves to addresses from
an address book, so it’s not
safe to open attachments
even if it’s from someone you
know. Avoid executables alto-
gether—it’s better to miss a
joke than become one. Watch
out for attachments that are
named as filename.jpg.exe—
these are executables too.
Various services on the Inter-
net alert you about new virus-
es and their nature as soon as
they are discovered. Sign up
with a good one to keep
yourself updated so that you
know well in advance how to
avoid them. 

How do I copy text and
images from a PDF docu-
ment?
Adobe Acrobat Reader has
three tools: one for selecting
text, one for selecting
columns and a third for
selecting graphics. Use the
Text Selection tool from the
toolbar to select running
text, as you would in a Word
document. The Column
Selection tool (drop down
the options under the Text
Selection tool to access this)
is great for picking up blocks
of text, say from a brochure.
Draw a rectangle around the
area you want to pick out
text from and only the text
within that box will be select-
ed. The Graphic Selection
tool is tricky—images are not
separate objects in a PDF doc-
ument. Draw a rectangle

around the image you want
to copy. Even if that area
contains text, it will be
copied as a graphic element,
which you can paste into any
image-editing application. 

There are just so many
documents! I can’t find the
contract agreement for the
Power project!
If you have a lot of unorgan-
ised documents, finding the
right one can be quite time-
consuming. It’s always faster
to have the computer look
for them rather than you tak-
ing up the task. All the appli-
cations in Microsoft Office—
Word, Excel, PowerPoint and
Access—have extremely
powerful search features that
locate the required file. On
the File Open dialog, you can
have the program look for
files that contain certain text
by entering the text in the
Text or Property area. You
can also filter down the selec-
tion to a particular date from
the Last Modified drop down
list. Click Advanced and you
can specify an infinite num-
ber of criteria to locate docu-
ments. The Advanced Find
dialog automatically picks up
criteria specified on the File
Open dialog (text, document
type and modified date). You
can add more by selecting a
property (File Name, Compa-

ny, Author, etc), selecting a
comparison condition
(includes or begins with),
entering a value for compar-
ison and clicking Add to List.
Once you’ve specified all the
criteria, click Find Now. The
File Open dialog box will dis-
play only documents that
match. If you enabled ‘Search
subfolders’, Word will display
the entire tree structure
down to the documents!

From the Advanced Find
dialog, you can also save
searches for later reuse. Thus,
even if your documents are
organised well, but across a
few folders, you can save cer-
tain commonly-used search-
es and simply use those to
open up documents of a par-
ticular kind in a single click.
The New Search button resets
the search criteria.

He expects me to know
the entire Internet by
heart? Now where am I
going to find Web sites on
corporate successes?
The World Wide Web is a
huge resource of informa -
tion, but research is akin to
filling a glass from a gushing
fire hydrant. However, search
engines are getting better by
the day and within minutes
you can open up a whole

bunch of Web sites that are
relevant to your topic. Search
engines have grown smarter
and know how to avoid
cheap tactics of Web devel-
opers to get their pages to
show up on search results.
Also, some of them actually
have hand-picked selections
of Web sites. Most already
use referral ratings to priori-
tise search results—if the site
is linked from a reputed site,
it gets a higher priority. Thus,
you can simply enter the
words you are looking for
and find relevant results
within the first 20 matches.

Google (www.google.com) is
known to give the most accu-
rate search results for the
simplest of queries. However,
almost all search engines
have a lot of mechanisms for
advanced searching, which
are usually unknown to
most. Again, the way to use
advanced searches differs
from engine to engine. For
example, wrapping text in
double-quotes indicates a
phrase search. And, Or, – and
+ usually indicate boolean
searches, depending on the
search engine. Sites like

Selecting blocks of text from PDFs

Locating documents is easy in
MS Office

Cool search options at HotBot
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Altavista (www.altavista.com )
also recognise keywords such
as Near for boolean search-
es—it will return results for
pages that contain words
close to each other, for exam-
ple, in the same paragraph.
Most search engines can also
search for matches only in
the page titles. Advanced
searching instructions are
usually located in some cor-
ner of the search page—look
for such a link on your search
engine, go through the
instructions, and you will be
able to locate sites more pow-
erfully. Many advanced
options are controlled by the
way you type the search cri -
teria, but almost all of them
have a user-friendly form for
at least some of the frequent-
ly-used features. HotBot
(www.hotbot.com) has some
very good advanced search
features missing from most
other search engines, such as
return only top-level pages,
pages must include certain
kinds of files, etc.

I don’t want others to
read my e-mail while I’m
away from office.
If you use Outlook or Out-
look Express, you can hide
your e-mail behind a pass-
word. For Outlook Express,
click File > Identities > Manage
Identities. You will see the cur-
rent identities setup on the
computer with Main Identi -
ty as the default one. Click
Properties for the one you
want to protect, enable
‘Require a password’ and
enter the password you want
to use. Every time you start
Outlook Express, you will be

asked for the password. Be
careful though—if you sim-
ply close the program, the
next time you will not be
asked for the password. Click
File > Exit and Log Off Identity
when you want to quit it.

For Outlook, you can
actually protect the data file
itself. Thus, even if it is
copied to another machine,
the password will still be
required to access the e-
mail. Click File > Data File
Management. Click Settings
and then Change Password.
Enter the password and dis -
able ‘Save this password in
your password list’. Now,
every time you open Out-
look, you will be asked for
this password, without
which Outlook will not load
the message stored.

Sharing my files is much
more convenient than
sending an e-mail every
time I want my boss to
check something. But is it
possible to prevent others
from accessing them?
Windows 98 is not very
secure when it comes to shar-
ing files, but no networked
machine is hacker-proof.
However, there are some
things you can do to prevent
people from accessing your
files. The simplest of all is to
use passwords. When sharing

a folder, you can specify two
passwords, one that will
allow a person to only read
files, the other that will also
allow him or her to modify
them. Secondly, you can
share folders such that they
are not visible on the net-
work. When sharing a folder,
if the share name ends with a
dollar sign, it will not be vis-
ible in Network Neighbor-
hood, but a person can access
it by typing the full path to it
(\\machinename\share$) in
Windows Explorer. Thus,
only the people who know
that such a share exists can
access it.

Another security option
in Windows 98 is to create
user level shares. For this,
your network must be con-
trolled by a Domain Con-
troller, which has the users
and groups already defined
on it. Right-click on Network
Neighborhood, click Proper-
ties and switch to the Access
Control tab. Select ‘User-level
access control’. All current
shares will be disabled and
after rebooting, when you
share a folder, you can add a
list of users who can access
the share and also define
what they are authorised to

do with the files there (read,
write, delete, create files and
folders, change file attributes,
list files and change access
control).

How do I access my 
e-mail from home as well
as from the office?
There are three ways to do
this. In your e-mail client,
you can set up mail to be kept
on the server even after it is
downloaded, so that it is still
available from other
machines. In Outlook
Express, click Tools > Accounts ,
select the e-mail account for
which you want to enable
this function and click Prop-
erties. Under the Advanced
tab, enable ‘Leave a copy of
messages on server’. Outlook
Express can optionally
remove the messages from
the server after a specified
number of days, or if you
delete it from your e-mail
store. In Outlook, you can
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access the same function
from Tools > Account settings.

Another option is to use
a Web-based service such as
mail2web (www.mail2web.com)
to access your e-mail. This
service requires no registra-
tion—you just enter your 
e-mail address and pass-
word, and you can access all
your e-mail from wherever
you are. It works with all
POP3 and IMAP4 servers.

The best option is to use
IMAP, if your e-mail server

supports it. Most commer-
cial servers support it by
default, but the administra-
tor may turn it off. When
you use IMAP, all the mail is
stored on the server and the
e-mail client allows you to
work with the e-mail as if it
were downloaded locally.
This is as good as Web-based
e-mail, with the conven -
ience and features of an 
e-mail client. To set up IMAP
in Outlook Express, click
Tools > Accounts > Add > Mail
and enter your name and 
e-mail address. When asked
for the e-mail server names,
choose IMAP from the drop
down list. Once the account
is created, Outlook Express
will download the list of
folders from the server. You

can set up IMAP any time on
any machine and have
access to the same e-mail.
Thus, if an e-mail is marked
as read, it will appear as read
from all other machines.

I know it’s not good to
use the same password
everywhere. But there are
just so many passwords, I
forget all of them.
Using the same password for
all purposes may seem con-
venient, but it can be
extremely dangerous. How-
ever, remembering more
than even five different
passwords (they are sup-
posed to be cryptic so that
they are not easily breakable,
right?) can be tedious. And
you are not supposed to
write them down anywhere
because someone might just
find it.

The answer lies in a pass-
word management utility.

There are lots of free soft-
ware available that generate
cryptic passwords and you
can note down what pass-
word you are using where.
The list is stored in an
encrypted format behind a
single password. Thus, you
have to remember only one
password and if someone
gets hold of the list, it will be
quite difficult for him or her

to access the passwords.
Whisper 32 (www.ivory.org) is
one such tool. It stores all
your passwords in one pass-
word-protected and encrypt-
ed file. Data files are
encrypted using a robust
encryption algorithm. You
can set certain passwords to
expire at particular intervals.
Another tool, PINs
(www.mirekw.com/winfreeware/pi
ns.html), is also free and very
flexible. It stores passwords
for functions under various
categories. It can also gener-
ate cryptic passwords 
and has excellent security
features.

I want to send this
presentation to others.
They may not have Pow-
erPoint and I want the
fonts, transitions, etc to
look the same.
PowerPoint has some great
features for sharing presen-
tations. If you want to sim-
ply run the presentation
over a LAN, you can simply
click Slide Show > Online Broad-
cast > Begin Broadcast. Howev-
er, with this everyone view-
ing the presentation must
have PowerPoint installed. A
simple solution to this is to
use the PowerPoint Viewer.
This is a small installation
just for viewing PowerPoint
slide shows. You can have
your presentation carry the
fonts used along with it, if
the fonts do not have license
restrictions. Click File > Save
As to save the presentation.
In the Save As dialog box,
click Tools > Embed TrueType
Fonts. The best way to dis -
tribute presentations is to

use the Pack and Go feature.
This creates a self-extracting
archive of the presentation
so that it can be sent by mail
and you can optionally
include the viewer along
with it as well as embed
fonts. Click File > Pack and Go
and simply run through all
the screens.

These blue screens are
irritating. I wish I could
just format the hard disk
and install Windows
again, but I don’t want to
lose all my e-mail and my
address book.
Outlook Express stores mail
in .dbx files. In Windows
9x they are stored in \Win-
d o w s \ A p p l i c a t i o n
Data\Identities. You can
see and change the location
of the mail store from Out-
look Express itself—click
Tools > Options > Maintenance
> Store Folder . Simply copy
the files to a different loca-
tion to back them up. Out-
look stores mail in .pst files.
Click File > Data File Manage -
ment > Settings . From here
you can see where all its

Use IMAP to access mail from
multiple locations

Manage passwords smartly and
securely

Pack presentations for sending

The folder where your mail is
stored
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contents including mail,
contacts, notes and
reminders are stored. 

These phone calls to
regional offices are cost-
ing us so much!
Instant Messenger (IM)
services such as Yahoo!,
MSN, etc provide very good
functions for text, voice
and file transfers—you only
need to be connected to the
Internet. Apart from pro -

viding a cost-effective alter-
native for communication,
IMs are also convenient. For
example, you can leave
messages for a person even
while he or she is not at the
desk and transfer files
directly, thus avoiding large
e-mail attachments. 

How can I preview 
e-mail and download only
the relevant ones?
There are various freeware
and shareware tools avail-
able that allow you to 
preview e-mail before down-
loading them from the 
server, even from POP3
servers. You can see the
sender, recipients, subject
and time stamps—these are
usually enough to deter-
mine whether the message 

is important or not. 
Magic Mail Monitor
(www.geocities.com/SiliconVal-
ley/Vista/2576/magic.html) is a
free tool that can handle
multiple e-mail accounts
and check them at regular
intervals. It sits in the sys -
tem tray and can optionally
display the entire message,
too. From here itself, you
can reply, send or delete the
e-mail. 

If your server supports it,
you can use IMAP for the
same functionality. By
default, Outlook and Out -
look Express download only
headers for IMAP folders.
You can preview each mes-
sage, download the ones you
want and delete the rest. You
can use IMAP just for pre-
view and have the same
account configured for

POP3, so after previewing
and deleting messages, the
ones you need can be down-
loaded to your desktop.

Sometimes when I
shutdown Windows, I get
a message that someone’s
connected to my PC, but I
have nothing shared.
How do I make sure no
one’s hacking into my
data?
If you have Windows 9x,
you can check who’s con-
nected to your computer
using the Net Watcher tool.
To install it, open Control
Panel > Add/Remove Programs >
Windows Setup. Select System
Tools and click Details.
Check the box for Net
Watcher and click OK. You
can launch the program
from Start > Programs > Acces -
sories > System Tools > Net
Watcher . It will display all
open connections, shared
folders and open files. If you
want, you can also discon-
nect users from here.

For Windows 2000 and
XP, right-click on My Com-
puter and click Manage. This

will open the Microsoft
Management Console
(MMC) for Computer Man-
agement. Expand the Shared
Folders item. Under ‘Shares’,
you can see what folders are
shared, ‘Sessions’ will show
currently connected users
and ‘Open Files’ displays
files opened over the net-
work. You can disconnect
users or close open files.

These agreement docu-
ments are huge. It takes
me so much time to go
through them and most
of it is fluff anyway.
Word uses a powerful feature
called Outlines for organis-
ing information. It takes just
a slight extra effort and dili-

gence on your part when
creating a document to
organise the information
correctly. Use Styles to mark
out headings and subhead-
ings in the document, in the
hierarchy in which they are
supposed to be (Heading1
corresponds to the first level,
Heading2 to the second, and
so on). Don’t use or not use
certain styles just because
the font doesn’t look good—
you can change the appear-
ance from Format > Styles.

If your document is cre-
ated correctly, you can use
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Cost-effective communication
with IMs

Preview e-mail before
downloading

Organising information with
styles
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the Document Map (from the
View menu) to browse
through the sections and sub-
sections. The items are
grouped according to the
hierarchy, and you can show
or hide any of the levels (to
see all sections at one glance,
for example), making it
extremely simple to navigate
the document. Another
advantage of using styles is
that it makes reorganisation
very simple. Switch to Out-
line View (View > Outline ).
Here, the entire document is
displayed in a hierarchical
form. Each group can be col-
lapsed or expanded. You can
click on the marker next to
the heading or paragraph and
drag it up, down, left or right.
Pulling it up or down will
move the entire group and its
subgroups above or below
other items, pulling it left or
right will promote or demote
the group. For a quick glance
at the sections, click the Show
First Line Only icon on the
toolbar. This will display only
the first line of every para-
graph, again making it
extremely simple to navigate
a document.

Another advantage of
using these styles in your doc-
ument is that it can be
imported directly into Power-
Point to make a presentation.

Oops! This logo on the
letterhead is for the
wrong department. Now
I’ll have to print all the
copies again.
You can avoid mix-ups and
ensure consistency for all
office memos by using 
templates. It is extremely

simple to create and use
them. Open any existing
document, delete all the
matter except the items
you want to repeat across
all memos (logos, headers,
footers, etc) and click File >
Save As and choose Docu-
ment Template from the
‘Save as type’ list. Apart
from repeating items, tem-
plates also maintain styles,
so you can ensure consis -
tency in the fonts, head-
ings, etc. Create a template
for every kind of document
you want to maintain and
every time you want to cre-
ate a new document, click
File > New and choose which
one you want to use. You
can even replace the New
icon on the toolbar with
the one from  File > New.

We dispatch several
hundred units across 20
regions. It takes me half
a day every week to
decide on the correct dis-
tribution plan and to
make reports for region-
wise break-ups.
Excel can be very useful for
small-time inventory track-
ing. Plus, you don’t need to
know too much about Excel
to be able to use it—basic
inventory tracking simply
involves addition, subtrac-
tion, multiplication and divi-
sion. As a one-time exercise,
you can make a worksheet
that has all the functions

defined. You can probably
use one sheet to keep a tab on
all products. Thus, if you
have all the products listed in
one column, the total num-
ber of products in another
column and the regions
across a row, all you have to
do is punch in the right num-
bers in the right cells. If you
want an estimate of how
many pieces of each to send
to each region, just fill in the
cells with the percentage of
products you send to that
region from the total number
of products (e.g., =B3*12%)
and every time the total
number of products changes,

you will automatically get the
new estimate.

When filling up the
sheet, if the number of
products exceed the total
number, or if a particular
region is receiving very few
products, you can have
Excel warn you about it by
using conditional format-
ting. Select the cells for
which you want the warn -
ings, click Format > Condi -
tional Formatting and select
‘Cell Value Is’ in the first
drop down, less than in the
second drop down and
enter the threshold value in
the text area. Click the For-
mat button to set the for-
matting. You can add up to
three such conditions. If

you simply want to high -
light negative numbers,
open Format > Cells , under
the Number tab set Catego-
ry to Number and choose a
style for negative numbers.

Again, rather than sim-
ply formatting such discrep-
ancies, you can have Excel
throw up an error message.
Click Data > Validation and
choose ‘Allow Decimal with
data greater than’ and enter
the minimum value the cell
should have. Under the
Error Alert tab, enter an error
message to be displayed
every time the data does not
match the criteria.

Creating reports and
graphs from this data is a
breeze. Just click the Chart
Wizard icon on the toolbar
and click through the
screens. You can link the data
from Excel into Word too,
say for creating vouchers for
the products that are being
sent to every region, by using
Word’s Mail Merge feature.

The directory is in a
Word file, but they
haven’t even used tables.
How do I copy just the
names of all the people at
one go?
You can select a column of
text out from a chunk in
Word, just as in Acrobat
Reader. Press [Alt] while
dragging a selection around
the text that you want to
copy and only that part will
be copied. This is extremely
useful for picking out infor-
mation from documents
where items have been sep-
arated by a number of
spaces or tabs.

Templates ensure consistency

Automatic validation in Excel 



Trinity: “What do
you need, besides
a miracle?”
Neo: “Guns, lots of
guns”

—The Matrix

arcade ■
■ games

122 SEPTEMBER 2002

■ games

This quote sums up the founda-
tion that FPS’ are built on. To the
layman, an FPS is just another
mindless shooting game, but

give an FPS gamer an elabo-
rate set of guns to

paint

t h e
walls with, and

you’ll make even the
most jaded gamer delirious

with glee. FPS’ aren’t played for
their compelling storyline, you know!
Game developers are aware of this and

manipulate the knowledge with sadistic
pleasure—ever notice how you start the
game with a lousy pistol that has all the
effectiveness of a bent fork? It’s only after
you’ve been through the early levels,

ducking, covering and being a complete
wimp, that you get the tantalising pay-
back. Those big guns with enough recoil
to send you rolling backwards from your
chair—guns that change your posture
from a cowering camper to a stand-
and-deliver agent of death! 

Here’s a stellar list of the top 10 guns
that have etched great gam-

ing moments in

blood.
But before

we begin, come on
backstage to see the rig-

orous test process these guns
were put through to make it to the

list. It involved hours of intense research
that brought out the compassion in our
editorial team. They ‘crunched’ their
respective deadlines and even fought
over who would put in late hours playing
every FPS released over the past few years,
benchmarking every weapon. Then 
followed a pro-con analysis, fierce intel -
lectual debates and upper class rivalry
over which gun rules. Finally, a consen-
sus was reached and a comprehensive list
of the top 10 guns was made.

SRIRAM SHARMA

A tribute to the best FPS weapons of all times

GRAPHIC DESIGN : Ram



Snarks are the small, fast and vicious alien
enemies in Half-Life, but turn baby Snarks
against your enemies and you have one of
the most amusing and sadistic weapons of all
time. You can pick them up from their nest
while they’re sleeping and turn them against
the enemies. As soon as you press the trigger,
the Snarks jump off the gun and head straight
for the nearest enemy. Beware though. If
there’s no enemy, they turn around and
attack you! A bunch of Snarks can take down
the toughest of enemies, not to mention
annoy the hell out of them! At the end of
their 15-second life, the Snarks explode into a
puff of green goop, causing damage to every-
one around. To ensure that they don’t attack
you, shoot them at the enemy from the top
of a ledge or a crate.

Also known as the Snot or the Goop gun,
think of the GES Biorifle as a mine-laying
weapon. It fires toxic blobs of slime that hurt
on direct impact. If fired at walls or the floor, it
stays there for about 4 seconds and then
explodes. You can cover a whole area with
this goop to build a barrier or trap to hold
back attackers chasing you. If one blob hits
another, both explode instantly and so do all
the other blobs close to them. You can use
this to create a chain reaction: lay a line of
blobs then let the last one explode. Use the

Before you protest that the LightSaber is a
sword, hear us out. This is the coolest
weapon ever implemented in an FPS and is
certainly the most powerful weapon in Jedi
Knight II. You’ll rarely need to use any other
weapon after you’ve obtained this one—it
makes a Jedi a Jedi Master. You can use the
LightSabre to deflect blaster fire and recipro-
cate with swings that take out most enemies
on contact. The secondary attack, the ultra
cool LightSaber Throw, can be used to
destroy multiple enemies at short or medium
range. With a three-tiered combat style, each
with its special moves, the LightSaber brings
special moves and combos to the genre.

alternate fire to load one big blob. If it hits
directly, it’s a one-shot killer. You can load the
gun and run around with it for as long as you
want! In water, the slime floats on the sur-
face, so if you know that an opponent is
underwater, you can cover the surface where
you expect him to get out of the water. Just
be careful not to run into the slime. 
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HALF-LIFE

THE SNARK GUN

UNREAL TOURNAMENT

THE GES BIORIFLE

JEDI KNIGHT II

LIGHTSABER

Inspired by DOOM, BFG stands for the Big,
Fu… err, Freakin’ Gun. Simply fire the BFG
into a small room of unsuspecting enemies
and change the colour of the map. It takes a
long time to warm up and even longer to
reload, but the energy ball it fires will vapor-
ise everything in its path. The BFG does dam-
age in three intricate stages. The first level of
damage involves the impact and radius effect
where the energy ball causes a blast. In the
second stage, the energy ball shoots out laser
beams, burning enemies who are close to it.
The third level of damage is the most devas-
tating—it affects anyone in the line of sight.
Use the BFG in crowded areas to maximise its
effect. With Quad Damage, you are talking
World War III here!

light and instantly impacts the target. It can
reduce 100 health points per shot. Mouse
sensitivity plays a large part in the physics, so
clean the mouse ball and use the smoothest
surface possible. It takes interminably long to
recharge, but it’s a one-shot kill weapon that
can quickly turn the tide in your favour.

QUAKE III ARENA

RAIL GUN

QUAKE II

BFG 10K

Ammo Type: Biosludge ■ Damage: Medium ■
Rate of Fire: 4 rounds per second ■ Clip Size:
25 rounds ■ Maximum Ammo Capacity: 100

Ammo Type: Melee weapon ■ Damage: Medi-
um/High ■ Rate of Fire: NA ■ Clip Size: NA ■
Maximum Ammo Capacity: Unlimited

Ammo Type: Uranium slugs ■ Damage: High ■
Rate of Fire: Once per 2 seconds ■ Clip Size: 10
rounds ■ Maximum Ammo Capacity: 200

Ammo Type: Energy cells ■ Damage: High ■

Rate of Fire: 1 second ■ Clip Size: 4 rounds ■

Maximum Ammo Capacity: 200

GO FETCH! Send the Snarks scurrying down
from a ledge and watch them chew through
your enemies like landborne piranhas

HAPPINESS IS A WARM GUN: The Rail gun in Quake III Arena is the weapon of domination

USE THE FORCE LUKE: Or the LightSaber,
for that matter

NOBODY
WANTS TO
PLAY WITH
ME! The map
looks empty
when you
have a BFG 

TURN SNOTTY! Use
the GES Biorifle to
spray green blobs
on the walls and
ceilings and wait for
an unsuspecting
victim to walk into it 

One of the most popular weapons in Quake
III, it’s the tool of choice for campers and LPBs
(Low Ping B*******). The Rail gun is the most
difficult weapon to master, but also the
weapon of domination. It produces one thin,
powerful beam that travels at the speed of

6

7

8

10

9

Ammo Type: Snarks ■ Damage: Low/Medium ■
Rate of Fire: 2.5 rounds per second ■ Clip Size:
15 rounds ■ Maximum Ammo Capacity: 15
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Imagine camping behind a wall, with just
your sniper scope peeking out, softly chant-
ing “Come to daddy baby…come on you
whiny kid... good boy” BANG!…and you
have a new trophy for the wall! Until
recently, just one shot from the Arctic War-
fare Police model (AWP) anywhere on your
body, and you were singing with the
angels. Subsequently, the AWP was toned
down a little—now if you get shot, say in
the foot, you don’t die immediately; but it
leaves you reeling and weak.

The feared Arctic Warfare Magnum
(AWM) dominates maps with its double
zoom capability and menacing sound. This
0.338 calibre bullet can rip through three
enemies standing in a single line. An over-
powered sniper rifle such as the AWM can

be quite a menace in the right hands. It’s
not without its downside though. It‘s heavy
and cumbersome to run around, manoeu-
vre or turn with. Use the AWP from a far off
stationary position and aim at areas you
know the enemy is going to pass through.
Strafing while reloading is also a good 
strategy. 

By far the most powerful device in Unreal
Tournament, the Redeemer can pulverise
anything close to it, no matter how well
protected and armoured it is. According to
the game guide, the Redeemer is a small
thermonuclear device that fires a very large
and slow-moving nuclear missile that
explodes upon impact. In secondary mode,
it’s like a reconnaisance plane—you can fly
around the map for as long as you like, until
you find the right place to blow up. 

It does have a few downsides, though.
For instance, you’ll surely kill yourself unless
you stay quite far away, and it can only be
shot once. Not to mention that it’s a very
precious commodity. If you pick up a
Redeemer, use it wisely.

UNREAL TOURNAMENT

REDEEMER

If arson is in your blood, this is one weapon
that is bound to appeal to your fire-happy
genes! Using Napalm fuel cells, this one
gives you the capability to play Fire-God.
You can direct it at a hoard of undead sol-
diers and watch them spin around the place
in a confused stupor while the room fills
with their burning fumes! The Flamethrow-
er spews long squirts of liquid flames that
set enemies on fire and cook them to a
crisp. Return to Castle Wolfenstein just
wouldn’t be the same without it. 

No other weapon is worth as much anticipa-
tion or joy as the SBC Cannon. It’s bigger
than the BFG and shoots uranium-powered
cannon balls that roll along, leaving a trail of
destruction. Rolling cannon balls through
swarms of enemies is a lot like bowling with
human pins! Hurl it from the top of a valley,
and watch the ball cut a neat hole through
an invading army. The ball bounces around
erratically until it finally stops and explodes
in a big nuclear explosion. Reserve this one
for your largest and most powerful enemy;
you’ll need it!

SERIOUS SAM

SBC CANNON

SHRINK WRAPS:
Honey, I shrunk
the enemy!

CAMPERS PARADISE: The AWM, the
number one gun for all your camping needs

THE FLAME THROWER:
How would you like
your enemies? Rare or
crisp?

THE SBC CANNON: A loose cannon to cut
a swathe through the enemy

I BELIEVE I CAN FLY: For an out-of-body 
experience, seek and destroy with the 
Redeemer

Ammo Type: Uranium-filled cannon balls ■

Damage: High ■ Rate of Fire: Variable ■ Clip
Size: 4 ■ Maximum Ammo Capacity: 4

Ammo Type: Thermonuclear device ■ Damage:
High ■ Rate of Fire: One shot ■ Clip Size: NA ■

Maximum Ammo Capacity: 1

RETURN TO CASTLE 
WOLFENSTEIN 
FLAME THROWER

Ammo Type: Fuel cells ■ Damage: High ■ Rate
of Fire: Constant ■ Clip Size: 200 units of
Napalm ■ Maximum Ammo Capacity: 200

We put this one in just for the laughs! After
a healthy dose of the big bad weapons, we
have for you the Shrink Ray. No prizes for
guessing what this gun does. This slick
weapon shrinks your enemies to pint-sized
Lilliputians for several seconds, during
which time Duke can play Godzilla in the
city! Can anything be more gratifying than
turning a meddlesome opponent into Tom
Thumb and squishing him with your
boot?!

DUKE NUKEM 3D

SHRINK RAY
Ammo Type: Crystals ■ Damage: High ■

Rate of Fire: 2.5 rounds per second ■ Clip Size: 5
■ Maximum Ammo Capacity: 50

COUNTER-STRIKE

ARCTIC WARFARE
POLICE MODEL

Ammo Type: 0.338 calibre bullets ■ Damage:
High ■ Rate of Fire: 0.89 rounds per second
Clip Size: 10 ■ Maximum Ammo Capacity: 30
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Operation Flashpoint: Resistance
expands the Flashpoint universe
and introduces fans to a spanking

new island with good graphics and excel-
lent gameplay. You are cast as Victor
Troska, an ex-Special
Forces soldier, living
an idyllic life on the
island of Nogova,
till a Soviet force
invades the island
and destroys Victor’s
dreams. The game
has been critically
acclaimed as an
excellent war simu-
lation—the player
will find himself pit-
ted against tanks,

dog-fighting with helicopters and air-
planes, and ducking for dear life amidst
war-strewn locales. 

What they forgot to mention in
the Art of War
This isn’t a run-of-
the-mill FPS. To
win, you need the
right mix of skill
and tactics. 
Safety in num-
bers: Stay in for-
mation; this is not
a solo game. Cover
your teammates
even as they pro -
vide cover for you.
Dog fights: If you

are caught in a dogfight with an attack hel-
icopter, remember that the chopper is
much more manoeuvrable than your fixed
airplane. Use your fighter’s engine to an
advantage and make wide angle attacks
from different angles. 
Cover your flanks: Use the environment
to your advantage—the bushes that litter
a map can render you temporarily invisi -
ble to your enemies. Use the trees and the
buildings as an effective blockade against
the hostile fire.
Don’t stop now: Keep moving. If you
have been spotted, hold down the [Shift]
key and keep bobbing and weaving
between trees and houses. This way you
become a hard-to-hit target and your
chances of survival increase manifold.
TLC: Use the medic and use him often—
remember that your aim gets affected if
you have been hurt. If you are in charge
of an entire platoon, get your buddies
healed in a similar manner.
Recycle: Make sure that your teammates
take useful weapons off fallen foes. To do
this, highlight your buddy, press [7] to go
to the action menu and choose the gun
that you want him to take.
Travel in style: Use the various in-game
vehicles—the light units such as the jeeps
are a great way to get around the map,
albeit with little protection. But the tanks!
Use them to hammer in the point that you
are not to be messed with 

AHMED SHAIKH

Hold [Left Shift] and press [Keypad
Minus].  Release the keys. Type one of the
following codes to activate the corre-
sponding cheat function. 
iwillbetheone: God mode 
savegame: Saves the current game
campaign: Unlocks all the missions. To be
used at the Main Menu.
endmission: Ends the current mission
topography: Shows the elevations on the
map. To be used at the Main Menu.

More than Skills

Carl Gustav Launcher
This rocket launcher uses highly explosive
ammunition, suitable against armoured and
unarmoured targets. Almost recoilless, it is
equipped with a modern targeting system.
Caliber: 84 mm 
Muzzle velocity: 300 ms  
Effective range: 1300 m

FIM92A ‘Stinger’ AA Missile
The Stinger is used by the US Army as a
short-range defence against flying units. It
offers effective protection against air-
planes, helicopters, unmanned aerial vehi-

cles and even cruise missiles.
Caliber: 91.4 mm 

Muzzle velocity: Mach 2
Effective range: 8000 m

Dragunov Sniper Rifle
Replacing the Svt-40, this one was
conceived by the Russians as a
sniper rifle. Apart from the ordinary

cartridges, it can also use devastat-
ingly effective incendiary bullets. An optical
sight enables you to conduct night firing at
infrared sources.
Caliber: 762x54 mm
Muzzle velocity: 830 ms 
Effective range: 3800 m

Tools of the Trade

■ tactics

The latest serving from Bohemia Interactive—resistance is futile!

SEPTEMBER 2002

KNOWLEDGE IS POWER: Use the map to
send in scouts and sorties to evaluate the lay
of the territory and the enemy positions

arcade ■
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Cricket 2002 is a complex, balanced,
and fun game. Unlike many cheap

sports sims that don’t get licences from
Cricket boards, Electronic Arts (EA), the
publishers of the game, has all the official
licenses to the International teams. You’ll
find features by the truckload—player
editors, high-level character detail, TV-
style gameplay, multiple camera views
(stump camera and the helmet camera),
and great sound.

The players look quite like their real-
life counterparts and character animation
is rendered using motion capture, mak-
ing the movements very realistic. After
every ball, there’s a replay from multiple
camera views and it is very satisfying to
see a ball being knocked out from the
stump camera.

Fans of the game will love to pick on
all the flaws of this game and Cricket 2002
does have a few. The scoring rate is too
quick against weaker sides and the LBW

decisions often seem unfair. The gameplay
is not radically different, though they’ve
dropped the tru-spin and tru-bat system
from their earlier version for a simplistic
gameplay mechanism. It is a little com-
plicated in the beginning, especially if you
are using a keyboard—you’ll find your
entire team wiped out in the first three
overs itself. 

The crowd sounds add to the electric
atmosphere and Richie Benaud and Jim
Maxwell give a realistic commentary. 

While this is a fairly solid game, it
still falls short of the pedigree of EA’s
sports titles. It doesn’t quite measure up
to the quality of the NBA and FIFA fran-
chises. While it falls short of being leg -
endary, this is still the best cricket game
out there.

EA SPORTS CRICKET 2002
Stroke Play

BOWLED: Cricket 2002 takes TV style
presentation to a new level

Minimum System Requirements: 300 MHz processor, 64 MB RAM, 8 MB Direct3D-compatible graphics card 
Genre: Sports ■ Developer: EA Sports ■ Distributor: Gayatri Impex ■ Phone: 022-3381443 Web site: www.easportscricket.com■ Price: Rs 999
■ Rating: ★★★ ✩

FOUNDATION FLASH MX 
All in a Flash

Want to learn the world’s best vector
animation tool for the Internet

without spending thousands of rupees?
Then get Foundation Flash MX. The book
covers all the subjects related to optimisa-
tion of the products, basics of dynamic
Web site design and structure. 

It’s aimed at novices and intermediate
level users and begins with a brief descrip-
tion of Macromedia Flash MX and how it is
different from the earlier versions. It gives
details of all the objects and tools used for
authoring, and guides you through the new
user interface. The book also has some exer-
cises to give you precision with its drawing

and bezier tools. You can acquaint yourself
with the intermediate and higher level of
Action Scripting used for Web applications
and game development by reading the fun-
damental concepts of object-oriented
design. Also found are detailed insights on
creating music, how sound works and the
things to keep in mind while creating music
for Web sites and other multimedia proj-
ects. It also contains exercises for manipu-
lating video files and many easy-to-use sam-
ple scripts. Foundation Flash MX gives com-
prehensive and knowledgeable insights on
every aspect of Flash that a user would
expect to come across.

Publisher: Shroff Publishers and Distributors Pvt Ltd ■ Contact: Computer BookShop ■ Phone: 022-2317922/23/24 Fax: 022-2623551
■ Price: Rs 400 ■ Rating: ★★★✩✩

✩
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Developed originally for the XBox,
PS2, and the Game Boy Advance, the

PC version of MotoGP: Ultimate Racing
Technology is made for the thrill seeking.
Racers such as Kenny Roberts and
Valentino Rossi battle it out with some 
of the world’s fastest machines such as
Suzuki, Yamaha and Honda. 

While beginners will find it fairly
easy to get the hang of their bikes, hon-
ing your skills in the finer aspects of rac-
ing will take some practice. That’s where
the various game modes such as Quick
Race, Time Trials, Training, Arcade
Championship and Grand Prix series
come into play. 

You can either play as one of the
many professional racers or create your
own rider identity. You are given 10
points, which are distributed among four
skill categories: Cornering, Braking, Top
speed and Acceleration. Each skill cate -
gory has 10 training missions and each
mission gives you one skill point. The
missions gradually increase in difficulty

and each requires a different skill set.
While Quick Race and Time Trials stress
on setting the best lap times, Arcade
Championship gives you points based on
your performance in the race. The Grand
Prix series mode lets you take part in the
practice and qualifying rounds on each
track before racing and your point total at
the end of the series determines your
standing in the tournament.

Visually, this game is
simply delightful. Details
such as the shadows on cer-
tain parts of the tracks that
are lined with trees while rac-
ing with the ‘Sunny’ setting
turned on, and the sound of
thunder and the flash of
lightning while racing on a
rainy day, add to the replay
value of the game.

What you will miss is the
actual realism involved in
Grand Prix racing—running
off the track as you try to

manoeuvre a sharp curve only decreases
the bike’s speed. The game also places
you astride automatically when you take
a spill, taking away from the realsim of
the crash. But even though this does
make things a wee bit easy, getting
through the tracks and making good time
won’t be so simple. All in all, this is one
high octane racing game that should put
the fire beneath you!

MOTOGP: ULTIMATE RACING TECHNOLOGY
Of Burning Rubber and Hairpin Curves

ROUND THE BEND: Well rendered graphics and smooth
handling of the bikes make for a great racing game

Minimum System Requirements: Pentium II 400 MHz, 64 MB RAM, 300 MB hard disk space, 3D accelerator card, CD-ROM drive, DirectX 8.x
Genre: Sport ■ Developer: Climax ■ Distributor: Milestone Interactive ■ Phone: 022-8381614 ■ Web site: http://motogp.thq.de ■ Price: Rs 799
■ Rating: ★★★★✩

DIE HARD: NAKATOMI PLAZA
Not Worth Dying For

Die Hard: Nakatomi Plaza is another
FPS based on a popular franchise,

this time on a popular 1980s action film.
The game emulates the plot of the

movie and puts you in the place of John
McClane, a smart-talking New York cop
who fights German terrorists to save his
wife. The game features several original
levels throughout the Plaza building.
Instead of a small group of terrorists, like
in the movie, you’ll find one at every
nook and cranny. Since the entire game is
set at the Nakatomi Plaza building, the
environments are repetitive, with offices,
offices and some more offices. This makes
the environment claustrophobic and the
gameplay uninteresting. 

It does feature some well-scripted mis-
sions where you have to defuse bombs,
cut wires and save civilians. The game’s
winning points are its realistic environ-
ments and impressive in-game cinemat-
ics. The offices look plush, with good

attention to detail, but there’s not much
to break the monotony. The Lithtech
engine (which was used for No One Lives
Forever) has been used here, but not to the
best effect. The weapon range is limited—
there’s only a standard machine gun, an
M16, a 9 mm pistol, a heavy machine gun
and a sniper rifle. The AI is interesting,
with the SWAT teams and the terrorists
hiding and dodging you, but there’s noth-
ing out of the ordinary. 

The game is a good first effort from
Piranha Games—well rendered and exe-
cuted. The cinematics and cut scenes give
the intended Hollywood feel, but Die
Hard: Nakatomi Plaza offers very little that
a dozen other FPS’ don’t.

Minimum System Requirements: 400 MHz processor, 64 MB RAM, 16 MB Direct3D graphics card Genre: First Person Shooter 
■ Developer: Piranha Games ■ Distributor: World Wide CD ROMs Phone: 022-5006661 ■ Web site: www.sierra.com/games/diehard/
■ Price: Rs 999 ■ Rating: ★★★✩✩

CUT! In-game cut scenes progress the plot 
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Each month we share with you our
experiences in bringing out your
favourite technology magazine.
Some of our behind-the-scenes

activities are adventurous, some funny
and some just involve a lot of hard work
in overcoming unexpected hurdles. But
never before have we faced a tragedy of
this magnitude.

We got the news in the wee hours of
Sunday, the 28th of July that five of our
team members, Akhilesh Singh, Arup
Ghosh and Sourav Ghosh from our Cir -
culation and Logistics team, and C.M.
Krishnan and Kiran Desai from our
Accounts department had met with a
fatal accident on the highway between
Bhopal and Indore. They were on yet
another road trip aimed at increasing the
reach of Digit in several smaller towns
and cities.

The news sent shock waves through-
out the company and we still find it hard
to believe that these five will not turn up
one day, dusty from the road, with some
more unbelievable tales of their intrepid
adventures.

Akhilesh was a stalwart, one of the
oldest members in the team. As head 

of the Circula-
tion and Logis-
tics  team, he was
responsible for
ensuring that
Digit reached
every corner of
India on time,
come hailstorm
or high water. 

Akhilesh had
strong personal

ties with everybody he worked with and
also with his trade partners, scattered
across the country. Though a taskmas-
ter at work, he was looked upon as an
elder brother and mentor by many of
the younger members of his team.
Always ready to meet any challenge
head-on, he had this innate knack of
getting the impossible done. Also, no
get-together was complete without
him—his ‘moon-walking-underwater-
cum-belly-dance’ routine used to be 

the popular demand at each and every
party.

Akhilesh leaves behind his grieving
parents, an older brother and two older
sisters. He was engaged to be married this
November.

Arup was assistant manager, Circula-
tion and Logistics. A true team player, 
he was level headed and dependable in

any situation,
always willing 
to take up 
any challenge
thrown at him.
Arup joined us in
December 1999
and was always
ready to lend a
helping hand to
others, irrespec-
tive of whether

he was bogged down with his own work.
An ace rally driver, his passion for cars

was rivalled only by his passion for cook-
ing. In fact, he was the de facto cook at all
office parties, where we would gather
together and hold a huge cook-in under
his expert guidance. 

He is survived by his parents and an
older sister.

Sourav was a very jovial person with
a booming, infectious laugh. He joined
the Logistics team in April 2001 as 
manager, magazine sales having previ-

ously worked
with the
Gawhati-based
p u b l i c a t i o n ,
Anand Bazaar
Patrika and
brought with
him extensive
knowledge and
experience about
magazine distri-
bution in India.

Though he’d been with us for just over
a year, he was regarded as an indispensa-
ble member of the team.

Just before the accident, Sourav had
gone to Kolkata on leave and wasn’t
going to be on this particular trip. But he
joined the rest of his team members on

his way back from Kolkata as his presence
would make a big difference to their
morale. 

Sourav leaves behind a grieving wife
and a three-year-old son.

Kiran was our manager, Accounts.
His tolerance in handling even the most
demanding situations lent a stabilising
effect to the hectic working style of the

Accounts depart-
ment. Always
keeping a low
profile, Kiran let
his actions speak
for themselves.
Today, his expert
financial sys -
tems help man-
age the accounts
for the entire 
JS Group. As a

friend, he had always guided his fellow
workers and stood by them during all
their problems, whether professional or
personal.

Kiran is survived by his mother, 
wife and a young daughter studying in
Class 10.

Krishnan was a perfect foil to Kiran.
His enthusiasm made the most difficult 
of tasks look easy. He was always 
the fun-loving guy who would release 

the tensions 
in the Accounts
d e p a r t m e n t .  
His second
innings with 
the JS Group
started when
he joined as
manager, Cred-
it Control, and
took over the
entire credit

functions of Jasubhai Digital Media. The
adept handling of our company’s funds
and cash flow was indeed a ‘credit’ to him.

Krishnan leaves behind a wife, a son
studying in class 11 and a daughter study-
ing in class 7.

As colleagues, friends and truly 
wonderful people, they will be sorely
missed. 

Twenty-one Guns
Digit will never be the same again without these heroes
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And you thought it was all about 
AutoCAD? Think again!

Computer Aided Design?

Highlight the lighter side of computing. Mail
your contributions to: Backbyte Digit, Plot
D-222/2, TTC Industrial Area, MIDC, 
Shirvane, Nerul, Navi Mumbai 400 706
or e-mail us at backbyte@jasubhai.com

Your chance to
bite back!

The Geek in Black

C++ in seven days

f u cn rd ths, u cn gt a gd jb n
cmptr prgrmmng

– Anonymous
“ ”

The Earth on your hard disk

Can’t stick their heads out of Windows 95.
Fetch command not available on all 
platforms.
Too difficult to ‘mark’ every Web site they
visit.
Can’t help attacking the screen when they
hear “You’ve Got Mail”.
The fire hydrant icon is simply frustrating.
Involuntary tail wagging is a dead give-
away that they’re browsing
www.pethouse.com instead of working.
SmellU-SmellMe still in beta test.
SIT and STAY were hard enough, GREP and
AWK are out of the question!
Butt-sniffing is more direct and less deceiv-
ing than online chat rooms.
TrO{gO DsA[M,bN HyAqR4tDc TgrOo
TgYPmE WeIjTyH P;AzWqS,.

WHY DOGS DON’T USE 
COMPUTERS
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Download Earth
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